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Lode Data Corporation on the Internet

Lode Data Corporation’s web site can be found at www.lodedata.com. We encourage all
our customers to visit on a regular basis due to frequent changes and additions.

Go to our site for complete product information about the Design Assistant, Drafting
Assistant, Fiber Module, Design Assistant Viewer, and Fiber Module Viewer. Also, check
our site often for product updates and new product release information.

If you experience any difficulty using the program or would just like advice on how to best
deal with a certain situation, please feel free to visit our support page and fill out a support
form for expert help.

Are you a current subscriber? If so, go to the download page and download all the latest
releases.

Check out our company news page for information about upcoming trade shows or other
events, check out our latest newsletters for tips and hints, or check our industry
employment page for companies looking for good designers and drafters.
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Introduction to the Design Assistant

Welcome to the Lode Data Design Assistant

The Design Assistant was introduced in 1983 as a basic engineering tool for designing
Broadband Coaxial systems. Over the years the Design Assistant has evolved into the most
comprehensive, flexible, and widely used design software in the world. It contains
hundreds of powerful features that will help you create the most efficient and accurate
design in the least amount of time. With that, we thank you for joining our group of
network design professionals and welcome you to Lode Data Corporation.

About This Manual and the Design Assistant

This manual is a reference document and a tutorial for exploring the Design Assistant. The
Design Assistant is a complete system for CATV design and optimization that performs
thousands of calculations instantly, keeping track of part numbers and equipment types,
signal levels, specifications, footages, house counts, and many other laborious tasks. This
frees you up to do what you do best, analyze, design, and optimize the overall network.

This chapter is a short and simple introduction. Next, we will cover how to install the
software on to your computer’s hard drive and how to get it running on your computer.
Chapter Three: Let’s Get Started, explains the basics of how to start, navigate, and exit the
Design Assistant. We recommend that you read the first three chapters right away, after
that it is up to you whether you want to learn more about the program layout and menus or
if you would prefer to jump right into designing by doing our tutorials. Either way, please
be sure to take a few minutes working with our tutorials as they will give you hands-on
experience designing small areas and teach a few tricks that you will find helpful when
designing your first real system.

Covering Some Background Information

The Design Assistant is intended for network design professionals; therefore, this manual
assumes some knowledge of common CATV design practices. A Glossary section is
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available to help you with unfamiliar terms. Though knowledge of the inner workings of
computers is not required, knowledge of your computer’s operating system and basic
directory structure is helpful. For more information on the inner workings of your
computer, the local library or computer software store should carry books for all levels of
knowledge.

Chapter 2: Software Installation explains the computer system requirements for the Design
Assistant software to operate properly on your computer.

How to Use This Manual

Throughout this manual, we will be giving you examples of information displayed by the
computer and information that you type into the computer. To avoid confusion between
the two, we have used some conventions in this manual to clearly separate what you type
into the computer from what the computer displays. For example, text that you should type
will be italicized and be separated from the main tutorial text like this:

Type this into the computer.

You would then type the phrase “Type this into the computer”. When we refer to a single
key to be pressed on the computer keyboard, it will appear as a key on your keyboard
graphically. We will also put it in capital letters, where applicable. For example, when we
speak of the [Enter] key, we are referring to either the enter key on the numeric keypad
(lower right corner on most keyboards) or the enter key located just to the right of the semi-
colon and quotation mark keys (on most computer keyboards). Since they function
identically, either [Enter] key is acceptable. If we want you to press the decimal point, we
will refer to it as the [.] key. It is located next to the [Enter] key on the numeric keypad
with the letters “Del” underneath the “.” symbol or above the space bar and below the “L”
key. For example, if we want you to type a command into the computer and press the
[Enter] key, we will list it like this:

[.][2] [Enter]

In this case, the “.2” might refer to the Backfeed command in the Design menu.

What the Design Assistant Can Do For You

The Design Assistant is a Computer Aided Engineering System for the design and
optimization of Broadband coaxial networks, ranging from citywide cable TV networks to
computer Local Area Networks (LAN’s). The Design Assistant automates the laborious
calculations associated with CATV design and provides instant feedback in a detailed, yet
easy to visualize manner. Whether it’s altering the value of a single tap or telling the
computer to determine the electrically optimal power supply locations for a whole section



Design Assistant Introduction to the Design Assistant>>>Chapter
1

3

of a city, the Design Assistant immediately shows the effects of those changes.

The Design Assistant keeps a record of part numbers, descriptions, levels, and tolerances
that you are able to add to, update, and modify. Using this information, you are then able
to design the entire network from the trunk to the feeder, or express to the distribution in
an easy and efficient manner.

Entry of existing plant is not difficult; extensions and upgrades to existing plant can be
computed with little effort. Variables such as vendors and/or bandwidth can be changed at
any point with the change being instantly analyzed without re-entering any of the network
layouts. You can add, remove, change, or relocate any piece of equipment. These changes
are instantly re-calculated and displayed at the touch of a button. You can visually identify
any device that is not within the specifications since problem areas are highlighted in a
different color.

The Design Assistant can keep track of many networks or individual parts of a single
network. When a particular design meets your satisfaction, you can print a Bill of Materials
(BOM). The Bill of Materials shows accurate aerial, underground, and total plant mileage
along with part numbers and quantities. It is possible to BOM any group of networks for a
total BOM of an entire city or county. The BOM is flexible enough to count materials
grouped by marked area, power supply area, cable category, or map number. If desired,
the BOM can be output to an Excel format.

The Design Assistant is built around several important platforms:

Accuracy: Designs workable plant, minimizing all potential errors. Handles many decimal
points of precision for reliable mathematical calculations.

Efficiency: Helps produce the most cost-effective design possible. Frees the operator from
the time-intensive mathematical and statistical tasks and automates much of the
design process. This allows the operator to concentrate on the creative aspect of
the design.

Flexibility: Create a design environment in which the operator is free to experiment,
knowing that the results of any experiments will be displayed instantly and changes
that do not produce the desired results can be undone with ease.

Ease of use: All of the functions of the Design Assistant are available from easy to
understand menus which put all the Design Assistant commands in the operators
grasp with only a few keystrokes. A complete help system can be accessed either
from the Help pull-down menu or by pressing [F1].

Take a little time to read through the manual, and work through the tutorial and soon, you
will find that you have learned how to design, optimize, and test Broadband coaxial
networks faster than you ever thought possible.





Software Installation

What You Should Have From Lode Data
Corporation

Included in this purchase, you should have the following:

 USB dongle
 Email from Lode Data with the download link.

If you are missing any of these items, please contact Lode Data Corporation at (303) 759-
0100.

Computer Hardware Required to Run the Design
Assistant

The Design Assistant will run on a number of different computers and configurations, the
minimum of which is listed below:

 Windows 7 (32 bit and 64 bit)
 Pentium microprocessor
 Hard disk with 4 megabytes available for the program and 1 megabyte available

for every 60 plant miles that you need to keep on your hard drive
 Color monitor
 101 key keyboard (AT style)
 Mouse
 USB port.

The following equipment is highly recommended:

 Printer: Any Windows compatible printer will do--used for printing reports,
such as the bill of materials
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While this is the minimum required to run the Design Assistant, it is important to remember
that with computers, more is always better. We don’t expect you would be happy running
today’s sophisticated operating systems on a machine with this limited hardware. We
recommend buying as much computing power as your budget will allow.

Installing the Key ("Dongle")

The Design Assistant requires a special kind of hardware "key" (also called a "Dongle")
connected to the USB port to operate properly. If the software does not find this key, then
it will not function.

Installation

Design Assistant

To begin the installation process, it is recommended that you close all other programs. For
proper installation of the drivers do not connect the USB dongle until after the installation
is complete and the user is still logged in. Download the software from the download link
provided by Lode Data.

 Install Lode Data Corporation software as the local admin. In Windows 7, you may
need to right click on the Setup.exe file and select run as administrator. During
installation say “Yes” to install the 1-wire driver.

 Attach the USB key directly to the USB port. Do not use a USB hub or laptop
docking station. Third party adapters may cause connection problems.

 Windows will automatically find the driver (1-wire device).

Sample Files

It is recommended for new users to load the Sample files during the installation. This will
provide samples of specification files* as well as network files which can help new users
familiarize themselves with the program.

* The specification files included with the installation are intended as samples only and
should not be used for actual design projects.
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Command Line Switches

Command line switches provide information to the Design Assistant prior to starting the
program. They command the program to do things like create a backup file, enable file
locking, start with a certain status file, etc.

To use a command line switch, simply add a space and the desired switch to the end of the
Target Line in the Program Item Properties dialog box. It is possible to use more than one
command line switch at the same time by separating each switch with a space. For an
example of how to set the backup file command line switch, see Figure 2-1.

Figure 2-1.

Note: The command line switch should be placed outside of the quotation marks on the
Target line.

The following are the available command line options:

/m <filename> Load <filename> macro file: automatically loads a certain macro
file.

/b ............... Keep network backups: each time the network is saved, the previous
version will be saved to disk as the name of the network with a
“.bck“ extension.
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Note: The /m (macro file) will direct the Design Assistant to write <filename> macro files
whenever either is saved or updated



Let’s Get Started

Starting the Program

To start the Design Assistant, simply double click on the icon the install program created.
This executes a file called “DAPCxx.EXE” which, by default, resides in the C:\Program
Files\Lode Data Corporation\Design Assistant\xx directory. (Note: The xx represents the
Windows operating system architecture. For example, DAPC32.EXE is the executable for
the Design Assistant Version on a 32-bit architecture).

When started, the Design Assistant displays the Design menu and you are ready to design.

If you have any problems installing the Design Assistant, call Lode Data Corporation’s
technical support staff at (303) 759-0100 for prompt, courteous assistance.

Working With the Menus

Now that the Design Assistant is installed and running properly, you have hundreds of
powerful commands at your fingertips. The Design Assistant uses two kinds of menus:
pull-down menus and screen menus. The pull-down menus is accessible with the mouse or
by holding down the [Alt] key and pressing the underlined letter (for instance [Alt][F] will
pull-down the File menu). The screen menus are accessible by pressing the keystroke or
series of keystrokes listed on the menu before the command name or by left mouse clicking
on the menu buttons. Note: most commands are immediate and therefore don’t require an
[Enter].

The Design Assistant’s screen menus are split into four categories: Design and Active
Entry, where the actual design is performed; Entry, where strand data is entered into the
program; and Powering, where all network powering takes place.

The screen menus, while not always as easily readable as the pull-downs, are an incredibly
powerful part of the Design Assistant because they enable the use of the 10-keypad to
invoke Design Assistant commands. Once familiar with the menu system and proficient
with the 10-key, there is no faster way to do design!
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What are the Project Settings?

For the purposes of the Design Assistant, the Project Settings are used to define paths to
different directories. A “path” on a computer is the letter of the hard drive followed by the
main directory and subdirectories. C:\Lode Data Projects\Specs is an example of a “path”
where \Lode Data Projects is a main directory and \Specs is the sub directory of \Lode Data
Projects on your C: drive.

The Design Assistant needs to access a few different kinds of files to operate. It also creates
many different types of files during normal operation. The Project Settings sets all the paths
so that the Design Assistant knows what directories to save files to and open files from.

Due to the various kinds of files and the sheer number of files that can accumulate over the
years, we recommend storing and writing these files in separate sub directories on your
hard drive. Often times the best way to do this is to store your files per project. For example,
you may wish to setup separate sub directories for each project using the project name as
the directory name. Below is an example of a recommended directory structure:

Figure 3-1

Setting up your project settings paths properly will ensure that the Design Assistant will
always be able to find the desired specification and network files and help with effective
file management.

Setting up the Project Settings

To set your directories, select Project Settings from the File pull-down menu. Displayed
in front of you are eleven options: The path for the network, specs, control, and report files.
If your directory structure is setup so that all files are stored in the same directory, it is best
to use the Set All Folders option to set all paths to the same directory. If, however, your
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file management plan is to keep different types of files in separate subdirectories, it may
be necessary to set your Project Settings paths individually.

To set the Project Settings paths, simply highlight (by using tab key or the mouse) the
desired path and type in the appropriate directory, sometimes, it might be quicker to use
the Browse option instead of typing the actual path.

It is desirable to create and save separate Project Files for each project.

Using the Keyboard

In addition to the use of a standard mouse, the Design Assistant program is designed to
operate with the use of the right hand portion of the IBM-style 101 key keyboard. This
includes the numeric keypad, the [Insert], [Delete], [Home], [End], [Page Up], [Page
Down] group, and arrow keys. The [Escape] key operates as the [Escape] key; however
it's a long way away from the rest of the other keys (the [Escape] key is normally located
at the top left corner of the keyboard). Therefore, we have made the [Num Lock] key
function as the [Escape] key.

With these basic rules in mind, here's a quick list of what the keys on the keypad and keys
immediately surrounding the keypad do:

NUMBER KEYS: Enter numeric data, select menus, and invoke numeric commands.

DECIMAL POINT [.]: The Decimal point key (may also have the letters "DEL" on it).
Use the [.] key as a decimal point when entering decimal numbers while editing the
spec files. The [.] key is also used to invoke many of the commands. A third
function of the [.] key is a field separator while entering footages, house counts,
etc. while in the Entry mode.

[Num Lock]: To be used as the [Escape] key. The original [Escape] key (usually marked
[Esc] and found in the upper-left corner of the keyboard) also functions. Please be
aware, pressing the Num Lock key while in the Design Assistant will have no effect
on the operation of the numbers on the numeric keypad. Therefore, the insert,
delete, home, end, page up, page down, and arrow functions located on the numeric
keypad itself will function only as numbers while in the Design Assistant.

Note: While in any Spec Editor, the Num Lock key behaves like a normal Num Lock
key, that is, it turns On and Off the number lock on the numeric keypad.

[/]: Like the Num Lock key, this key has been remapped to function as a backspace key
while in the Entry mode of the Design Assistant. In the Design screen, the [/] key
toggles between standard display and expanded display.

[*]: Used to create or invoke user-defined command sequences called "macros".
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[Enter]: Accepts keyboard input data and executes entered commands. Note that not all
[Enter] keys are marked "ENTER", some may be marked "RETURN" or may just
have an arrow leading down, bending, and pointing to the left (  ).

[Arrow Keys]: Moves the cursor one field up, down, to the left, or to the right.

[.][Arrow Keys]: [.][Up or Down] arrow will move the cursor to the top or bottom of the
current branch when in the Design, Entry, or Powering. [.][Right or Left] arrow will
move the cursor to the branch beginning on the highlighted node.

[Page Up]: Moves back one branch while in the Design menu, Entry menu, or Powering
menu.

[Page Down]: Moves forward one branch while in the Design menu, Entry menu, or
Powering menu.

[Insert]: Inserts a line at the cursor position.

[.][Insert]: Inserts a line below the cursor position.

[Delete]: Deletes a line at the cursor position.

[.][Delete]: Undeletes lines previously deleted with the Delete key. Note this places the
previously deleted nodes at the cursor position; so, if your cursor is not in the proper
location the nodes will be replaced in the wrong location.

[Scroll Lock]: Controls the Design Assistant scrolling mode.

[.][Enter]: On the [ftg | hc | cab | lv] column, this opens the dialog to populate the address
location. A [.][Enter] on a tap will open the “Edit Tap Port Branches” dialog. Create and
edit tap branches through this dialog.

Don't worry if you're not sure what we mean by branches, nodes, and scrolling modes, we
will cover that terminology in the next section.

Using the Mouse

The Design Assistant uses the mouse for various miscellaneous tasks. All actual design
work, that is, design entry and optimization is done using the 10-key pad on the keyboard
to maximize efficiency. The mouse is used primarily to access the pull-down menus,
toolbar buttons, and to navigate the Design Assistant network. Mice equipped with a scroll
wheel allow the user to scroll up and down through the nodes.
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A left mouse click on any of the pull-down menu commands or toolbars will execute that
command. A left mouse click on a single node (line) or piece of equipment within the
Design Assistant will place the cursor at that location. A double left click on a branch
number (either the branch number or coupler ID will do) will move the cursor into that
branch. A right click anywhere within the Design Assistant screen, excluding the window
around the program, menu, toolbars, and scroll bars allows for customization of the display
colors.

What is a Network?

Depending on to whom you speak--a computer consultant, a cable systems engineer, or a
psychologist, the term network can mean many things. Limiting the definition to our
application, a network is a means of distributing signal, using "points" or "nodes". Signals
travel along cables from point to point in two opposite directions. The signal can start from
a headend, hub, or fiber receiver and travel towards the customer ("downstream", "forward
path"). A signal can also originate from the customer or from a piece of equipment located
on the network. The signal can travel towards the hub or headend by traveling along the
return path. A network can be a plant extension, a feeder leg, a trunk run, or an entire fiber
node consisting of up to 28000 branches and 128000 nodes (lines).

More About Nodes

To the Cable TV world, a node is known as a fiber receiver and the service area that it
feeds. For Design Assistant purposes, we will define a node as a line of information in the
Design, Entry, or Powering screens. In the real world outside the computer, it may
represent a pole for aerial plant, or a pedestal for underground plant. Several nodes can
represent a single pole or pedestal. One node in the computer can contain one active, up
to four taps, two couplers (feeding up to two branches), a power supply, all ancillary
equipment, and all the resultant signal levels and connectors. The backbone of the Design
Assistant lies in accurately entering the information about each node into the computer.
This information includes but is not limited to footages, house counts, equipment, etc.

Don't get locked into the idea that a single physical pole or pedestal must be represented
by only one node. A “0” footage on a line represents an extension of the line above it and
is therefore at the same physical location. Remember that it's helpful when starting out to
think of a node as one line in the Design, Entry, or Powering displays.

What is a Branch?

A branch is a contiguous run of cable ending with a termination (branches should never
end with couplers). Branch 1 usually starts at the headend or a fiber receiver. All branches
after branch 1 start from a coupler (or possibly an internal coupler). A branch usually begins
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where the strand or trench “breaks off” in a different direction, when a backfeed is created,
or at multiple-output amplifiers. A branch may have any number of other branches leading
off it. It is not necessary to begin a new branch when changing cable type, for example
when transitioning from express to feeder. The Design Assistant clearly marks which nodes
have branches and which do not. Moving from branch to branch is easy within the Design
Assistant; also, finding a branch from any other branch in a network requires only a couple
of keystrokes. It may be helpful when starting out to think of a branch as one page on the
display that begins from a coupler.

How Much Can the Program Handle?

The Design Assistant can keep track of as many networks as your hard disk can store.
However, the dimensions of each network do have some boundaries. A network cannot
exceed 128000 nodes. A network cannot have any more than 28000 branches at a given
time. Each branch requires at least 2 nodes worth of storage along with the number of
nodes that the branch contains. Additionally, each trunk station with connected feeder legs
takes an additional node worth of space, as does each multiple dwelling unit extension.
Have your calculator handy? Putting it all together, with combined branches, nodes, and
connected trunk stations, the equation looks like this:

(branches X 2) + total nodes + (connected trunk stations) +
(multiple dwelling unit extensions) < 128000

In English, multiply the branches by 2, add the total number of nodes in the network, and
add the number of connected trunk stations and multiple dwelling unit extensions. This
number must be less than 128000. Now that we have explained all the limitations, please
note that with today’s popular architectures, it is very unusual to reach the maximum
branch or node limit.

Getting Help When You Need It

Help is available at any time while in the Design Assistant. There are two methods from
which to access the help system: go to the Help pull-down menu or press [F1]. The Help
pull-down menu provides access to a complete context and index of our help system as
well as information about your particular system, like the version of the Design Assistant
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and Windows that you are running. It also provides access to our What’s New text file that
explains what new features are included in your current version.

[F1] is a context sensitive help system that will automatically display help information for
the current screen in the Design Assistant. This is a one-touch help system to provide help
for the most important place in the program – wherever you are at present.

If desired, it is possible to print the information in the current Help screen by pressing the
Print button. To close the Help window, simply press the X in the upper right corner of the
window or press the [Escape] or (Num Lock) key.

File Naming Conventions

It's important to note how the Design Assistant names its files. Inside the Design Assistant,
file names exist as 255 character lines of text. Each type of file has a unique file extension
associated with it? While filenames can be as many as 255 characters, it is recommended
that filenames be kept short yet descriptive.

It is typically recommended that all specification files in a Project have the same name.
For example: DENVER750R would be an appropriate name for the specs used for the
Denver 750 MHz Rebuild project. If we were to create a new Actives spec file with this
name, it would be written to disk as “DENVER750R.ATV” in the Spec file folder. The
extension “ATV” denotes that this file is an Actives spec file. If we created a design
network named DENVER001 (representing Node 001 of the project), it would be written
to disk as “DENVER001.NTW” in the Networks folder.

Note: Naming all specification files with the same name simplifies the loading and copying
of these files both within and external to the Design Assistant.

Here is a quick list of the files used by the Design Assistant.

<filename>.0AB Macro file (system file)
<filename>.PAR: Parameters file
<filename>.ATV: Actives file
<filename>.TAP: Taps file
<filename>.CPR: Couplers file
<filename>.CBL: Cables file
<filename>.PRC: Pricing file
<filename>.PER: Performance file
<filename>.NTW: Network file
<filename>.CNL: Control file
<filename>.BCK: Backup file
<filename>.MPN: Map number file
<filename>.MGD: Map Grid file
<filename>.DAP: Project Settings file



Chapter 3 <<< Let’s Get Started Lode Data Corporation

16

Xspec.XPF: Xspec file – fixed filename
<filename>.F00: Custom form for comments – maximum of 8

characters

By default, the system files reside in the C:\Program Files\Lode Data Corporation\Design
Assistant\xx directory, while the help files reside in the C:\Program Files\Lode Data
Corporation\Design Assistant\xx\HELP directory (where xx represents the Design
Assistant version number). The remaining files are in the directories specified by the
Project Settings. The procedure for changing these directories is outlined in the section
Setting up the Project Settings earlier in this chapter.

How to Exit the Program

To exit the program, press the X button at the upper right corner of the Design Assistant
window or go to the File pull-down menu and press Exit. If you have not saved your work,
the Design Assistant will display a dialog box asking if you would like to save your work
before exiting the program. To save your work press “Yes”, to discard any changes press
“No”, and to return to the program press “Cancel”.



Pull-down Menus and Toolbars

Pull-down Menus

The pull-down menus within the Design Assistant are used for various purposes. They are
used to load files, unload files, change modes, access print functions, access specification
file editors, and to access the help system, to name a few. Pull-down menus and functions
within them can be accessed by using a left mouse click or by holding down the Alt key
and pressing the underlined letter at the same time (for instance [Alt][F] for the File pull-
down).

File

The File pull-down menu is used primarily to create new files, load existing files, unload
currently loaded files, print files, and save files. Some of the commands on the File pull-
down menu cascade to display more options; these commands have an arrow to the right.

Figure 4-1

Most of the commands within the File pull-down are relatively self-explanatory. To start a
new network file, hold the cursor over New and when the other options are displayed,
simply click on Network. To open an existing network file, hold the cursor over Open and
when the other options are displayed, simply click on Network.
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The New Network function will begin by prompting you for the name of the new network.
Once the new network name is entered, the Keep Existing Levels box is displayed.
Pressing “Yes” to Keep Existing Levels retains all network specific tap output levels
defined in the current network (see Chapter 5: Utilities section Global Change Menu:
Levels for more information on tap levels). Next, it will automatically display the Network
Initialization Window (see Chapter 5: Utilities section Global Change Menu: Network
Initialization Window) to define the starting signal levels and characteristics of the new
network. Upon clearing the Network Initialization Window, the Design Assistant will
automatically change to the Entry menu for immediate input of strand information. If
importing form the Drafting Assistant, you will switch to the Design mode.

The Unload function is used to unload individual specification files that are currently
loaded. Typically, this is only used if a file is loaded and is not valid for the current project.
For instance, it may be possible that one project would require a Performance file and the
next project would not.

The Print command will print any of the various reports displayed, each of which is
described in detail in Chapter 8: Reports.

Edit

Mark/ Unmark: Toggle marking of node at the cursor position. This will place a blue line
just to the left of the footage. Marked areas may be copied, deleted, or BOMed separately.

Mark to End of Line: Marks all nodes downstream of cursor to the end of line.

Unmark to End of Line: Unmarks all nodes downstream of cursor, to end of line.

Swap Mark: Inverts the selection by marking all nodes currently unmarked and unmarking
all nodes currently marked.

Copy Marked Area: This allows marked areas in the current
network to be duplicated and inserted at the cursor position in
either forward or reverse format. Pressing 1 will copy all of the
marked nodes and paste them starting at the cursor location.
Pressing 2 will copy and paste only the marked nodes on
Branch 1. Pressing 6 will copy all of the marked nodes and
paste them at the cursor location in reverse order. Pressing 7
will copy and paste only the marked nodes on Branch 1.

Delete Marked Area: This function will delete only the marked nodes beginning with the
node under the cursor and ending in each branch when an unmarked node is encountered.
Branches that have all nodes marked will be deleted. Nodes upstream of the cursor and

Figure 4-2
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marked areas not contiguous with the marked area that includes the cursor will not be
deleted.

Copy: This command copies either the entire network or marked areas only.

Paste: This command pastes the information copied using the copy command. The
information is inserted at the cursor location.

Find/Replace: Find and replace Actives, Cables, Couplers,
or Taps on the current branch, downstream from the cursor,
or the entire network. The “Lock Changed Nodes” check
box will allow you to lock all nodes where replacements have
been made.

Rename Devices
The Rename Devices command provides an easy way to change the names of Actives and
Power Supplies on a Network wide basis. For example, if your active names contain the
name of the power supply in them and you wanted to change the Active name from
N01P201 (where the P2 represents Power Supply 2) to N01PB01 (where PB represents
Power Supply B).

Simply type P2 in the Find What: window and PB in the Replace With: window, select
the option to cover the Entire Network and then click OK. Every active in the network
that contained P2 will be changed to PB. You can also add Prefixes or Suffixes to the
device names.

Edit Node Address
This command opens the dialog to populate the current locations address.

Figure 4-3

Figure 4-4
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Mode

The mode pull-down menu can be used to switch the Design Assistant to
Design mode, Entry mode, Active Entry mode or Powering mode. This
command is there mostly to aid new users; experienced users usually find it
faster to change modes using the screen menu options. For instance, pressing
[NUM] [9] or [ESC] [9] from the Design mode will access the Edit mode,
and vice versa.

If you do not wish to toggle through all of the menus, use the Select Mode option. Checking
the menu name means the [NUM] / [ESC] [9] will toggle to that
menu. Clearing the check mark indicates you do not wish to toggle
to that particular menu.

Tools

The Tools pull-down menu contains various commands for
changing the status of the current network.

Network Initialization: Displays the Network Initialization Window. For a complete
description see Chapter 5: Utilities section Global Change Menu: Network Initialization
Window.

Clear Amp Names: Removes any previously assigned amplifier labels.

Append: Attaches a network on disk to the network in memory, starting it as a branch
beginning at the cursor location. The network may be appended without modification,
clipped, or clipped and compressed. Clipping removes all nodes following the last active.
If there are no actives in a network, nothing will be appended. Clip and compress removes
the nodes after final actives and compresses multiple nodes into single nodes wherever
possible. It is also possible to specify that the appended areas not be included in the Bill
of Materials.

Convert: This function allows you to convert feet to meters, meters to feet, feet to
decimeters, decimeters to feet, meters to decimeters, and decimeters to meters. Note that
if you convert feet to meters and then convert meters back to feet again, you may not have
the exact original footages due to differences in rounding.

Connect: Builds connections between the trunk network in memory and its attached feeder
legs. Connect should be used when feeder legs have been created with the New Network
option or when the name of the trunk network is changed. It is not necessary to use this
function if all feeder legs were created through the Amplifier Definition Window.

Move origin: This command will rearrange the network so that the node at the cursor
location will become node 1.1, turning around the nodes preceding it so that they are fed

Figure 4-5

Figure 4-6
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from that node. This allows you to select any point within the network as the point from
which signal will originate. The nodes that had been upstream of the node selected will be
converted into branch 1 and the downstream nodes will be moved onto branch 2 beginning
at the new 1.1.

Force Signals:

Subfunction [1], Signals: Forces the signals at the cursor position to user-specified
values and recalculates signals from the cursor on. Forced signal levels will
be reset by the next function that updates the signal levels at that node such
as Test, any of the Forward Execution functions, Recalc, WillWork, etc., if
done from a point upstream.

Subfunction [2], Set Margin: Sets how far a tap has to be out of spec before being
displayed red. If a tap is less than the margin value out of spec, it will be
displayed in yellow. This function's setting does not override the Tap
Margin setting in the Parameters file; it will be retained only until a new
Parameters file is loaded or the same Parameters file is reloaded.

Subfunction [3], Specs to EOL: Same as function [6], change specs, except that
this function recalculates signals only from the cursor position onward.
Note that a network can only be saved with a single set of specs in place.

Plugins: Opens the Pad and Equalizer selector/editor for the amplifier or tap at the current
cursor location. See Chapter 7: Design Menu, section Pad/EQ Selection.

dB Req: Calculates the minimum signal requirements needed at the cursor to feed to the
line extenders and ends of line downstream, whichever comes first.

Extended dB Req: Calculates similar to [.][9] dBreq with the addition of testing all
available combinations of couplers to arrive at the minimum signal requirement.

Toggle No BOM: Toggles NoBOM status of a branch on and off. Turning NoBOM on
for a branch will cause it to be omitted from the Bill of Materials for the network. A branch
not included in the Bill of Materials will be indicated by the branch information at the top
of the screen being displayed in reverse video. This is the only time that a (non-appended)
branch will have its’ branch information highlighted in reverse video. Therefore, make
sure that any highlighted branches are intended for exclusion from the BOM.

Delete No BOM: This will delete all branches that have been marked to be excluded from
the Bill of Materials. This will also delete all Autoappended feeder legs as well as manually
appended feeder legs that had been specified as not to be included in the BOM. This
function will also delete Autoappended legs whose corresponding trunk amps have been
deleted.

Macro Options: The Macro command allows you to record repetitive keystrokes that you
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can play back at any time. Due to the tremendous potential of Macros, we have dedicated
an entire chapter to it. See Chapter 11: Macros for a complete overview of the Macro
command.

Run Batch Macro: Run multiple macros on multiple networks. See Chapter 11: Macros.

Global Change

Cables: The set cables mode contains functions that are useful for changing the cable types
used in large portions of the network.

Levels: This mode contains functions for changing the tap output/input levels used in large
areas of the network and for adding new tap output/input levels to the network levels area
(levels 16-31).

Maps: Allows you to change map and location numbers in large portions of the network.

Map Grid: Shows maps occupied by the networks in the current network directory.

For a complete description, see Chapter 5: Utilities section Global Change Menu.

SpecEdit

The SpecEdit pull-down accesses the editors used to create specifications files. There are
seven different types of specification files used by the Design Assistant: Parameters, Taps,
Actives, Couplers, Cables, Pricing, and Performance. Each of the types are created and
edited separately. For a detailed description of the specification files, please refer to
Chapter 10: Building Specifications.

Also, you can create a Control file through the SpecEdit pull-down. A Control file is
basically a group of network files that are added together. This provides the power to run
a Bill of Materials or an Active Report on multiple networks at the same time. For more
information on creating a Control file BOM, refer to Chapter 8: Reports.

Test

The test pull-down menu provides access to the various Design Assistant testing functions.
These options include Network, Powering, Global Test, and Preferences.

Network: Tests the current network for signal, performance, and cascade errors.

Powering: Tests the current network for voltage and current problems.
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Global Test: Successively loads each specified network file in the specified directory and
tests them. Note that it will test them all with the specs currently in memory. Note also that
any unsaved changes to the currently loaded network will be lost.

Preferences: Allows the user to “turn off” testing for certain types of errors. This is an
option best left unexplored. It is possible to inadvertently turn off errors that are critical to
design.

Misc

The Misc pull-down is used to access various miscellaneous commands that are used
primarily for the maintenance of files, not production design. The miscellaneous
commands are described below:

Number of Free Nodes Displays the number of free nodes remaining in the current
network.

Resolve Branches Function used to attempt to reconstruct a corrupt network.
Network file corruption is EXTREMELY rare, so this
function will probably never be needed.

Override Current
Passing

Loads a file used to override the current passing capabilities
set within the Parameters file.

Enable Dialog Warnings Resets the program to display all dialog-warning boxes that
were previously disabled.

Set Import If you have multiple Design Assistant Viewers open, select
Set Import to tell the Drafting Assistant which one you want
to import from.

Update All Update All opens each network in the network directory and
saves it with the specifications.

Project Load Setting This command allows you to select how your Project Settings
are loaded and stored. Four options are available:

Default: Project Settings are manually loaded upon starting
the Design Assistant.

Project file stored with the network files: The Project
Settings file is stored in the same directory as the network file
that is being opened and only one Project Setting file is
allowed in each network directory.

All Project files are stored in one directory: Select the Project
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Path by typing or browsing for the path. There cannot be two
spec files named the same on the computer and there cannot
be two projects in the directory with the same named specs
and networks.

Load Specs automatically from last save: This option is used
when all of your spec files for multiple systems are stored in
one directory. After setting this option, create and save a
project file for one of the sets of specs. Open a network that
uses those specs. Opening networks that use different specs
will automatically load the specification files.

Figure 4-7

Reports

Multi-Net Downstream Summary: Creates an Excel spreadsheet that summarizes the
number of homes, amplifiers, route, and cable for any number of networks.

Network Tap Report: Creates a list of all the taps in the current network. The list
information includes the tap branch, node, address, part number, and port outputs.

View

Show Grids: Toggles the grid display on and off.

Show Tips: With this option turned on (default), an information tip relating to the
location of your cursor will appear in the lower right corner of the Design Assistant
window when in Design mode.



Design Assistant Pull-down Menus and Toolbars >>> Chapter 4

25

Help

The Design Assistant contains a complete on-line help system. Within this system you will
find three options to help you quickly locate the help you need.

1. Contents – Displays a list of high-level topics allowing the user to double to click
on a topic until the desired help is shown.

2. Index – Allows the user to type the first few letters of the desired topic to find
exactly what is needed.

3. Find – The most comprehensive option will look through the entire help system to
find specific words.

It is also possible to hit [F1] at any time within the Design Assistant to display context
sensitive help that will display help for the current menu.

The Help pull-down includes four more options: What’s New, About Windows, About
Design Assistant, and Key Info. What’s New displays the What’s New file detailing new
features in the current version. About Windows displays the Windows version and
registration information, and About Design Assistant display the Design Assistant version
information. Key Info displays information about the security key installed on the machine
including the serial number, products it will run, key date, as well as timer key expiration
date. Note: timer key expiration date will only be displayed for those using a temporary
or timer key.

Toolbars

In addition to the pull-down menus, the Design Assistant also makes use of toolbars that
give one-click access to a few Design Assistant commands.

New Network Starts a new network.

Open Network Opens an existing network.

Save Network Saves the current network.

Jump to Parent
Branch

If on a branch other than branch one, it will move the cursor
to the starting location of the current branch.

Jump Displays a limited jump dialog to jump to different branches.

Increment Entry If placed over an existing piece of equipment, it will change
the device to the next higher line number designated in the
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specification file. If placed in an empty column, pressing the
[ + ] button will place the first device found in the specification
file.

Decrement Entry If placed over an existing piece of equipment, it will change
the device to the previous line number designated in the
specification file. If placed in an empty column, pressing the
[ - ] button will place the first device found in the specification
file.

Test Network Tests the current network for signal, performance, and cascade
errors.

Test Powering Tests the current network for powering problems.

Edit Plugins Opens the Pad and Equalizer selector/editor for the amplifier
or tap at the current cursor location. See Chapter 7: Design
Menu, section Pad/EQ Selection.

Escape Functions as an Escape key.



Utilities

Utilities

The Design Assistant contains many commands that are functional in multiple menus. In
this chapter, we will discuss these utilities in detail. Also, there is one global command,
Macros, that is functional in every menu. The Macro command allows you to record
repetitive keystrokes that you can play back at any time. Due to the tremendous potential
of Macros, we have dedicated an entire chapter to it. See Chapter 11: Macros for a
complete overview of the Macro command.

Jump

This command includes a host of ways to move quickly to other parts of the network. The
simplest and most obvious use is to enter in the number of the branch and node where you
want the cursor to move, in the form "<branch>.<node>". If either branch or node is not
specified, it will be left unchanged (e.g., if the cursor was at location 1.7, "5" would move
the cursor to 5.7; ".5" would move the cursor to 1.5). Attempting to move the cursor beyond
the last branch or the last node in a branch will move the cursor to the last branch or node,
as appropriate. Additionally, several other options exist at the Jump menu:

[Home] Search for amp label: The computer will prompt for an amplifier label and then
jump to its location. The entire label need not be entered. This command will
search for the first amplifier whose label begins with the search text.

[Home][Home] Repeat amplifier search: The cursor will be moved to the next amplifier
after the cursor's current position that matches the search string.

[Ins] Search for power supply label: The computer will prompt you for a power supply
label and then jump to its location. The entire label need not be entered. This
command will search for the first power supply whose label begins with the search
text.
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[Ins][Home] Repeat power supply search: The cursor will be moved to the next power
supply whose label begins with the search text.

[ / ] Search for comment: Searches for a text string within a comment or sticky note. The
entire comment does not need to be entered. This command will search for partial
text strings.

[ - ] Search for branch label: Searches for a branch label or name.

[.][-] Low V/dB: Locates the lowest voltage if in the powering menu or the lowest high
channel signal level if in the Design screen.

[End] Locate footage pair: Will prompt for one or two footages in the form
"<footage1>.<footage2>". The cursor will be moved to the first pair of footages
matching the search pair, even if they are separated by a single zero node or coupler.
If the second footage is not entered, the cursor will be moved to the first matching
footage.

[End][End] Repeat footage search: The cursor will be moved to the next footage or footage
pair matching the search footage(s) entered the last time the footage search
command was used.

[Del] Search for map#/loc#: The computer will prompt you for a map and location number
in the form of "<map>.<location>". The cursor will then be moved to that position.
If only a map number or a location number is entered, the cursor will move to the
first node that matches that map or location number.

[Del][Del] Repeat map and location number search: The cursor will be moved to the next
map and/or location number matching the search string.

[+] Overhead view: Puts full-screen overhead view of network on screen. Arrow keys
may be used to move the cursor to the desired node. The number of the node under
the cursor will be displayed in the upper-left corner of the screen. Pressing [Enter]
will return to the menu from which jump was invoked with the cursor located at the
node selected. Pressing [Esc] will return to the menu without moving the cursor.

[] Move to the previous active.

[] Move to the next active.

[] Move to the previous split location.

[] Move to the next split location.

[Page Up] Moves cursor to previous power supply location.
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[Page Down] Moves cursor to next power supply location.

[ . ][ / ] Jump to previous trans (transformer).

[ . ][ * ] Jump to next trans (transformer).

[F5] Jump the Next PCD.

[F6] Jump to the Previous PCD.

[ScrLk] Jump to Address. The entire address does not need to be entered. This command
will search for partial text strings.

Amplifier Definition Window

[.][+] Opens the Amplifier Definition Window from any Design or Powering menu. This
command is not actually displayed on any menu. The Amplifier Definition Window allows
the entry of a unique identifying name up to 256 characters for each amplifier in a network.
Simply type in the name for that amplifier, followed by the [Enter] key, then press [Page
Down]. Names up to 256 characters long may be applied to power supplies as well by
pressing [.][+] while the cursor is on a power supply. In addition, up to four extensions of
one or two characters each may be specified for each amplifier. These extensions,
appended onto the amplifier name, are the names of the feeder networks that begin from
this amp.

Note: While only fourteen characters for each amplifier and six characters for each power
supply are displayed on the Design screen, the full length name is retained in memory.

Also, after an amplifier has been named (during one design session), the name is retained
and displayed the next time the Amplifier Definition Window is opened. Hitting the [+] key
will increment the last number or character in that amplifier’s name. For example; if one
amplifier has been named “Den01-01”, press [.][+] after moving to the next amp location.
The name “Den01-01” will be displayed on the first line of the Amplifier Definition
Window. Press [+] and the name will change to “Den01-02”. Finish the naming of the
second amplifier by pressing [Enter] followed by [Page Down].

You may change the name of the amplifier or the networks attached to it at any time and if
the networks connected to the amplifier already exist, they will be renamed automatically.

Commands available within the Amplifier Definition Window:

[],[]: These will move the cursor up or down between entries within this
window.

[]: If a number is displayed in brackets to the right of the two-character extension
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for a given network, this signifies that the compressed legs corresponding
to this network have been appended using the Autoappend or AppendArea
functions. If Autoappend has been used and no number appears there, this
indicates that either the network has not been entered or that the network
does not contain any active devices. If such a number is displayed, pressing
the right-arrow key will move the cursor to the starting point of the
appended branch indicated.

[Page Down] : If pressed when the cursor is on one of the network positions in the
window (that is, any of the "Net #" lines), this will create that network and
prompt to save the network if any changes have been made. Or, if the
network had been previously created, it will load that network, again
prompting for a save if any changes have been made. If you do not save
your changes, they will be lost -- this includes any changes to the names in
the Amplifier Definition Window.

[Delete]: This key, when pressed while the cursor is over one of the network
positions, will delete the network extension from the window, optionally
deleting the network of that name on disk as well.

[Esc] or [Num Lock]: Closes the window, saving the information within.

When designating the number of feeder legs connected to
the amplifier, if the network exists, the port and
feedermaker number is displayed in the Amplifier
Definition window. If it states “Not Found”, this
represents the fact that you have told the Design Assistant
that a particular amp will have a network connected here,
but you have not yet created those networks.

Note that whenever network names are changed through
this window, either through changing the amplifier name
or the individual network name, if any of the networks
named on disk do exist, they will also be renamed.

Please note that the use of feedermaker networks is not at all common in today’s
architectures. The Amplifier Definition Window is used mostly to simply name amplifiers.

MDU Definition Window

Pressing [-][9] in the Entry menu displays the MDU Window. Pressing [.][7] in the Design
menu or [.][.][7] in the Power menu also displays the MDU Window. The MDU Window
is designed to allow tap selection based upon drop length, drop coupler loss, drop cable
type, and quantity of drops desired instead of minimum tap output and house count. The
MDU Window is also where elaborate arrays of Network Interface Units (NIUs) may be
input. When the MDU Definition Window is being defined for the first time (before any

Figure 5-1
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taps are placed), you will see something like the following:

Figure 5-2

Figure 5-2 shows a simple MDU Definition Window setup. The MDU drop specification
box contains 5 columns:

“Tap Number” is the number of taps that can be placed at one location. You may define
up to four separate taps to feed your respective drops.

“Distance” refers to the drop length information -- from the tap to the end of the drop
(converter, TV, etc.). In this case we are expecting the longest drops to be 150 feet
and the shorter drops to be 75 feet. The long drops will be fed from the first tap
and the short ones from the second tap.

“Coupler ID” needs to have some coupler ID entered here! If you do not want your
design to include the loss and the drops created by a drop splitter, then you must
define a fake zero loss coupler in your spec files and input that coupler ID here.
The “102” here represents a 2-way drop splitter. If you are using Network Interface
Units (NIUs) in your design, you will input the NIU drop array code here and it
will be displayed in “[ ]” brackets to let you know that it is an NIU array. It is
necessary to use the MDU window for all NIU nodes that require any NIU array
configuration other than the default. The default NIU array configuration is defined
on line 1 in Page 4 of the Couplers file.

“Cable” refers to the type of cable you wish to use for the drops. In this case, cable
type “14” is RG 6.

“Level” represents the minimum level required at the end of the drop. Level “14” in
these specs (SAMPLECITY) is defined as 4.5 dB at the forward high frequency
and 1.0 dB at the forward low.

“Quantity” represents the number of drop ports required. The maximum value for this
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column is 8 since we have a maximum of an 8 port tap. If you have specified a 2-
way drop splitter (as in this case), then a “qty” of 8 will actually produce 16 drops.

The Design Assistant will automatically tally up all of this MDU drop specification
information and pick a tap that meets the criteria. Any time an MDU is defined at a node,
this MDU information will override any tap level information specified in the “lv” column
in the Design screen. Once an MDU has been defined, the house count will be displayed
in “< > “ underlined angle brackets. By defining a node as having MDU information, the
Design Assistant will separate the MDU house count from the residential house counts on
the Bill of Materials.

You may define up to four separate taps to feed your respective drops. This accounts for
a maximum of 32 drops. If your house count at any one node exceeds 63, the Design
Assistant maximum, it will be necessary to “break up” the house count and put it on two
nodes separated by a zero footage.

If you need to separate MDU counts from residential but do not wish to design the MDU
with the window, you may count it as a “non-design MDU”. To invoke this command,
press the [Delete] key while in the MDU Definition Window. The message “MDU not
included in design” will appear in the MDU drop specification box. Any non-designed
house count will be displayed in “< >“ angle brackets as opposed to our normal underlined
angle brackets. For any non-designed house count, the Design Assistant will not
automatically pick any taps, but it will flag any level specified in the “lv” column in the
Design screen (not the MDU window) that has not been satisfied at that node. Press the
[Delete] key one more time to make it active.

Check the Commercial box in order to register the MDU as a commercial count on the
BOM.

The bottom portion of the MDU window

“Tap Port” is the heading for the first column. The “tap#” specifies which of the four
possible taps feeds this particular drop and “(port)” specifies which port out of that
tap examining. For example, on the next to last line, 2(3) means that this drop is
being fed from the third port on the second tap.

“MDU Line(Array#)” is the heading for the second column. The MDU line represents
to which line from the MDU drop specification box we are referring. Array# refers
to the specific drop in the “qty” column that ends with the levels displayed to the
right.

“Coupler ID” is the heading for the third column. The “Coupler ID” displays the drop
coupler or NIU array ID number. The number in the brackets represents which
drop within a multi-drop NIU array the levels to the right are referring to.

The remaining columns represent the signal levels at the forward high, forward low,
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return high, and return low frequencies. Note that these signal levels are the levels at
the end of the drop, not the level out of the tap ports.

Commands available within the MDU Definition window:

[Del]: Toggles between design and non-design status for the house count at that
node. If non-design is selected, the house count will be included in the total
house count for BOM purposes but no design will be produced for it.
Angled brackets "< >" indicate non-design MDU's. Angled brackets that
are underlined "< >" indicate standard MDU counts.

[],[],[],[]: Move between entries in the MDU window.

[Enter]: Pressed without first entering any numerical data, the [Enter] key will
cause the last number input into the column being worked on to be
entered -- even if the last such entry was in a different window. For
example, if your drop cables are all type 238 and you will be using only
level 15 for the drop level you need only enter those in once when the
program is first started. From then on pressing [Enter] in the cable and level
columns will automatically set the drop cable type to 238 and the drop level
to 15. Of course, if you type another value in one of these columns it then
becomes the default.

[Esc] or [Num Lock]: Closes the window, saving the information within if at least
one drop splitter has been specified.

Network Initialization Window

The Network Initialization Window sets the starting signal levels and distortion levels for
a network. It may be accessed at anytime from the Entry menu (by pressing –4) or from
the Tools pull-down menu to change the starting signal levels for the current network.
Anytime the Network Init command is invoked, the Design Assistant will display this box:
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Note: the Network Initialization box will also be displayed once a new network has been
created to set the starting levels for the new network.

Clicking on the Feedermaker network checkbox signifies that the network being created is
a feedermaker network. Since most networks in today’s architecture do not contain
feedermakers, this option is normally not checked. When checked, the options to enter the
feedermaker type, port number, and bridger type become enabled. If the Feedermaker
option is checked, the signal levels will be set automatically and cannot be edited by a user.
This is a safety feature to ensure that a network is not started with incorrect levels.

Bridger types and their levels are defined on the Bridgers\Feedermakers\In line Eqs tab in
the Actives spec file. A 1 in the Bridger type will start with the signal levels set for BR1
and subtract the loss of the feedermaker (and port) entered above.

The Amp and LE Cascade make it possible to set the cascade that may already exist. Both
of these will be set to 0 in most cases, but this feature makes it possible to track cascades
accurately in the case of a plant extension.

The next section, Starting Levels, sets the starting signal level at each of your 10 design
frequencies. Please note that setting a starting signal level will have no effect if that
particular frequency is not enabled in the Parameters. If you are unable to modify the signal
levels, check to be sure the Feedermaker network option is not checked.

Figure 5-3
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The next section, Performance, sets the starting distortion levels at for each of your defined
distortion types. If not sure, we suggest setting these levels to 99. Pressing OK will set the
new levels and return to the network.

Global Change Menu

The Global Change pull-down menu is accessible from the Design menu and the Powering
menu. As discussed in Chapter 4: Pull-down Menus and Toolbars, you have four options:
Cables, Levels, Maps, and MapGrid. Selecting any of these options opens a separate menu.

Cables

The Cables submenu is helpful if you have to change the cable type for many nodes at
once. It gives options to change the cable type for a node, for a branch, or even for the
entire network.

Commands include:

[1] Jump: Allows you to quickly "jump" to virtually any place in the network. Please see
the Jump section at the beginning of this chapter for more information.

[2] TglCbCr (Toggle cable carry on/off): When cable carrying is turned on, it copies the
cable number used at the node where cable carry is turned on to any nodes to which
the cursor is moved. Selecting this command again will toggle this option off, and
return the cursor to normal. The cable type being carried may be changed with
function [7], Select Cable. When this function is invoked, you will be prompted
whether to replace, replace physical, or replace electrical. Selecting replace will
replace all digits of all cables downstream with the identical cable type that is at the
cursor location. Replace physical will replace only the last two digits of the
downstream cables thereby keeping the cable series (0 through 900) that was
previously input. Replace electrical will replace the last two digits but not affect
whether the cable is odd or even thereby keeping the aerial/underground status as
well as the cable series.

[3] FilBrnch (Fill this branch with current cable #): Copies the cable number used in
the node under the cursor to all nodes below it in the current branch. When this
function is invoked, you will be prompted whether to replace, replace physical,
replace electrical, or replace single. Selecting replace will replace all digits of all
cables downstream with the identical cable type that is at the cursor location.
Replace physical will replace only the last two digits of the downstream cables
thereby keeping the cable series (0 through 900) that was previously input. Replace
electrical will replace the last two digits but not affect whether the cable is odd or
even thereby keeping the aerial/underground status as well as the cable series.
Replace single will replace only a single type of cable downstream with the cable
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currently under the cursor.

[4] FilNet (Fill net with cable #): Copies the cable number used in the node under the
cursor to all nodes fed from it. Setting the cable at node 1.1 and using this function
will set all cables in the network to that particular number. Replacement options
are the same for this function as they are for function [3], "Fill this branch with
current cable #".

[5] Series: Finds and replaces cable ID. First, enter the Cable Series to be replaced, then
enter new Cable Series ID.

[7] Select cable at this node: Prompts for a cable number and, if one is entered, sets the
cable at the cursor to that number.

[9] Toggle display: Allows you to toggle through three displays of cable types. The first
display lists cables 0-15 from the Cable specification file. The second display lists
cables 12-27 and the third lists cables 24-39.

[.][+] Open Amplifier Definition Window. Within this function you may set the amp
identifier for the amplifier at the cursor location and assign the feeder legs that
begin from that amp (if any) as well as move to, create, rename, or delete these
feeder legs. Please see the Amplifier Definition Window section earlier in this
chapter. Note: this function is not displayed in the menu.

[.][-] When invoked from a feeder leg, this command will load the trunk line to which the
feeder leg is attached and place the cursor at the amplifier from which it originates.
Note: this function is not displayed in the menu.

Maps

This menu has similar functions as the Cables menu except that they are oriented towards
the map and location number. Commands include:

[1] Jump: Allows you to quickly "jump" to virtually any place in the network. Please see
the Jump section at the beginning of this chapter.

Map:

[2] Carry: When map carry is on, it copies the map number under the cursor to any
nodes to which the cursor is moved.

[3] FillBrnch (Fill Branch): Copies the map number used in the node under the
cursor to all nodes below it in the current branch.

[4] FillNet (Fill Net): Copies the map number used in the node under the cursor to
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all nodes fed from it.

[7] Select: Allows you to select a map number at the cursor location.

[8] Clear: This function clears all map numbers downstream of the cursor.

Location:

[.][2] Carry: When location carry is on, it will set the location number field of each
upstream or downstream node to either one less or one greater than the
previous node depending on which direction the cursor is moved.

[.][3] FillBrnch (Fill Branch): Beginning with the first node downstream of the
cursor, this function sets the location number field of each node in the current
branch to one greater than the previous node.

[.][4] FillNet (Fill Net): Beginning with the first node downstream from the cursor,
this function sets the location number field of each node to one greater than
the previous node.

[6] Select: Allows you to select a location number at the cursor location.

[.][8] Clear: Clears all location numbers downstream from the cursor.

[.][+] Open Amplifier Definition Window. Within this function you may set the trunk
amp identifier for the amplifier at the cursor location and assign the feeder legs that
begin from that trunk amp as well as move to, create, rename, or delete these feeder
legs. Please see the Amplifier Definition Window section earlier in this chapter.
Note: this function is not displayed in the menu.

[.][-] When invoked from a feeder leg, this command will load the trunk line to which the
feeder leg is attached and place the cursor at the amplifier from which it originates.
Note: this function is not displayed in the menu.

Levels

This menu has similar functions as the Cables submenu and the Maps submenu except that
they are oriented toward the minimum tap output levels. This menu is helpful if you want
to test what effect a different tap output level will have on an existing network.

Commands include:

[1] Jump: Allows you to quickly "jump" to virtually any place in the network. Please see
the Jump section at the beginning of this chapter.
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[2] Carry: Copies the level number used at the node where level carry is turned on to all
nodes to which the cursor is moved. The level type being carried may be changed
with function [7], Select. Turning this option off returns the cursor to normal.

[3] Fillbrnch (Fill Branch): Copies the level number used in the node under the cursor to
all nodes below it in the current branch.

[4] FillNet (Fill Net): Copies the level number used in the node under the cursor to all
downstream nodes. Setting the level at node 1.1 and using this function will set all
levels in the network to that particular number.

[5] Add Level: As noted in the Chapter 10: Building Specification Files, section
Parameters, there are up to 16 tap output levels defined in the Parameters file and
are represented by levels 0-15. These 16 levels are termed “system-wide” levels.
However, you may also create and modify 16 more levels, numbered 16-31, in any
given network, which will then show up in the Network-Specific levels window
(see [6], [8], and [9], below). Although these levels apply only to the network
currently in memory, they may be saved with the network, and then they may be
added to other networks by using [8], Load levels, described below.

[6] Change : Change a tap output/input level in the Network-Specific area (16-31) to a
new value. Note that this will change the required levels at all nodes currently using
the level you change. See [5] Level, above.

[7] Select: Prompts for a level number and, if one is entered, sets the level at the cursor to
that number.

[8] Load: Loads the Network-Specific levels (16-31) from an existing network. See [5]
Level, above.

[9] TgleDisp (Toggle Display): Allows you to toggle between the System-wide Levels
window and the Network-Specific window. The System-wide levels window
displays Page 3 in the Parameters specification file. Tap output levels beyond 15
may be specified in the Network-Specific window. These levels are specific only
to the network in memory. See [5] Level, above.

[.][+] Open Amplifier Definition Window. Within this function you may set the amp
identifier for the amplifier at the cursor location and assign the feeder legs that
begin from that amp (if any) as well as move to, create, rename, or delete these
feeder legs. Please see the section Amplifier Definition Window in this chapter.
Note: this function is not displayed in the menu.

[.][-] When invoked from a feeder leg, this command will load the trunk line to which
the feeder leg is attached and place the cursor at the amplifier from which it
originates. Note: this function is not displayed in the menu.
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Map Grid

This display shows the maps occupied by the networks in the current network directory.
They may be listed in either numerical (grid off) or geometric (grid on) arrangements,
optionally displaying the networks that are at least partially in the map at the cursor location
(list nets On). Grid and network display options are "sticky" and will remain set for as long
as you are in the Design Assistant or until you change them.

Commands include:

[0] Grid: Toggles between geometric (grid on) and numerical (grid off) display.

[.][0] TgleNm (Toggle Name/Number): Toggles the display from the map name view to
the grid number view. Custom map names are setup using the template and new
template commands.

[1] Jump: Allows you to enter the desired map number and the cursor will be moved to
that map. If the map does not exist in the current network path and the display is
in grid mode, the cursor will move to the blank space that would be occupied by
the map had it existed. If the display is not in grid mode, the cursor will not move.

[.][1] EntNme (Enter Name): Allows entry of a map name at the cursor location.

[2] NetList (Network Listing): Turn network listing on or off. The network listing
displays which network(s) contain each map number.

[3] Search: You may search for a particular entry by typing in both the map and location
number. This function will search through all networks that are wholly or partially
contained in the map specified for a node with that particular location number. If
one is found, it will respond with the network containing it. If desired, the network
containing this map and location number may be loaded by pressing [4] Load
Network.

[4] Load: If cursor is in the network listing ([9] Net/map toggles between network listing
and map area), the network at the cursor location will be loaded. If the network
listing is displayed, the cursor will automatically move into that area.

[.][4] Blkfill (Block Fill): Places custom map numbers defined in a template and replacing
the grid numbers. When invoked, a box is displayed giving the option to only fill a
certain area by indicating the top left and bottom right map numbers for the block
fill to take place within, or press [Home] to fill the entire grid.

[.][5] EdTmpl (Edit Template): Enters the template edit mode allowing entry of custom
map numbers. The template command will enter the existing map grid template.
Please see the section Creating a Custom Map Grid later in this chapter for an
example of how to use the template editor.
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[.][.][5] NewTpl (New Template): Enters the template edit mode, clearing all existing
values. Please see the section Creating a Custom Map Grid later in this chapter for
an example of how to use the template editor.

[.][6] Erase: Erases the custom map name, replacing it with the grid number.

[7] Map BOM: Allows you to create a BOM by map number. Place the cursor on the map
desired and press [7]. This function loads the networks included in the map either
wholly or partially into memory in order to perform its calculations. It will reload
the network currently being worked on after the Bill of Materials is complete. If
you have made any changes in the design since your last save, you will be asked if
you want to save them before continuing. If this prompt appears and you do not
save, all the changes since the last save will be undone.

[9] Net/Map: Toggles the cursor between the map list and the network listing.

[] Move cursor up.
[] Move cursor down.
[] Move cursor to the left.
[] Move cursor to the right.
[PgDn] Page network listing (if displayed) down.
[PgUp] Page network listing (if displayed) up.

Creating a Custom Map Grid

1. Break up your map names into parts that change and parts that don’t.

For example, if your map numbers look like those in the following grid:

G48-49 G48-50 G48-51
G49-49 G49-50 G49-51
G50-49 G50-50 G50-51
G51-49 G51-50 G51-51
G52-49 G52-50 G52-51

Then the center map (G50-50) would be broken up as follows:

G - never changes
50 - changes vertically by 1
- - never changes
50 - changes horizontally by 1
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We recommend that you build your map grid around the center of the map area by entering
the center map information into the initial pattern. Note: any map close to the center will
work as well.

2. Create a template [.][5] from the MapView option in the Entry menu.
.
To create a template for the grid above:

a. In the "initial pattern" column, type the letter G followed by Enter. The pattern length
will automatically be set to 1 for 1 character (G). This pattern doesn’t change so no further
information is needed on this line.

b. Arrow down to the next line (notice the G’s appear in the sample grid below). Enter 50
in the initial pattern column and press Enter. Pattern length is set to 2. This number
changes for each row (vertically by 1) so enter a "1" in the "Increment" column under the
"V". That will finish this row.

c. Arrow down again (notice the changes in the sample grid). Put a minus sign in the "initial
pattern" column. Once again this doesn’t change so no further information is needed on
this line.

d. Arrow down again (notice the changes in the sample grid). Enter 50 in the "initial
pattern" column and this time place a "1" in the Increment column under the "H".

e. Arrow down again (notice the sample grid now looks like the grid above).

f. This template is complete, so hit the Escape key and return to the main map grid.

3. We need to overlay our new map template on top of the default map grid.

a. Locate map number 5050 in the default map grid by moving the cursor with the arrows
or using the jump command.

b. There are two methods available for replacing the default map numbers with the ones
set up in the template, the blockfill option and the paint option:

1. The BlockFill option [.][4]. Before pressing [.][4] to start the "BlockFill"
function, determine the size of the map grid you wish to create. For this example,
we will use a 10 row by 10 column map grid with G50-50 being the approximate
center map. Determine which default map numbers represent the upper left and
lower right corner of the desired grid. We will use 5545 as our upper left and 4655
as our lower right. Press [.][4], the prompt asks for the upper left and lower right
coordinates enter 5545.4655 and press enter. You should have new map numbers
in a 10 x 10 grid with G50-50 as the approximate center map. It is also possible to
press [.][4] BlockFill followed by the [Home] key to replace all default map
numbers with your custom map numbers.
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2. The Paint option [5]. With the cursor placed on "5050", press the 5 key. This
turns on the Paint option (notice "5050" became G50-50). Move the cursor using
the arrow keys, notice the map number you move the cursor over changes to the
appropriate number from the new map grid. When you have finished changing all
the desired map numbers, press "5" again to turn off "Paint".

4. Press the Escape key to exit the map grid. You will be prompted to Save and Exit. Do
so by pressing the number 1. A dialog box will appear prompting you to enter a name for
the map grid file. Enter the desired name (naming the map grid with the same name as the
spec files will enable loading the map grid automatically when you load the project) and
then click OK.

.



Entry Menu

Entry Menu

The primary purpose of the Entry menu is to quickly input all strand or trench information
that is necessary for network design.

Figure 6-1

The Entry menu is where all the strand information, including branch structure, is input.
While in this menu, all functions must be preceded with a [-]. The “B” and “N” columns
are the branch and node numbers and are automatically generated on the fly by the Design
Assistant. The “ftg”, “hc”, “cab”, “lv#”, “map#”, and “loc#” columns stand for footage,
house count, cable type, tap output level, map number, and location number, respectively.
Pressing a [.] will move the cursor from one column to the next. A [Backspace] will
remove one character at a time in the current column, if no characters exist it moves one
column to the left. A [Enter] by itself will copy the information from the previous node.
The Design Assistant will automatically keep the cable type and map numbers input at
previous nodes until it is changed.

Commands include:

[-][0] Fwd/Rev: Toggles the entry mode between the default forward direction in which
the cursor is advanced one node forward after each entry and the reverse direction
where the cursor remains in place and all entered data are moved down. Selecting
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reverse entry automatically turns on insert. When on, this function will be
highlighted in reverse on the top of the screen.

The reverse entry mode can be useful if the designer wishes to begin at the end of
a strand/trench route and then work back upstream toward where the optical
receiver will be placed.

[-][1] Jump: Though not shown in the menu, this function allows you to quickly "jump"
to virtually any place in the network. Please see Chapter 5: Utilities, section Jump.

[-][2] Ins/Ex (Insert/Exchange): Switch between insert and exchange modes. The default
mode is exchange where all data, if entered on a line with an existing node, replaces
the data already on the node. In insert mode, data entered at an existing node will
be inserted at the cursor position, moving any nodes on or after the cursor down
one. Thus, in insert, a footage entered at node 1.8 will create a new node 1.8 with
that footage, and the previous 1.8 will be moved to 1.9.

[-][3] Return: This command moves the cursor to the end of the branch feeding the current
branch. This is helpful if you wish to enter sub-branches as you get to them and
then continue entering the main branch. This command will have no effect if
invoked from branch 1.

[-][4] NetInit (Network Initialization): Displays the network initialization window. This
is useful if your network was originally created using the wrong signal levels.
Please see Chapter 5: Utilities, section Network Initialization Window for more
information.

[-][.][4] Label: This function allows you to give your branches a name up to 14 characters.
Once a branch is named, the name will display, in brackets “[ ]” directly to the right
of the branch information. For example, if you named branch 3 (of 7) “Broadway”,
then the top of the screen would show “Branch 3 of 7 [Broadway] Starting 1.4. Any
branches fed from “Broadway” and not specifically given a name of their own will
display the name “Broadway” in parenthesis “( )”.

[-][5] ChBrSt (Change branch start): Allows you to move the starting point of the branch
currently displayed to a different node. Branches may not be moved so that they
form a loop or so that more than two branches begin at a single node. If loop
creation is attempted, a warning message will be displayed and the branch start will
not be moved. This command is very useful when a node with a branch start point
has accidentally been deleted. In this case, you would get an error message that
said “Branch x does not begin anywhere”. If you need the information that is on
branch x, jump into that branch and change the branch start point to the correct
node.

[-][6] ChAfTh (Create branch after this branch): Creates a new branch immediately
after the branch currently displayed on the screen, increasing the branch number of
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all subsequent branches by one. For example, if you were creating a branch from
branch 3 in a network consisting of 5 branches, the branch this would create would
be branch 4. The old branch 4 will automatically be renamed to branch 5, branch
5 will be renamed to branch 6, and so on.

[-][.][6] New Network: Create a new network.

[-][7] ChAfLst (Create branch after last branch): Creates a new branch after the last
branch in the network. Branch numbers of all existing branches in the network are
unchanged. This is the recommended method of branch creation for new users.

[-][8] DelBr (Delete Branch): Deletes the branch currently displayed. When invoked,
you will be asked to confirm the deletion of that branch (yes or no). Selecting
“Yes” will delete the current branch and all downstream branches.

[-][9] SetMDU (Set MDU): Designate the house count of a node as being an MDU house
count or edit the MDU information regarding a node already designated as having
an MDU house count.

[-][.][9] DpMDU (Duplicate MDU): Automatically copies the MDU information that was
input at the previous MDU location. Please see Chapter 5: Utilities, section MDU
Definition Window.

[Ins] Insert a node with zero footage and house count and the same cable type as the node
above at the cursor position without changing insert/exchange mode status.

[Del] Deletes the node under the cursor. Note that if a branch begins at the deleted node,
the branch itself is not deleted only the starting point of that branch is deleted.

[-][.][+] Name: Opens Amplifier Definition Window. Within this function you may set
the amp identifier for the amplifier at the cursor location and assign the feeder legs
that begin from that amp (if any) as well as move to, create, rename, or delete these
feeder legs. Please see Chapter 5: Utilities section Amplifier Definition Window.

[-][.][.][+] Notes: The “Sticky Note” function allows entry of a text note at any node in
the network. This note may be used to enter any information desired. If your
project calls for the same basic information at many locations, you may press

Figure 6-2
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[Escape] and [9] to attach a previously designed form. You may create this form
in any text editor and save it as <filename>.F00. [Escape] will display the other
options of Keep changes, Discard changes, Restore, and Clear. Once the changes
to the note have been kept (saved), the Design Assistant will display a yellow
musical note “ ” on the line between the “cab”
and “lv columns.

Active Entry Menu

The primary purpose of the Active Entry menu is to enable quick design where levels and
equipment values are calculated as entry is done. This may be a good mode to use for
adding a small extension to an existing network. Notice that there are no menus or buttons
available while in this mode.

Figure 6-3
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Design Menu

Design Menu

The Design and Active Entry mode is where all actual design work is done. The Design
menu contains many powerful design optimization tools whereas the Active Entry menu
does not have access to these tools. The Active Entry mode is simply used for quick entry
of strand and equipment information. Most users prefer to work within the Design menu
because of the available tools and flexibility. The Design screen displays the strand
information input in the Entry (excluding the map and location numbers) as well as signal
levels, amplifiers, taps, and couplers.

The Design screen looks like this:

Figure 7-1



Chapter 7 <<< Design Menu Lode Data Corporation

48

Figure 7-1 gives an example of a small network displayed in the Design mode. The top
portion of the screen displays the menu. Still on the top line, to the right of the menu name
is the name of the network and the starting point of the current branch. The next three lines
of the menu display the functions and the key(s) used to activate them. In the bottom left
corner of the screen, names of the spec files currently in memory; just to the right of that
is the current branch number and the type of feedermaker this network was created with.
The remainder of this screen is separated into the following columns:

N: Displays the node number. Not to be confused with a fiber node, a node (in this context)
within the Design Assistant is simply a line of information. It is useful for jumping
to specific locations in the network.

750: Displays the forward 750 MHz frequency (this column is usually reserved for your
highest forward analog frequency). 750 in this case is just a label (entered in the
Parameters spec file). The Design Assistant is capable of doing design at any
frequency. The signal level displayed here is the level after the footage specified
on the same line but before the insertion loss of any equipment. Thus, it is the input
to any equipment located at this node.

54: Displays the forward 54 MHz frequency (this column is usually reserved for your
lowest forward analog frequency). 54 is just a column label and can be changed in
the Parameters spec file.

42: Displays the return 42 MHz frequency (this column is usually reserved for your highest
return analog frequency). 42 is just a column label and can be changed in the
Parameters spec file. Note that this level is also the level after the footage. It is the
level required from this location to make the minimum reverse input into the
previous amplifier.

5: Displays the return 5 MHz frequency at this location (this column is usually reserved
for your lowest return analog frequency). 5 is just a column label and can be
changed in the Parameters spec file.

ftg, hc, cab, lv: These values are the footage, house count, cable type, and desired tap
output level. Although these values are usually entered into the Entry screen, you
may edit them (by pressing “0” to alter the field) or add new ones from within the
Design screen.

amp: This is the amplifier column for any amplifier defined in the spec files. In-line
equalizers or any of the “Q#s” (see Chapter 10: Building Specification Files,
section Actives) are also placed in this column.

taps: This column is wide enough to display up to four taps on any one line. This provides
a maximum of 32 ports (four 8 port taps) on any one line. If your house count
requires more than 32 ports, you must break up the house count and feed the
remainder from a line with a zero footage.



49

Design Assistant Design Menu >>> Chapter 7

cplr[b]cplr[b]: These columns are for couplers and branch numbers. The number within
the brackets is the number of the branch that begins at that node. A number directly
to the left of the “[b]” is the coupler ID number. A “- [b]” indicates that there is a
branch originating at this location but a coupler type has not yet been specified.

550: Displays the forward 550 MHz frequency. 550 is just a column label and can be
changed in the Parameters spec file.

F4, F5, F6: The remaining possible forward frequencies. The Design Assistant has the
capability to design using up to 6 forward frequencies. Notice that there are no
signal levels in these columns; this is because these last three forward frequencies
were not enabled in the Parameters spec file.

R3, R4: The remaining possible return frequencies. The Design Assistant has the capability
to design using up to 4 return frequencies. Notice that there are no signal levels in
these columns; this is because these last two return frequencies were not enabled in
the Parameters spec file.

Reading the Design Screen

Reading the Design screen can be tricky for new users, so here is a breakdown of what you
are looking at. The numbers in the “N” column are the node number (or line number) in
the current branch. The node number is useful when trying to jump from one location to
another. The signal levels displayed are the levels after the footage that is on the same line,
but before any equipment. Therefore, these signal levels represent the input to the first
piece of equipment on that line. For example, in our Figure 7-1 at node 1.7, 23.76 is the
750 MHz input to the first amplifier. The line below the last footage displays the signal
(in the signal level columns) that continues through the last tap (0.00 if self-terminating
tap). It also displays the tap port output in the taps and coupler columns.

In the equipment columns (amp, taps, cplr[b], cplr[b]) the Design screen is read from left
to right. For example, if there is a line with an “11”, “[26]”, then a “8[2]”, this represents
an active ID 11 line extender feeding a 26 value 4-port tap feeding a DC8 (which creates
branch 2). In this case, the 4-port tap is on the input of the coupler. If the tap needs to be
on the output of the coupler, the house count and tap must be placed on a node with a zero
footage directly after the coupler. A zero footage can be used anytime multiple pieces of
equipment must be placed at the same location.

The taps column is wide enough to input up to four taps at one node. This accounts for a
maximum house count of 32, four 8-port taps. If a house count greater than 32 is desired,
then the remainder of the house count should be placed on a zero footage node. The taps
will display the tap value (as input in the spec files) within one of four different types of
brackets that identify the number of tap ports. “/ /” represent a two-port tap, “[ ]” represent
a 4-port, “{ }” represent a 6-port (if any), and “<>” represent an 8-port tap.
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The coupler columns display the coupler ID# as well as the branch number that is created
by that coupler. The branch number is displayed in brackets “[ ]” if it is considered a
normal branch -- that is the branch has information on it and is not a backfeed or
forwardfeed. The branch number is displayed in parentheses “( )” if there is no information
on that branch. The branch number is displayed in curly braces “{ }” if a backfeed and
angle brackets “<>” if that branch is a forwardfeed. Directional couplers and unbalanced
3-way splitters may be entered so that the high leg is directed to any of the branches. The
normal process for entering couplers is to place the cursor in the coupler column and press
[0] to Alter and then enter the ID# of the desired coupler, like 8 for a DC 8, followed by
enter. This will place a split configuration in the Design screen that looks like the
following:

8[2] (For a drafted example see Figure 7-2A at the end of this section.)

In this case, the through leg of the DC is feeding branch 1, and the tap leg is feeding branch
2. If you wish the tap leg of the DC 8 to feed down the screen to branch 1 and the through
leg to feed branch 2, you must press [0] to Alter and [-][7]. This will place a split
configuration in the Design screen that looks like the following:

8-[2] (For a drafted example see Figure 7-2B at the end of this section.)

To input a 3-way splitter with the through leg feeding down screen (branch 1), press [0] to
Alter and [3] assuming that “3” is the coupler ID number of your 3-way splitter. This will
produce a splitter configuration in the Design screen that looks like the following:

3[2][3] (For a drafted example see Figure 7-2C at the end of this section.)

In this case, the through leg is feeding branch one, and the tap legs are feeding branches 2
and 3. If you want the through leg to feed branch 2, press [0] to Alter and [-][3] to produce:

3-[2][3] (For a drafted example see Figure 7-2D at the end of this section.)

Here the through leg feeds branch 2 and the tap legs feed branches 1 and 3. If you want
the through leg to feed branch 3, press [0] to Alter and [-][-][3] to produce:

3=[2][3] (For a drafted example see Figure 7-2E at the end of this section.)

Here the through leg feeds branch 3 and the tap legs feed branches 1 and 2.

General Cursor Movement

Commands accessible from Design menu:
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[.][] Move to node 1 of the current branch.

[.][] Move to the end of the current branch.

[.][] Move to first branch beginning at this node.

[.][] Move to second branch beginning at this node.

[.][Page Down] Move to the last branch of the network.

[.][Page Up] Move to branch 1.

[Home] Move up one screen of nodes.

[End] Move down one screen of nodes.

[Ins] Insert empty node at cursor position.

[.][Ins] Insert empty node below cursor position.

[Del] Delete node at cursor position.

[.][Del] Undelete node, placing previously deleted at
cursor position

[+] Increase value: When activated over a tap or two-way coupler (splitter or DC), will
change it to the next higher value tap or two-way coupler and recalculate signal
levels. If used in a tap column where there is no tap present, it will select a tap to
put there. If used in the active column, it will change the device there to the next
line number, if no active is present, it will place an active ID number11.

[-] Decrease value: When activated over a tap or two-way coupler (splitter or DC), will
change it to the next lower value tap or two-way coupler and recalculate signal
levels. If used in the coupler column where a branch has been created but no coupler
has been specified, it will place the first two or three way coupler listed in the spec

Figure 7-2
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file. If used in a tap column where there is no tap present, it will select a tap to put
there; if used in the active column, it will change the device there to the prior line
number; if no active is present, it will place an active ID 11.

[/] Toggle display format: Switches the network display between normal (one line per
node) and expanded (five lines per node). The expanded display shows, in addition
to the normal display, the output from each tap, pads and equalizers used if there is
an active device on that node, footage from last device and from the beginning of
the network, dB of cable from the last device and from the beginning of the
network, cascade depth, and output from the node. The actual expanded screen at
an amplifier location will look something like the following:

Guide to expanded display format:

A The normal display of the signal levels, ftg, hc, cab, etc.

B Underground housing used at this node – blank if none

C Amplifier name (if named amp exists)

D Map number – if entered in Entry screen

E Forward pad value

Figure 7-3

Figure 7-4
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F Forward equalizer value

G Power supply name feeding this node if there is an amp here – shown in brackets
if PS is located at this node, in parenthesis if not

H Location number – if input in Entry screen

I Reverse pad value

J Reverse equalizer value

K Aerial distance to previous active (only displayed if there is an amp or split at this
node)

L Aerial distance to start of network (only displayed if there is an amp or split at this
node)

M Total distance to previous active or split (only displayed if there is an amp or split
at this node)

N Total distance to previous active (only displayed if there is an amp or split at this
node)

O Total distance to start of network (only displayed if there is an amp or split at this
node)

P dB of cable to previous active or split (only displayed if there is an amp or split at
this node)

Q dB of cable to previous active (only displayed if there is an amp or split at this
node)

R dB of cable to start of network (only displayed if there is an amp or split at this
node)

S Cascade depth of amps (amp codes 61-89 and 41-49) – Cascade depth of line
extenders (LE codes 11-33H)

T Quantity of amps (including this amp) from this node downstream – Quantity of
line extenders from this node downstream

U Total house count (including HC at this node) downstream to end of line

V Signal levels leaving node – after equipment but before next distance
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W Tap port output signal levels – displays a “—“ if there is no tap present

X Tap number – may display tap pad and equalizer values instead if using any type
of tap that utilizes plugin pads and equalizers. Values for forward EQ’s are
displayed under ftg, return EQ’s under hc, forward pads under cab, and return pads
under amp.

Design Commands

[*][*] Macro: Allows you to create and edit macros. Please see Chapter 11: Macros for
more information. Also on the Tools pull-down under Macro Options.

[Enter] Recalculates signal levels at the cursor location and moves the cursor down one
line. Note: This command is not shown on the menu.

[0] Alter: Prompts for the ID number of a new piece of equipment to be placed at the
cursor position. If the cursor is in the ftg-hc-cab-lv column, this will allow editing
of the information under the cursor; if no cable type or tap output level is specified,
the previous type will be retained. In the tap columns, it is possible to specify the
number of ports desired on the tap and the system will automatically select the
value. In all columns except the ftg-hc-cab-lv, pressing the [0][Home] key will
display a list of possible equipment (as defined in the current spec files) to be input.
Placing the cursor on the desired piece of equipment in the list and pressing [Enter]
will place the highlighted piece of equipment at that location.

[.][0] Break (Break node): This will break the node under the cursor into two nodes,
always keeping the footage and cable in the first node and the coupler(s) in the
second node. Taps and actives may be shuffled between the two nodes depending
on the cursor position when this command is invoked. If the cursor is on the
ftg-hc-cab-lv column, the house count and all equipment other than the footage and
cable type will be placed on the second node. If the cursor is in the LE column, the
LE and any couplers will be moved to the second node, but any taps will not be. If
the cursor is on one of the tap columns, the tap, house count, amplifier (if present),
and coupler (if present) will all be moved to the new node. In each case, any
couplers will be placed on the second node, and if the cursor is on either of the
coupler columns, no other piece of equipment will be placed on the second node.

[.][.][0] SpcVw (Spec View): To invoke this command you must type [.][.][0]. Then, select
the number to the left of the spec file you want to view. This function will display
the specified spec file (2-9) in a separate window. You can then use the arrow keys
to view the entire file but no changes can be made to the file. Pressing [Escape] will
return to the normal view. Note: this display of the specs has been modified in a
print format and will not look identical to the spec editors.

[1] Jump: Allows you to quickly "jump" to virtually any place in the network. Please see
Chapter 5: Utilities, section Jump for more information.
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[.][1] Join (Join nodes): Combines the node under the cursor with the following node, into
one node. Note: this cannot be done if the first node has equipment and the second
node has a non-zero footage, or if the two nodes have different cable types.

[.][.][1] Xspec: To invoke this command you must type [.][.][1]. When this function is
called, it displays 10 sets of spec files (Parameters, Actives, Taps, Couplers, Cables,
Pricing, and Performance) labeled 0 through 9. Pressing the corresponding number
will load all the specs listed on that line. You may edit this file from here by
pressing the [ / ]. See Chapter 10: Building Specification Files section Xspec File
for more details.

[2] Forward (Forward execute single node): Selects taps and optionally equalizers,
recalculates signals, and advances to the next node.

[.][2] BkFeed (Backfeed): If cursor is not at the start point of an existing backfeed (pole#
1039 in Figure 7-5) or the node immediately following a backfeed (pole# 1040),
this command will create a new branch containing a backfeed of one node in length
beginning at the cursor position. If the cursor is at the starting point of an existing
backfeed (pole# 1039), it will extend the existing backfeed by one node. If the
cursor is at the node immediately following an existing backfeed (pole# 1040), this
function will move the starting point of the backfeed to the node at the cursor,
extending it forward one node in the process. If a backfeed reaches a branch start
point, the Design Assistant will give the option to move the coupler onto the
backfeed branch.

Branch numbers of backfeeds will be shown in curly braces { }.

[.][.][2] FwdFd (Forwardfeed): To invoke this function you must actually type [.][.][2].
It operates the same as the Backfeed [.][2] function above except it creates
forwardfeeds instead. Branch numbers of forwardfeeds will be shown in angled
brackets < >.

[3] Carry: This function "picks up" an active device at the current node. Once a device
has been picked up, it will move along with the cursor until it is put down by
pressing [3]. You can move the amplifier/LE by using the arrow keys or the mouse
wheel. Carry will be toggled off if you try to move an amp onto a node that is
already occupied by another amp. Each time the cursor (and the active) is moved,
the function "forward to line extenders" will be invoked, re-selecting subsequent

Figure 7-5
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tap values. Note that any method of moving the cursor (jump, page up, page down,
etc.) will also move the active device. “Carry Amp” is displayed to the right of the
OP optimization tool indicating Carry Amp is active.

[.][3] UnBkFd (Unbackfeed): If the cursor is placed at the start point of the backfeed
(pole# 1039 in Figure 7-5), this function will reduce the length of the backfeed by
one, returning the house count at the far end of the backfeed to the main run.

[.][.][3] UnFFd (Unforwardfeed): To invoke this function you must type [.][.][3]. It
operates the same as the Unbackfeed function ([.][3] above) except it
unforwardfeeds.

[4] Fwd2A (Forward to Amplifier)A: Execute forward, placing taps and in-line
equalizers and recalculating signals, stopping at amplifiers, line extenders, or ends
of line, whichever come first.

[.][4] XFd2A (Extended Forward to Amplifier): This will execute Fwd2A, but it will do
so with the use of AutoCpl (see function [7] AutoCpl below) to attempt to pick
couplers that will work with existing amplifier/line extender placements. If this
cannot be accomplished, it will try to minimize the number of different locations
where there is insufficient signal to place a tap, preferring to have one large area of
insufficient signal to several small ones. Note that this will not affect couplers
upstream of the cursor or downstream of any downstream amplifiers or line
extenders.

[.][.][4] BrLabel (Branch Label): This function allows you to give your branches a name
up to 14 characters. Once a branch is named, the name will display, in brackets “[
]” directly to the right of the network name at the top of the screen. For example,
if you named branch 3 (of 7) “Broadway”, then the top of the screen would show
[Broadway] Starting 1.4. Any branches fed from “Broadway” and not specifically
given a name of their own will display the name “Broadway” in parenthesis “( )”.

[5] Test: This function recalculates the signal level throughout the network and displays
any errors or warnings found. It also allows the cursor to be moved to another node.
The Test function will check for insufficient signal input to an active, incorrect
cascade, excessive crossover, tap output below spec, etc. Please see the section
Test Errors at the end of this chapter for a more detailed definition of the actual
errors.

[.][5] MoveCpl (Carry Coupler): Allows easy movement of coupler(s) and attached
branch(es). Invoking this command will "pick up" one or both couplers at a node -
- if there is only one split at a single node, this function will always pick up the
branch and its coupler. If two branches begin at a node, invoking it from the
footage, LE, or tap columns will pick up both couplers. Invoking it from either
coupler column will only pick up the branch that starts in that column.
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You can move the coupler by using the arrow keys or the mouse wheel. Note that
if two branches are fed by a three-way coupler and only one of them is carried and
then placed at a different node, the three-way coupler will be deleted. Once this
command has been invoked, a "Carry Coupler" will appear to the right of the

optimization tool, indicating that Carry Coupler is active. When the
cursor is moved to another location and [.][5] is pressed a second time the coupler
will be moved to that location. Note that this may be used to move a branch
between the first and second positions on a single node. Note also that this function
differs from the Carry function previously defined because it is not “dragged” along
as the cursor is moved.

[.][.][5] Dsmry (Downstream Summary): This will calculate and display the total
distance, strand and trench, house counts, power supplies, PCD’s, and number of
actives from the cursor location down. This includes any actives at the cursor
location and any networks fed from the one in memory. Note: if any networks are
fed from the network currently loaded, an Autoappend must be performed on at
least the downstream area for an accurate count.

[6] WillWrk (WillWork): This is probably the most powerful command available.
WillWork selects all taps and equalizers and calculates signals from the cursor to
the ends of line based on the signal levels shown at the cursor.

[.][6] XWillWk (Extended WillWork): Same as Extended Forward to Line Extenders
above, but will stop only at the ends of line and not at downstream line extenders.
Note that this function may change coupler values if they were not picked with the
AutoCpl or other “extended” functions.

[.][.][6] ClrLEs (Clear LE’s): Will give the option to remove all amplifiers, taps,
couplers, fixed nodes, or all from the cursor location downstream. Note that all
options except “All” will keep the equipment at any node that is fixed.

[7] AutoCpl (AutoCoupler): Selects coupler(s) at the current node. If the cursor is in any
column except one of the coupler columns, the coupler that it selects will leave as
much signal as possible coming down the screen and send the least amount of signal
to the branch beginning at this node. If it cannot supply enough signal to feed the
off-screen branches, it will display an error message that states “Cannot select
coupler at node x.x”. If the cursor is in one of the coupler columns, the coupler
selected will attempt to give the maximum amount of signal possible to the off-
screen branches and the least amount of signal coming down the screen. If it cannot
select a coupler that makes the branch coming down the screen work, it will display
a message that states “Cannot select coupler at node x.x”.

[.][7] SetMDU: Opens a window for the entry of MDU (Multiple Dwelling Unit)
information. This window consists of four lines with spaces to specify the footage,
coupler, cable, level, and quantity. You may enter this information for up to four
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separate taps at each location (please see Chapter 5: Utilities, section MDU
Definition Window for more information.

[.][.][7] CAwBF (CarryLE with backfeed and forwardfeed): This function allows the
movement of and/or automated creation of backfeeds and forwardfeeds while
carrying an active. When this function is activated, a highlighted "A" will appear
in the lower right corner of the menu.

[8] Recalc (recalculate): Recalculate signals throughout the network, leaving all
equipment unchanged.

[.][8] RotTap (Rotate tap): The purpose of this function is to quickly move a tap from the
input to the output(s) of a coupler. This is a relatively simple concept, but is a very
powerful optimization tool. First, it will create a node with zero footage
downstream of the split and move the tap(s) and house count onto it. When invoked
for a second time, it will move the node and tap(s) onto the branch beginning at this
node. When invoked again, it will move the node and tap(s) back to its original
position. If two branches begin at this node, it will first move the taps downstream,
and then to the branch on the left, then to the branch on the right, then back to its
original position. Note that each time it is used, the cursor should be on the node
where the branches begin and you should execute a WillWork to ensure all levels
have been recalculated.

[.][.][8] XCAmp (Extended Carry Amp): This command is active until it is put down
with [3], [.][.][7], or [.][.][8]. Using this function will call up a menu with the
following Carry commands:

[0] Carry only: Will "pick up" and move the active along with cursor. Each time
the cursor is moved, F2LE (Forward to Line Extenders) will be activated.

[1] w/ bf & ff: This will carry the LE and allow the movement of and/or automated
creation of backfeeds and forwardfeeds.

[2] bf, ff, AutoCpl: This will carry LE, move or create any backfeeds or
forwardfeeds and use Autocoupler to select couplers to feed the backfeed
or forwardfeed.

[3] bf, ff, Xftole: This will carry the LE, move or create any backfeeds or
forwardfeeds and perform the Extended forward to LE function.

[4] bf, ff, Xftole, cpl here fixed: Will carry LE; move or create backfeeds and
forwardfeeds; perform the Extended forward to LE function while leaving
the coupler at the current node fixed.

[9] Toggle: The options displayed on the Toggle pop-up menu are:



59

Design Assistant Design Menu >>> Chapter 7

[0] Signal display: Toggles the display between RF signal levels and performance
levels. If more than four distortion types are defined in the Performance
file, this option will toggle the display through them in groups of four before
returning to the RF signal display. The column headings will also be
changed with the signal display.

[1] Automatic EQ: Switches equalizer placement modes between three modes:
EQ+, Automatic: Equalizers will be placed automatically wherever the
crossover exceeds the maximum crossover spec and removed wherever it
doesn't.

EQe, Automatic placement except for the last node in a branch or a node
immediately preceding a line extender: As above, but equalizers will not be
placed or removed on the last node in a branch or immediately preceding a
line extender.

EQ-, Manual: Equalizers will neither be placed nor removed automatically.

You may set the default to any of the three on the first page of the Parameters spec file.

[2] Optimization: Toggles between three tap optimization options: 1. Off (OP-):
The Design Assistant will select taps according to the default selection chart
on the tap selection tab in the Parameters. 2. On (OP+): The Design
Assistant will select taps and combinations of taps with the lowest insertion
loss to maximize the signal sent down stream. This is useful in areas with
large house counts or areas that are proving difficult to design, however, if
used always it may select odd combinations of taps that are not necessary.
3. On Failure (Opf): The Design Assistant will select taps normally until
there is not enough signal to feed downstream at which point it will
automatically attempt tap optimization. The default tap optimization setting
can be specified in the Parameters file on the tap selection tab.

[3] Locked: Toggles the fixed flag at the cursor position. If a node is fixed,
indicated by an arrow displayed to the left of the footage column, the
equipment at the node will not be modified by the semi-automatic design
commands (ex. WillWork) in the Design mode. You can also double click
in this column to toggle the lock On or Off.

Note: Anytime a node containing an active has been "Fixed" (locked), that
amplifier will continue to reference the same Pads\EQs Bank even if the
bank is changed in the Active Specifications. Once the node is "Unfixed"
(unlocked) the active will reference the bank indicated in the specifications
the next time the signal is recalculated or the network is opened.

Default: Off



Chapter 7 <<< Design Menu Lode Data Corporation

60

[4] Branch order: If two branches begin at the node the cursor is on, toggling the
branch order will swap their positions, with appropriate changes in signal
levels downstream (if any) due to repositioning the couplers (if two couplers
are used instead of a three-way).

[5], [6] Swap branch: This function will swap the information that is displayed
off-screen due to a branch start point with the information that is coming
down the screen. Use [5] to swap information when one branch begins at
the cursor location or to swap the information with the branch on the left
when two branches begin at the cursor location. Use [6] to swap the current
branch information with the branch on the right when two branches begin
at the cursor location. Note that if there are two branches beginning at the
node, and two separate couplers are being used (not just a three-way
splitter), swapping with the first branch will change the signal levels in the
first off-screen and the down screen-branch.

[7] Slush Propagation: Toggles whether to propagate “slush signal” throughout
the system. Slush signal is defined as deviations in the output level of
actives without AGC caused by the fact that pad and equalizer values are
available only in discrete steps rather than being continuously variable. For
example, assume the minimum input to an amplifier is 15dB and the actual
input level is 19.7dB. In this case, the Design Assistant will pick a 4 pad
(because it won’t overpad) and in a non-AGC amplifier, the actual output
of that amp would be 0.7dB higher than it should. When Slush propagation
is on, it will carry that 0.7dB on down the line for use in pad, equalizer, and
tap selection. When invoked, options are displayed to turn it off, propagate
slush signal in the forward path only, return path only, or forward and
return. When on, the Design Assistant will display an “Slush F” for forward
only, “Slush R” for return only, or “Slush F/R” to the right of the
optimization tool button.
Default: Off

[8] AutoCost: Gives a running total of the materials and labor cost of the network
currently loaded. It is displayed at the top of the screen in the title bar. Cost
calculation is done according to the figures entered into the Pricing
specification file. If this spec file is not filled in or not loaded, Autocost may
still be switched on, but will show a zero value. Autocost need not run at
all times to track costs; cost calculation is performed whenever the function
is toggled on.
Default: Off

[9] Fudge Level: Sets up a tap margin of a specified amount, allowing the semi-
automatic design functions such as WW (WillWork) and Fwd (Forward) to
select taps in the yellow and red ranges, instead of only in the green.
Conversely, it can also be used to guarantee a certain amount of signal
above the minimum output shown in the "lv" column. The Fudge level's
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default is zero, in which state taps selected by the computer will be picked
as closely as possible to the tap output level entered at the node in question.
The fudge level may be set to any value, positive, negative, or zero. If a
positive level is selected, the Design will always attempt to fudge any taps
it selects by that many dB, possibly resulting in yellow or red taps. A
negative value will result in taps being selected that are at least the Fudge
factor above the minimum tap output requirements. In neither case, will
this affect manual selection of taps or colors in which taps are displayed.
Fudged taps lower than tap minimum output will be displayed in yellow or
red regardless of the setting of the fudge level. Anytime a red or yellow tap
is selected it must be fixed to keep it when the fudge level is set back to
zero. The fudge level will automatically be reset to zero upon exiting the
Design.

[/] DEV: Toggles between the three Full Spectrum Plugin Deviation options. A drop
down selection in Design mode is available for full spectrum plugins. The default “Total
Dev.” finds the plugin to provide the least cumulative slope deviation on all forward and
return frequencies.

“Fwd Dev.” Finds the plugin to provide the least slope deviation for forward
frequencies only.

“Rtn Dev.” Finds the plugin to provide the least slope deviation for return
frequencies only.

[.][9] Copy: Copies the network currently loaded in memory. Use the Paste command
(Edit pull-down), to paste the copied items.

[.][.][9] LckDStr (Lock Downstream): This command gives two options: Set Fix and
Clear Fix.

Set fix: Will fix all nodes downstream of the cursor.

Clear fix: This function changes all nodes from the cursor position down to not
fixed.

[.][/] Distance (Calculate distance): Asks for a node in the current network and then
calculates the total distance between the specified node and the node at the cursor
position. These nodes need not be in the same branch nor need one be fed from the
other.

[.][+] Name (Open Amplifier Definition Window). Within this function you may
specify a name for the amplifier at the cursor location and assign the feeder legs
that begin from that amp/LE as well as move to, rename, or delete these feeder legs.
This command will have no effect if no amplifier is present at this location. See
Chapter 5: Utilities, section Amplifier Definition Window for more information.
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[.][.][+] Notes: The “Sticky Note” function allows entry of a text note at any node in the
network. This note may be used to enter any information desired. If your project
calls for the same basic information at many locations, you may press the Attach
Form to attach a previously designed form. You may create this form in any text
editor and save it as <filename>.F00. Other options include Clear, Restore, Apply
Changes, Detach Form, and Print Notes. Once the changes to the note have been
kept (saved), the Design Assistant will display a yellow musical note “ ” on the
line between the “cab” and “lv” columns.

Pad/EQ Selection

The Design Assistant automatically selects plug in pads and equalizers for actives and taps
(plug in pads and equalizers are only selected for taps that are specifically designated to
use plug in devices. See Chapter 10: Building Specification Files section Create Taps
File: Pads\EQs.) Plug in pads and equalizers can be manually changed to reflect asbuilt
changes by placing the cursor on the device (amp or tap) that you wish to modify, and
either clicking on the Edit Plugins toolbar button or selecting Plugins from the Tools pull-
down menu to open the Pad/EQ editor.

Amp Pad and EQ selection
The Pad/EQ editor for amplifiers provide drop down boxes with lists of the
available values for Forward and Return pads and equalizers. The bottom half of
the editor consists of two boxes that display signal levels. The levels in the “Amp
Forward Inputs” box represent the signal level at the amp module (after the pad
and equalizer). The levels in the “Amp Return Outputs” box are the actual return
output levels directly after the return pad and equalizer. The levels in both boxes
update to reflect any manually selected pads and equalizers.

Tap Pad and EQ selection
The Pad/EQ editor for taps provides drop down boxes with lists of the available
values for Forward and Return pads and equalizers

If the OK button is clicked to close the Pad/EQ editor, the user will be prompted to lock
the pad and EQ values. If “Yes” is selected, then those values will not be automatically
changed by any recalculation within the program. An arrow will appear between the
second return frequency and amplifier columns. This is an indicator that the values are
locked or fixed. The user can unlock the values by either double clicking on the arrow or
accessing the “fixed” option from the Toggle menu.

Note: Anytime a node containing an active has been "Locked" (Fixed), that amplifier will
continue to reference the same Pads\EQs Bank even if the bank is changed in the Active
Specifications. Once the node is "Unfixed" (unlocked) the active will reference the bank
indicated in the specifications the next time the signal is recalculated or the network is
opened.
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Popup Menu
Right Click anywhere on the Design Screen and a
Popup menu will appear. This mouse controlled menu
enables you to Toggle the Expanded Display(same as
using the [/] key), Recalc Signal Levels ( [8] key), Edit
Notes ( [.][.][+]), Change the Display Colors, and
move the cursor to a specific column.

The Display color options allows you to modify the color
of the font (foreground) and/or the screen (background) in the program.

Move to Column allows you to move the cursor to a specific column. This is
primarily used in recording macros.

Note: the popup menu is available in the 2 Entry modes as well as powering
but only contains the option to change the Display Color.

Test Errors

Following is a list of all the errors that the Test function 5 tests for. All errors are displayed
in red if fatal or bad, and yellow if marginal. When fatal errors are encountered, the Test
function will be aborted.

Fatal Errors include:

Branch does not begin anywhere.
The branch listed has no starting node defined. If this error is encountered when
attempting to enter the Design menu, then the program will immediately display
the Entry menu. Once at the Entry menu, you will be able to reconnect the branches
to a valid starting point within the network. This error is most typically caused
when the [Delete] key is pressed while the cursor is placed on a node where a branch
or branches begin. Pressing the [Delete] key in this situation does not delete the
information on that branch it only deletes the start point of it. All branches that do
not begin anywhere will display the message “NO STARTING NODE” on the top
of the screen. Possible fixes are to either delete the branch(es) using the Delete
Branch command (if you don’t need the information) or using the Change Start
command to move the start point to a valid location. Both of these commands are
accessible from the Entry menu.

Branch not fed from branch 1.
The branch listed, if followed upstream as far as possible, ends before returning to
branch 1. Go to the very beginning of the disconnected branch(es) and, from the
Entry, use [-][5] Change Start, to connect it to a proper location. This is a very
uncommon message and can sometimes indicate corruption within the network.

Figure 7-6
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Branch contains a loop.
The branch listed contains a loop. A loop is a branch, which is connected in more
than one location to its parent branch. This is a very uncommon message and
generally indicates corruption within the network.

Branch is not fed by any coupler.
No coupler has been placed to feed this branch. Simply place a coupler at the
designated location.

Nonfatal errors are generated when the test is allowed to finish to completion and the test
is not aborted. These errors are:

Branch does not contain any nodes.
An empty branch contains no nodes at all. Place at least a single zero node in the
branch or eliminate the branch completely. Hitting the [Delete] key on the only
node in a branch while in the Entry menu generally causes this.

Unused LE placed.
A line extender that is not listed as being used according to the LE cascade
specification in the Parameters file has been placed. For example, a 31 LE has been
placed despite the fact that the maximum line extender cascade for the design has
been listed as 2. For more information about the maximum line extender cascade,
please see Chapter 10: Building Specification Files, the Parameters section. This
could also be caused by the custom cascade settings in the Actives file.

Undefined Cable type.
A Cable type is being used at the specified location, which is not defined in the
Cable specification file.

Duplicate Amp ID.
Multiple amplifiers within the network have the same name or label. All amplifiers
must have unique names, therefore simply rename the appropriate amplifiers using
the Amplifier Definition Window.

LE X/N before/M after (LE Cascade violation).
An amplifier has been placed out of its cascade specifications. In the error message
the “X” represents the LE or AMP in question, the “N” represents how many LEs
or AMPs are before the one in question, and the “M” represents how many Les or
AMPs are placed after the one in question. For example, the message “LE 21/1
before/1 after” means that there is a 21 placed with 1 LE before and 1 LE after for
a total of three in cascade (counting the line extender itself).

Fslope too low to equalize.
There is no valid forward equalizer for the line extender/amplifier at this node; all
defined equalizers will over equalize this device. Short spacing amplifiers usually
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cause this. One possible solution is to move the amplifier farther away from the
previous amplifier. This message occurs most frequently in networks whose spec
files contain no cable simulators.

Input too low for CS.
The high positive slope at the input to the active requires a Cable Simulator to
correctly adjust the input levels to the amp module, and the Cable Simulator
necessary for the slope correction results in too low of an input level for the
specified device.

Rslope too low to equalize.
There is no valid return equalizer for the line extender/amplifier at this node; all
defined equalizers will over equalize this device.

--- input of xxx to LE.
Insufficient input (at the specified frequency) to a line extender or amplifier.

--- output of xxx from LE.
Return output (at the specified frequency) required from the line extender or
amplifier is greater than the maximum specification.

--- signal below min.
Signal level is below minimum value specified by level specification selected at the
specified frequency for this node. Applies to nodes with levels but no house counts.

Nonexistent tap used.
A tap that has not been defined in the specification files has been placed. This
message generally occurs when switching between different specification files.
Often times this can be fixed by using the WillWork with the current specs.

Invalid terminating tap used.
A self-terminating tap has been placed upstream of other equipment. This situation
will also create other messages at the equipment downstream. Therefore, fixing
this problem can sometimes clear other error messages as well.

Tapout(---) below min.
Tap output below minimum at specified frequency.

Tapout(---) above max.
Return input required at tap port is above the maximum level at specified frequency.

Crossover above max.
Forward low channel level exceeds forward high channel level by greater than the
maximum crossover specification in the Parameters file.
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Return Xover
Return high channel level exceeds return low channel level by greater than the
maximum return crossover specification in the Parameters file.

Not enough taps.
Too few tap spigots to feed either the specified house count or the number of drops
required for an MDU.

Not enough drops.
Specified MDU drops and drop splitters not sufficient to feed the house count at a
node.

Performance errors.
Displays error messages anytime the particular performance level drops below the
specified warning level. These will appear with whatever distortion type
description has been entered into the spec files. For example, if Composite Triple
Beat has been defined in the spec files as “CTB”, the error message will state “CTB
of xx.xx at y.y”. The “xx.xx” is the actual distortion level; “y.y” represents the
“branch.node” with the problem.

Invalid internal coupler.
A coupler designated as internal in the Coupler spec file is being used in an invalid
location. Typically caused by placing an internal coupler at a location that does not
contain an Active, or by placing an external device (such as a tap) in between the
Active and the internal coupler.

MDU window w/o house count
A MDU window exists at a location without a house count.

Tap Levels over window
The output levels from the designated tap are higher than the range established by
adding the Tap Window level to the Minimum tap output level.

Tap Level below window
The return input levels required at the designated tap port fall below the minimum
level established by subtracting the Return Tap Window level from the Maximum
tap input level.

Tap Cascade error.
The tap cascade limit has been exceeded. The tap cascade limit is the maximum
number of taps in any given signal path. This value is set on the General
Parameters tab in the Parameters file.
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Reports

Print Pull-down Menu

The Print pull-down menu (see Figure 8-1) gives you options of viewing and/or printing
various reports about the data stored in the Design Assistant. All of the reports listed in
the Report Generation menu can be viewed or printed. The available reports are broken
down into four main categories: Specs, Networks, BOM, and Miscellaneous.

Specs

To print any of the currently loaded specification files, hold the cursor over Specs and click
on the desired spec file (Parameters, Actives, Taps, Couplers, Cables, Pricing, or
Performance). The chosen spec file will be displayed in quick report format providing the
opportunity to view it scrolling from page to page, if desired. It is also possible to save it
to a file for customization or printing at a later date.

Figure 8-1
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Networks

There are six options displayed under the Networks fly-out option: Network, Network
Distortions, Network and Amp Data, Extended Network, Overhead View, and Network
Diagram. When any of the network printout reports are chosen, the desired report will be
displayed on the screen with a message box reminder stating “press 1 to print” (if desired,
this message can be skipped by clicking in the “don’t show this message again” box). Once
the report is displayed there are two options: 1. View and scroll through the report –
pressing [Escape] will clear the report. 2. Print the report by pressing [1], selecting the
desired printer and pressing OK.

The network option will produce a report that looks very similar to the Design Assistant
network while in the Design menu with three additional columns. The “C” column (located
between “lv” and “LE”) lists the pin-type connectors from the cable to the first piece of
equipment on that line. The “hth” column (located to the right of the branch [b] column)
lists the number of housing-to-housing connectors at the end of that line. A second “C”
column (next to the “hth” column) lists any pin-type connector at the end of that line.

The Network Distortions option prompts you to choose either the First, Second, or Third
set of four distortions as set up in the specifications files. It looks similar to the network
printouts except it displays distortions in place of the frequency columns.

The Network and Amp Data report is the same as the Network report except the screen is
expanded at amplifier locations to display pad/EQ values, etc. The extended network report
expands the screen at every node to display amplifier data and tap output levels.

The Overhead View and Network Diagram reports provide a “stick diagram” of the
network in memory.

The Extended Network displays frequency signal levels in the network printout

BOM

The BOM or Bill of Materials fly-out contains five reports: the Control file BOM, the
Single Network BOM, Map BOM, Powering BOM, and Analysis.

To use the Control file BOM report you must have a valid control file loaded. A control
file is a file containing a group of networks. The Control file BOM report takes this group
of networks and adds the BOM information to produce an overall Bill of Materials.
Creating a Control file is covered in detail later in this chapter in the section: Creating a
Control File.

The Single Network BOM produces a Bill of Materials report for the network currently in
memory. The map BOM report allows for creation of the Bill of Materials by map #, if
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entered in the Entry screen while creating the network. The Powering BOM calculates the
Bill of Materials based upon power supply boundaries. The Analysis report produces a Bill
of Materials based upon the networks in the current Control file, but it redesigns each
network using a forward execution method. The Analysis report could be helpful to see
what the effects of a different cable size or tap output level may have on a large group of
networks.

When any of the BOM reports (other than Map BOM) are selected, a Generate Bill of
Materials window similar to the following will appear on the screen:

Print BOM pages: The Control file has the capability of grouping networks (from different
directories if desired) into five separate groups by specifying a path on each page
and adding the desired networks to the Control file. The Group check boxes allow
you to select/unselect the pages you want to include in the BOM (pages does not
refer to how many pages the BOM printout will be). The default is to print out all
the pages of the Control file that contain networks. This option is only available for
Control file BOMs not Single Network or Map BOMs.

If the BOM report is to be generated by power supply, page 1 contains the BOM
for the trunk station and page 2 contains the BOM for the attached feeder legs (if
any).

Print format: There are five options for the BOM format. Totals only displays the BOM
totals for each page in a single column that contains all equipment used, both aerial
and underground (Format 0). Also, you may select aerial and underground in two
separate columns (Format 1), aerial, underground, and totals in three columns

Figure 8-2
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(Format 2), aerial only in one column (Format 3), and underground only in one
column (Format 4).

Default: Totals only.

Include totals: This option is available for the Control File BOM. Extra columns are added
to the BOM showing either the total of the combined pages, the difference between
pages, or the total and difference.

Default: NO.

Include cost estimate: Tells the Design Assistant whether to calculate a cost estimate for
the Bill of Materials based on the Pricing file. If no prices have been entered into
that file, the default is NO; if prices have been entered, the default is YES.

Include unused PNs: Include lines in the BOM listing all part numbers entered whether
there are any used in the network(s) or not.

Default: NO.

Marked area only: If the BOM is to be calculated for a single network, you have the
option of calculating the BOM for only the areas that have been marked instead of
for the entire network. These need not be contiguous. See Chapter 5 Entry Menu
for information on how to mark specific areas within the network.

Default: NO.

BOM by cable series: In the Single Network BOM you may tally your Bill of Materials
by cable series. Using the mouse, select the first number of the series that you wish
to BOM. For example, picking a 3 and a 5 here will BOM just the cable and
equipment fed with 300 and 500 series cable.

Once you are satisfied with the options chosen, press [PgDn]. Press [Cancel] to return to
the Design screen without displaying the report. You should be viewing the selected BOM,
but this BOM has not yet been sent to the printer. In the report screen, the [Page Up] and
[Page Down], along with the [Left Arrow], [Right Arrow], [Up Arrow], and [Down Arrow]
keys all operate to scan through the text. Listed are the part numbers and totals for all of
the parts used to design the network in memory.

To print the report, press [1] or select Print to display the Windows print dialog box. Select
the desired printer and press OK.

There are two other options for printing many of the reports: print to file and print to Excel
format or “.XLS”. To print to a text file, you must first install the Generic Text Only printer
driver supplied by Windows. Select this option as the desired printer whenever you wish
to print to a text file. If you are not familiar with how to install a new print driver, please
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consult your Windows documentation.

It is also possible to print some Design Assistant reports in a Excel format. To do this,
simply type the name of the Excel file followed by “.XLS”, for instance “test.XLS” next
to Excel file name in the print display box. Printing to a .XLS file allows for customized
spreadsheets containing Bill of Materials or Active Report information. This feature allows
the user to customize not only the look of the report, but also the content. BOM File
Options include Use Network Name for Excel Export and Exclude Zero Counts. By default
the Excel files are saved to the Network folder as setup in the Project Settings or the user
can Browse and select a destination folder. After selecting the path and filename Press
Enter or select [Enter] To export BOM File and the Excel BOM will be created.

Misc

There are nine miscellaneous reports available: Macro Summary, Active report, Control
File Active report, Tap Distribution report, Performance Distribution report, Network
Notes, MDU report, Power Supply report, and Control File PS report.

The Macro Summary report displays a listing of all currently assigned and saved macros.
It lists the hot key used to invoke the macro, the length or number of keystrokes used in
the macro and the macro text description (if any). Press [1], select the desired printer, and
press ok to print this report.

The Active report is a summary of all pertinent information about the actives in the current
network. The Active report will provide the amplifier type, name, inputs, outputs, pads/eqs,
and much more for every active device in the current network. The Active report is only
available in Excel format. Enter the file name and press [Enter]. The file has been created
and saved in the directory specified in your Project settings. .

The Control File Active report is the same as the active report except instead of producing
a report based on the current network; it produces a report for all the networks listed in the
current Control file.

The Tap Distribution report allows you to analyze how many of the currently loaded
network's taps are above or below the minimum tap output specified at each node. This
report shows the number of taps and tap ports above or below the specified level and breaks
them down in .25 dB increments. Press [1], select the desired printer, and press ok to print
this report.

The Performance Distribution report provides a breakdown of the expected performance
for each type of distortion (c/n, ctb, etc) at every tap in the currently loaded network. The
report breaks down the performance levels in one dB increments. The number of taps and
tap ports operating at the various performance levels are tallied in their respective columns.
Also included for each 1 dB increment is a percent total indicating what percentage of the
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taps in the network is operating at that level or above.

The Network Notes report creates a text file containing the location, (Branch/Node) and
content of each note.

The MDU report creates a text file containing the location, (Branch/Node) and content of
each MDU.

Example:
MDU Report for network: lode-1
Printed on Tue Aug 09 14:07:55 2016
Branch: 1 Node: 9
ftg cpl cb lv qty
10 2 0 0 2
0 0 0 0 0
0 0 0 0 0
0 0 0 0 0

tap#(port) MDUline(Array#) CodeNumber(drop#)
1(1) 1(1) 2 11.43 5.19 50.75 50.37 10.81
1(2) 1(2) 2 11.43 5.19 50.75 50.37 10.81

The Power Supply report creates an Excel spreadsheet containing the location and values
of all power supplies in the currently loaded network.

Figure 8-3

The Control File PS report creates an Excel spreadsheet containing the location and
values for all power supplies in the control file currently loaded.

Creating a Control File

A Control file is a file that contains a group of networks, the contents of which are added
together to create cumulative Bills of Materials or active reports. To create a new Control
file, go to the File pull-down, select New, and then select Control. A dialog box will appear
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prompting for a new file name, enter the file name and press OK to display the create
Control file dialog box:

Figure 8-4

This simple dialog box is used to create new Control files or edit existing Control files.
The File pull-down provides the options of opening a Control file, saving a Control file,
and saving a Control file as a different name.

To begin creating a new Control file, press the Browse button and choose the directory
where your networks reside. The networks in that directory will be displayed on the left
side. Select the desired networks (hold the Ctrl button to pick multiple networks) and press

. The highlighted networks will be moved to the right side. To include all the
networks in this directory in the Control file, press .

Notice the tabs along the top of the dialog box labeled page 1, 2, 3, 4, and 5. This allows
the Control file to include networks from separate directories. If you wish to take advantage
of this functionality, click on the “Page 2” tab and follow the directions outlined above.

To remove files from a Control file, select the desired files on the right side of the box and
press or press to remove all the networks.

Once you are satisfied with the chosen networks, save the file and press OK and you are
ready to use your newly created Control file.





Powering

Powering Screen

The Powering display is very similar to the Design screen display except that instead of
signal levels, voltage and current levels are displayed. The display also allows the
placement of power stops and power supplies.

Figure 9-1, is an example of a very small network displayed in Powering. The top portion
of the screen displays the menu -- in this case it's the Powering menu. Just to the right of
the toolbar buttons is the CarryPS indicator. When (On), this indicates that the cursor is
either carrying a power supply or if no actual power supply is present the cursor simulates
a power supply. The next three lines of the menu display the functions accessible from
here and what key to use to invoke them. In the bottom left corner of the screen, the
specification files that are currently loaded, the current branch number, and the
feedermaker indication are displayed.

The remainder of this screen is separated into the following thirteen columns:

Figure 9-1



Chapter 9 <<< Powering Lode Data Corporation

76

N: Displays the node number. It is useful for jumping to specific locations in the
network.

volt: Displays the voltage at this location. The voltage displayed here is the voltage level
after the footage specified on the same line.

current: Displays the current (amperage) requirements at that location.

ftg, hc, cab, lv: These values are the footage, house count, cable type, and required tap
output level. Although these values are usually entered in the Entry mode, you may
edit them or add new ones from within the Design mode and Powering mode.

=: Represents the presence of a power stop. Located on the separator character
between the lv and amp columns. See Placing Power Stops in the next section of
this chapter.

amp: This is the amplifier column for any amplifier defined in the spec files. In-line
equalizers or any of the “Q#s” (see Chapter 10: Building Specification Files,
section Create Actives File: Bridgers\Feedermakers\Inline Eqs ) are also placed in
this column.

amp ID#: Displays the label of any active device at that location if one exists and has been
named.

supply %: Displays the type, label and percentage of operating capacity of a power supply
at that location if one exists.

cplr[b]|cplr[b]: These columns are for couplers and branch numbers. The number within
the brackets is the number of the branch that begins at that node. A number directly
to the left of the “[b]” represents the coupler ID number. A “- [b]” indicates that
there is a branch originating at this location but a coupler type has not yet been
specified.

General Cursor Movement

[.][] Move to node 1 of the current branch

[.][] Move to the end of the current branch

[.][] Move to first branch beginning at this node

[.][] Move to last branch beginning at this node

[.][PgDn] Move to the last branch of the network

[.][PgUp] Move to branch 1

[Home] Move up one screen of nodes

[End] Move down one screen of nodes
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[Ins] Insert empty node at cursor position

[.][Ins] Insert empty node below cursor position

[Del] Delete node at cursor position

[.][Del] Undelete node, placing previously deleted at cursor position

Note: When using a trunk and feeder architecture where the trunk is the parent network
and the feeder legs are children networks, remember not to place power supplies on the
Appended versions of networks as they will be removed by the next Append. If you need to
place supplies on networks that will be Appended (typically the feeder legs), place them
within that network while it is the one currently loaded. Then save it and re-Append it
before continuing. This is not normally a problem with today’s architectures because
“feeder legs” are usually treated as branches rather than children networks, so there is no
reason to append for powering purposes.

Placing Power Supplies

There are three methods of placing a power supply in the Design Assistant. Each method
requires that the Design Assistant is in the power mode and that the cursor is in the “supply”
column. To place the first supply entered in the specification file, simply press the [+] key,
to place a specific power supply press [0] to alter followed by the desired supply’s id
number, or to pick from a list of power supplies press [0] followed by [Home], move your
cursor over the desired supply and press [Enter]. Once a power supply has been placed,
the supply type can be incremented and decremented by press the [+] and [-] keys. To
remove a power supply, put the cursor on top of the power supply and press [0] to alter
followed by and id number of “0” and press enter or you can place your cursor on the power
supply and keep pressing the [-] key until the power supply has been removed.

The Design Assistant has the ability to locate the most efficient location for the power
supply as well as the ability to carry the power supply to many different locations and see
the effects immediately. For more information on these functions, see the section titled
Powering Commands, functions [6] Locate, [.][7] Loc Mnu, and [3] CarryPS.

Placing Power Stops

Power stops are treated as if they are located in the span of cable leading up to the node
they are placed on. Therefore, a power stop located at node 1.10 prevents power from
flowing between 1.10 and 1.9 but not between 1.11 and any branch that begins at 1.10.

Power stops are placed by putting the cursor on the vertical bar “|”, just to the right of the
"lv" column and pressing either [0], [+] or [-]. To remove a power stop, place the cursor on
the power stop symbol and press [0], [+], or [-]. Note that for powering purposes it may
not make a difference which line a particular power stop is placed on. However, if you
plan to do your Bill of Materials per power supply make sure that the stops are placed so
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that cable between devices is counted in the appropriate BOM. Also, if doing Bills of
Materials by power supply, be careful not to isolate pieces of your network by placing a
power stop at both ends of an express run.

If, however, you are using our Drafting Assistant to import the design and you want it to
import the power stops correctly, then it will be necessary to place the power stops in the
Design Assistant where they will be placed on the map.

Note: The Design Assistant will not allow deletion of a power stop if removing the power
stop will create a loop.

Powering Commands:

[+] Increase value: When used in the supply column, it will change an existing power
supply to the next higher power supply ID number specified in the Parameters file.
If there is no power supply present, pressing [+] will place a type 1 power supply.
When invoked over a two-way coupler, it will change it to the next higher value. If
used in the coupler column where a branch has been created but no coupler has
been specified, it will place the first two or three way coupler listed in the spec file.
If used in the active column, it will change the device there to the ID number from
the next line in the Actives file, if no active is present, it will place an 11 LE.

[-] Decrease value: When used in the supply column, it will change an existing power
supply ID number to the next lower power supply ID number specified in the
Parameters file. When invoked over a two-way coupler, it will change it to the next
lower value two-way coupler. If used in the coupler column where a branch has
been created but no coupler has been specified, it will place the first two or three
way coupler listed in the spec file. If used in the active column, it will change the
device there to the ID number from the previous line in the Actives file, if no active
is present, it will place an 11 LE.

[*][*] Macro: Allows you to create and edit macros. Please see Chapter 11: Macros for
more information.

[.][-] When invoked from a feeder leg, this command will load the trunk line to which the
feeder leg is attached and place the cursor at the amplifier from which it originates.

[0] Alter: This function prompts for a piece of equipment (power supplies, amps, LE’s,
taps or couplers) to be placed at cursor location. This function also allows you to
edit footages, house counts, cables, or levels. The desired data can be entered by
typing in the necessary information (power supply ID#, footage etc.) after invoking
the Alter command. Pressing the [Home] key while in the Alter command will
display a list of the equipment defined in the spec files. With the cursor in the
column marked “supply %” this list will show the power supplies defined in the
Parameters file. This display also indicates the percentage of operating capacity
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required of each power supply if placed at that location. Placing the cursor on the
desired power supply in the list, then pressing [Enter] will place the highlighted
power supply at that location.

[.][0] Break (Break node): This will break the node under the cursor into two nodes,
always keeping the footage and cable in the first node and the coupler(s) in the
second node. Taps and actives may be shuffled between the two nodes depending
on the column the cursor is in when this command is invoked. If the cursor is on
the ftg-hc-cab-lv column, the house count and all equipment other than the footage
and cable type will be placed on the second node. If the cursor is in the LE column,
the LE and any couplers will be moved to the second node, but any taps will not
be. In each case, any couplers will be placed on the second node, and if the cursor
is on either of the coupler columns, no other piece of equipment will be placed on
the second node.

[.][.][0] SpecView: This function will display the specified spec file (2-9) on the bottom
part of your screen. You can then use the arrow keys to view the entire file but no
changes can be made.

[1] Jump: This function allows you to quickly "jump" to virtually any place in the network.
Please see Chapter 5: Utilities, section Jump.

[.][1] Join (Join nodes): Combine the node under the cursor with the following node into
one node. Note: this cannot be done if the first node has equipment and the second
node has a non-zero footage, or if the two nodes have different cable types.

[.][.][1] Xspec: When this function is called, it displays up to 10 sets of spec file names
(Parameters, Actives, Taps, Couplers, Cables, Pricing, and Performance) labeled 0
through 9. Pressing the corresponding number will load all the specs listed on that
line. You may edit this file from here by pressing the [ / ] key.

[2] Clear: [1] Values: Set all voltages and currents shown to 0.
[2] Stops: Removes all power stops.
[3] Supplies: Removes all power supplies.
[4] All: Will set all voltages and currents to 0 and remove

power stops and power supplies.

[.][2] ApArea (Append Area): Append only those networks connected to the current
powering area (as defined by power stops). While this is principally for the
appending of networks with active taps (which preclude compression), it may be
used for any network with attached legs, particularly if the network being powered
has too many attached legs to append all at once.

[.][.][2] Append: This function is the same as the AutoAppend function available in the
Entry menu. When invoked, it will append all of the feeder legs that originate from
the network in memory.
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[3] CarryPS: Turns on and off the carry power supply function that allows you to pick up
a power supply and carry it until you put it down by pressing [3] again. This
function also automatically recalculates the power requirements as the cursor is
moved even if it is invoked where no power supply is present. Note that CarryPS
toggles the CarryPS indicator on and off.

[.][3] CarryLE: Picks up active the device at the current node. Once a device has been
picked up, it will move along with the cursor until it is put down by pressing [.][3]
again. Note that any method of moving the cursor (Jump, Page Up, Page Down,
etc.) will also move the active device. When an active is being carried, the CarryLE
indicator is set to ON.

[.][.][3] Unapnd: Automatically strips off any branches previously appended with the
Autoappend or AppendArea functions.

[4] Recalc (Global): Recalculates voltage and power requirements from each existing
power supply in the network. This function has no effect within power boundaries
in which no power supply has been placed.

[.][4] Report: Generates a listing of actives, taps, splits, and power supplies in the current
powering area. Also, lists location, device type, voltage, current draw, downstream
current, voltage range, along with quantity and type of cable leading up to each
device. If running a report on a powering area that is connected to another network
through a PCD, the report must be run from the network containing the power
supply.

[.][.][4] Trans:Displays an indexed list of transformers from the spec file. Select the index
number for the desired transformer or enter [0] to remove.

[5] Test: Lists all powering errors. See the Test Errors section later in this chapter.

[.][5] CarCplr (Move Coupler): Allows easy movement of coupler(s) and attached
branch(es). Invoking this command will pick up one or both couplers at a node. If
there is only one split at a single node, this function will always pick up the branch
and its coupler. If two branches begin at a node, invoking it from the footage, amp,
or supply columns will pick up both couplers. Invoking it from either coupler
column will only pick up the branch that starts in that column. Note that if two
branches are fed by a three-way coupler and only one of them is carried and then
placed at a different node, the three-way coupler will be deleted. Once this has
been invoked, a "Carry Coupler: will appear next to the button, indicating
that carry coupler is active. When the cursor is moved to another location and [.][5]
is pressed a second time the coupler will be moved to that location. Note that this
may be used to move a branch between the first and second positions on a single
node.
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[6] Locate: Will find the location within the current powering area where a power supply
could be placed to give the minimum current requirement, and will calculate
voltages and current as if a power supply were placed at that location.

[.][6] TstArea: Same as Test [5] but only for the powering area that the cursor is in.

[7] BOM (from Powering menu): Calculates and displays the Bill of Materials for the
powering area (as defined by power stops) in which the cursor is located. This
includes all feeder legs presently attached to amplifiers within the powering area.
The Print Bill of Materials window for this command includes a "BOM Entire
System" option, which will calculate a BOM for the entire network in memory and
all attached legs. For the BOM to be calculated correctly for multi-level
attachments (amp windows leading to legs that have amp windows leading to still
more legs, etc.), the legs with those attachments must be Appended at the time the
BOM is calculated. For example, BOMs for attached networks more than one level
deep may not be included if only AppendArea was used; all networks should be
Autoappended to the topmost network. To obtain a printout of the BOM, press [1]
while in the screen display. The results may then be sent to a printer or file.

[.][7] Loc Mnu: Similar to [6] above, but with the following options:

[0] Minimum current: (as above).

[1] Balanced Draw: As close to equal current draw as possible in at least two directions
from the supply.

[2] Maximum Low Voltage: Select the placement that will result in the lowest voltage
being as high as possible.

[3] Minimum Square Voltage Drop: Find the point with the minimum sum of the
squares of the voltage drop at all powered devices.

[8] Calc: Calculate the voltage and power requirements for the current powering area as
if a power supply were placed at the cursor location.

[.][8] NIUtest: Invokes NIU Powering Analysis (see NIU Powering Analysis section later
in this chapter) menu.

[9] Node NIU: Toggles the NIU on or off at the cursor location.

[.][9] BR NIU: Toggles all of the NIU’s in the current branch on or off.

[.][/] Dist (Calculate distance): Asks for a node in the current network and then calculates
the total distance between the specified node and the node at the cursor position.
These nodes need not be in the same branch nor need one be fed from the other.
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[.][+] Open Amplifier Definition Window. Within this function you may specify a name
for the amplifier at the cursor location and assign the feeder legs that begin from
that amp/LE as well as move to, rename, or delete these feeder legs. This command
will have no effect if no amplifier is present at this location. See Chapter 5:
Utilities, section Amplifier Definition Window for more information.

[.][.][+] Note: The “Sticky Note” function allows entry of a text note at any node in the
network. This note may be used to enter any information desired. If your project
calls for the same basic information at many locations, you may press [Escape] and
[9] to attach a previously designed form. You may create this form in any text
editor and save it as <filename>.F00. [Escape] will give the other options of keep
changes, discard changes, restore, and clear. Once the changes to the note have
been kept (saved), the Design Assistant will display a yellow musical note “ ” on
the line between the “cab” and “lv” columns.

Centralized and Distributed Powering

With the ever-diminishing size of serving areas in today’s popular HFC designs, it is often
desirable to power multiple networks or fiber nodes with one centrally located power
supply by connecting them together with powering cable. This is what we refer to as
“centralized powering”. It is also sometimes desirable to insert power in multiple places in
the same network or fiber node by running power cable from the power supply some
distance along an express run to the power inserter, thereby maximizing the operating
voltages. This is what we refer to as “distributed powering”. Beginning in version 3.0, the
Design Assistant simplifies these popular powering scenarios by giving you the ability to
distribute power to separate parts of single networks and by giving you the ability to
connect multiple networks together.

Either scenario described above requires the use of what we call a Power Connecting
Device or PCD to create the desired connections whether within a single network or
spanning across multiple networks. To place a PCD, put your cursor in the coupler column,
press [0] to alter and enter [1000] as the id number. This will display a dialog box providing
the option to either create a new connection or to connect to an existing open PCD (anytime
the new connection option is chosen, it creates an “open” PCD). Make your desired
selection and press ok. Note: PCDs may be placed while in the Design, Power, or Active
Entry modes and also note that the program will not allow the creation of loops when
placing PCDs.

To create a connection within the same network for distributed powering, place power
stops so that your PCD will not create a loop, place power inserter(s) with the distance back
to the power supply on the branch the power inserter creates, and place the PCD at the end
of that distance. To create a connection between two (or more) networks, open another
instance of the Design Assistant being sure that the networks you wish to connect are open
in each instance of the Design Assistant (for example Node1 is open in one Design
Assistant window and Node2 is open in the other Design Assistant window). Once the
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desired networks are open, place a power inserter in one or more of the networks with the
distance needed to connect the networks on the branch the power inserter creates and insert
the PCD.

Once the connections have been created it is possible to jump between the connection
points by simply double clicking on the network name displayed in the coupler column. If
a network is opened that has another network connected to it for powering purposes, the
Design Assistant will automatically start a new instance and try to open the connected
network whenever it tries to calculate powering information.

Be sure, that if you are creating connections within multiple networks, that each network
file is saved individually to ensure that all the connection information is retained correctly.
Also, be sure to save all connected networks if a connection location has been changed in
any of the networks. It is important to keep in mind that the Design Assistant stores PCD
connection information by using the branch and node numbers. Therefore, if you make any
change to the branch and node structure upstream of a PCD, you are actually modifying
the connection location and consequently need to save both networks. Commands that may
change the branch and node structure include delete, insert, join, break, etc.

Network Interface Unit Powering Analysis

This menu, accessed by pressing [.8] NIUtest, allows you to perform various tests on a
network using system-powered telephony Network Interface Units. PLEASE NOTE: Due
to the complexity of the analysis and the number of repetitions in the various NIUtest
options, any given test may take a minute or so to complete. You may break out of any of
these tests at any time by pressing the [Escape] key. The trial currently running will
complete before the [Escape] takes effect. Trial conditions will be based on NIU power
requirements placed in the Couplers file, and penetration and status information placed in
the Parameters file (See Chapter 10: Building Specification Files). Note also: if
performing an NIU test on multiple networks connected through PCDs, the test should be
run from the network containing the power supply.

[1] Statistical: This is probably the best test to run on any given powering area to determine
the chance of failure during normal operating parameters. Due to the variable nature
of NIUs, the variation in take rates, and differing usage patterns, it is not possible
to accurately determine probable power consumption in just one test. Therefore, the
statistical analysis runs 1000 trials within the current powering area to help
determine different possible powering scenarios.

It is helpful to think of the statistical test as a sort of “Monte Carlo” test. Each trial
consists of “rolling the dice” and randomly placing NIUs based upon the
penetration percentage defined in the Parameters file. Once NIU locations have
been randomly determined, the Design Assistant revisits each location and once
again “rolls the dice” at each NIU location to determine the statistical probability
that this particular phone is off hook, ringing, or otherwise in use.
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Once the 1000 trials have been completed, a window similar to Figure 9-2 will be
displayed:

Figure 9-2

Pressing any key will remove this display box from your screen.

A quick analysis of this display reveals the following:

 1000 trials were run on power supply “ps2”
 The highest current in any of the 1000 trials was 6.008 during which 20

NIUs were placed, 7 of them were off hook, 2 were ringing, and there were
0 blocked calls

 The lowest current in any of the 1000 trial was 4.774 during which only 4
NIUs were placed, 0 was off hook, 0 were ringing, and there were 0 blocked
calls

 The median power consumption was 5.287 (14 NIUs placed, 0 off hook, 0
ringing, and 0 blocked calls)

 The mean power consumption was 5.296 (12 NIUs placed, 2 off hook, 0
ringing, and 0 blocked calls)

 99% of the trials had a total current consumption of 5.769 (with 19 NIUs, 4
off hook, 1 ringing, 0 blocked) or less.

 95% of the trials had a total current consumption of 5.638 (19 NIUs, 1 off
hook, 1 ringing, 0 blocked) or less

 Further breakdown for 75%, 50%, 25%, 5%, and 1% of the trials
 There were no under voltage trials
 There were no over current trials
 There were no trials with blocked calls
 There were 2144 call requests

All in all, this is a pretty stable powering area. This analysis can be interpreted in a
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number of ways. For instance, some may decide that if there is no more than a 75%
chance for failure then it is OK while others may decide that if there is even a 1%
chance for failure then the area must be reevaluated. Whatever your parameters
may allow, this analysis should provide enough information to make an informed
decision.

[2] Worst-case: Provides the ability to perform a peak-usage risk assessment by allowing
the modeling of periodic "peak phone usage" powering scenarios to ensure that
your broadband telephone design falls within your power supply's capabilities at all
times.

The worst-case analysis allows you to specify a different penetration percentage
than is set in the spec files as well as specify how many lines should be forced off-
hook in the current powering area. It then selects NIU lines in such a way that the
overall current draw is maximized. Pulling one line off-hook per NIU beginning at
the NIU with the lowest operating voltage, and then proceeding in order of
increasing operating voltage do this. If the number of off-hook lines you've
specified exceeds the number of NIUs in the current area, additional lines will be
pulled off-hook starting, once again, from the NIUs with the lowest operating
voltages until the desired number of lines are off-hook. An estimated average value
of additional current draw due to ringing will also be added into the calculations, to
produce the worst-case current draw. The display window for Worst-Case Analysis
shows the following details:

Figure 9-3

The first line displays the type of power supply and the location of that power
supply. The next two lines display the total house count (including MDU units) and
total lines possible within the active powering area. The total lines possible is
derived from the total house count above, the number of phone ports specified in
the NIU specifications on the Base NIU tab in the Couplers file, and any specific
NIU arrays that may have been placed in MDU windows during design of this
powering area.

Penetration: Displays, in brackets, the current NIU penetration percentage. It
automatically defaults to the value set in the specification files. The number
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to the right in parenthesis is the number of phone lines equal to the specified
penetration percentage. It is possible to modify either the percentage or the
lines to simulate various worst-case tests.

Offhook: Displays, in brackets, the current percentage of active NIUs that will be
pulled off-hook during the test. The number to the right in parenthesis is the
number of phone lines equal to the specified off-hook percentage. It will
default to the value set in the spec files. For instance, if the spec files specify
an off-hook of 15%, then the number displayed here is 15% of the active
phone lines determined by the penetration percentage. The Penetration
percentage includes additional line percentage if any is specified in your
Parameter specs. In the screen shot displayed above, 5 lines are equal to
15% of the 26 phone lines determined by a penetration percentage of 20,
with 10% additional lines.

Note: the off-hook limit specified on page one of the Parameters file
overrides the value that can be set here. In other words, if you try to set an
off-hook value in this test that is higher than the off-hook limit specified in
the Parameters, the worst-case test will revert back to the limit set in the
spec files. It is possible to experiment with higher off-hook limits by
temporarily setting the off-hook limit in the Parameters to “0”. It is possible
to modify either the percentage or the lines to simulate various worst-case
tests.

NIUs Active: This sets a limit on the number of NIUs to be activated. The effect of
this is to further concentrate the power-consuming line activation’s. The
smaller the number of NIUs allowed to be active, the more localized the
powering problem becomes. An NIU being active means that at least one of
its lines is off-hook. It is not possible to have a larger number of NIUs active
than you have off-hook lines. It is possible to modify either the percentage
or the lines to simulate various worst-case tests.

Halo/Wedge: Worst-case power consumption occurs due to high, localized
activation of NIUs that are distant from the power supply. Two patterns may
yield this situation. The first is a “Halo” where the NIUs are randomly
distributed around the outer edges of the powering area. The second is a
“Wedge” where the localization occurs primarily on one main branch or
express line of the network. Though different criteria are used to develop
the increasingly stressful scenarios with each of these options, results may
often be very close to the same due to other characteristics of the power
delivery system.

Pressing [Home] will invoke the test that displays a second window showing the
following details:

Trials: Each time another stress scenario is developed, the power calculations are
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run again to determine the new load. “Trials” shows how many iterations of
this were performed.

Off-hook: Displays how many phone lines were actually pulled “off-hook”.

Current Draw: Displays the worst-case current draw. This is the point at which a
more stressful scenario could not be created within the worst-case setup
specifications.

Fails?: Displays a “yes” or “no” to indicate if any failure scenarios were generated.
A “yes” indicates that either an under-voltage or an over-current condition
existed on an NIU or active device. The actual voltage at an NIU or active
device going below the Minimum Voltage specification causes an under-
voltage condition. This condition can sometimes be fixed by moving the
power supply to a more centralized location. An over-current condition
indicates that there was too much current passing through a device. The
power passing capacities of devices are specified on the General Parameters
tab in the Parameters file.

Note: When the Worst Case function is invoked, power calculations will be set to
Worst-case Simulation mode (this is indicated by a red flag at the top-left corner of
the display). They will remain in this mode until the Clear subfunction of NIUtest
is called or the Powering menu is exited.

[3] Failure Point: This test calculates the number of lines off-hook if and when an NIU or
any other devices falls below its minimum voltage in the current powering area.
Only minimum voltage is checked by this test. All other possible failures such as
excess current draw or excess current through a certain device may be checked for
with the test and test area functions in the Powering menu. Note: Meta NIUs are
not used in this test.

[8] MetaNIU On/Off: Toggles the use of MetaNIUs on or off. MetaNIUs are defined on
Meta NIUs tab in the Couplers file and are used to further define how a customer
uses their phone. MetaNIUs can be toggled on or off in specific powering areas for
use in the statistical test to more accurately model the probable powering needs of
your system. To use the MetaNIUs for the statistical analysis, toggle this setting to
on (an M will appear in the upper left area of the menu). When toggled on, the
statistical analysis will use MetaNIUs exclusively (except where NIU arrays have
been explicitly placed through the MDU Window).

Note: if powering area includes connection to another network, be sure MetaNIU is turned
on in both instances of the Design Assistant.

[9] Clear: Resets the powering calculation mode to Normal. When NIU Worst-case
analysis is used, the specified distribution of off-hook lines will continue to be used
for all powering calculations until Clear is used, the Powering menu is exited, or
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either of the NIU analysis routines is used again. Unless the powering calculations
are in Worst-case mode (as indicated by the red flag on the top-left corner of the
screen), Clear will have no effect.

Test Errors

Following is a list of all the errors produced by the Test [5] and Test Area [.][6] functions
of the Powering menu. All errors displayed in red are out of spec; those displayed in yellow
are marginal.

Excess current draw at:
The current draw is too high for the power supply used.

Excess current thru:
The amount of current being drawn through the specified device exceeds the
maximum limit (“Max A”) set on the General Parameters tab in the Parameters spec
files.

Insufficient voltage for:
Voltage at specified device dropped below “Vmin” set in Actives spec file for
amplifiers, the Couplers spec file for NIUs, or Taps spec file for powered taps.

Bucking power at:
There are two power supplies within the same powering area that have not been
separated by a power stop.

Open PCD at:
A Power Connecting Device has been placed at this location, but the connection
to another PCD has not been completed.



Building Specification Files

What Are Specification Files?

Specification files are the data files external to the Design Assistant program that the
program uses to manage the user-defined parameters. They define every piece of
equipment used by the Design Assistant and every operating parameter of the program.

During installation, sample specification files are placed into the SPECS subdirectory to
be used while learning the program. These specifications are intended to be samples only
and, therefore, should not be used for actual design.

There are seven different types of specification files: Parameters, Actives, Taps, Couplers,
Cables, Pricing, and Performance. The file extensions for the specifications files are as
follows: Parameters - .PAR; Actives - .ATV; Taps - .TAP; Couplers - .CPR; Cables –
.CBL; Pricing – .PRC; and Performance – .PER.

For those who plan to work with many different sets of specs due to multiple projects, it
may be desirable to create separate subdirectories for each project. The most common
method of managing multiple sets of spec files is to create a separate subdirectory for each
project under C:\Lode Data Projects\Project name\Specs.

Getting Around in Spec Files

The File pull-down menu in the spec editors gives the options to create a new spec file,
open an existing spec file, save the current spec file, save the current spec file as a different
name, and print the current spec file. Pressing OK will save the changes to the current spec
file to memory, but will not save the changes to disk. This provides the opportunity to
return to the Design Assistant screen and test the changes that were made. If the program
is exited without saving these changes, the changes will be lost. Cancel will return to the
Design Assistant screen without saving any changes.
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Parameters

Select the Parameters option from the SpecEdit pull-down to display the current Parameters
spec file. The Parameters file contains five separate pages of general information such as
maximum crossover, maximum tap outputs, pedestal sizing, and power supply information.

Create Parameters File: General Parameters Tab

Figure 10-1

Distance Units: This indicates whether the units of distance are in feet, meters, or
decimeters. This only affects the display and does not modify previously entered
specs. For example, entering cable attenuation in feet and then changing this field
to meters will not automatically update the cable attenuation or the distances
already entered into existing networks. The default is feet.

Signal Display: This indicates whether the signal levels are displayed in dBmv or dBµv.
The only effect of this is a change in display format to accommodate more digits
before the decimal point for dBµv, it will not automatically update the values in the
spec files.

Default EQ placement: This specifies when in-line equalizers will be placed in the Design
when performing any automated tap placement routines like forward to le or
WillWork. If it is set to “EQ+”, they will be placed when the maximum crossover
specification has been exceeded. If this is set to “EQ-”, automatic equalizer
placement will be off, this means in-line equalizers will not be selected
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automatically. If it is set to “EQe”, equalizers will be placed when the maximum
crossover specification has been exceeded except at the last node of the branch or
in the node immediately preceding an active. The current EQ setting is displayed
to the right of the toolbar in the Design menu.

Maximum crossover: Maximum crossover refers to the maximum that the forward low
signal may exceed the forward high signal before an in-line equalizer is placed.
This is measured at the tap spigot and will not cause the automatic placement of an
in-line equalizer at a pole without taps. Typical values for the maximum crossover
range are from zero to 3 dB.

Maximum Rtn Crossover: This checks for crossover on the return path. Set this value to
99 if you do not care about crossover on the return path. The forward path crossover
is used to automatically place in-line equalizers; the return path crossover, if used,
will not automatically place in-line equalizers. It will only identify an error when
it occurs by turning the tap yellow. You then have the option to place an in-line
equalizer manually.

Strand/trench types: This allows you to specify which cable categories you wish to
include in linear strand/trench calculations to get an accurate cable bearing strand
distance on your Bill of Materials. To use this feature, simply check the box next
to the cable series that you wish to include in your mileage count. Note that if this
is not set up correctly, the figures in the Downstream Summary for strand, trench,
and total may not be correct. The Downstream Summary is “.4:Dsummary” in the
Design menu. See Chapter 10 Building Specification Files: Cables for more
information on the cable series.

Lines per form: For all Design Assistant print functions, this value specifies the number
of lines that can be physically printed per page. Paper that is 11 inches long can
print 66 lines. Setting this value to 60 will print only 60 lines per page, leaving
three lines at the top of the page for a top margin, and three lines at the bottom of
the page for a bottom margin (three lines are equal to 1/2”). If “Lines per form” is
set to “0”, no form feeds will be sent (recommended for most printers).

Allow Over Equalization: A check mark in this box instructs the Design Assistant to
select equalizers for taps and actives that have the “best fit”, that is it will select the
equalizers that come the closest to the desired slope even if it creates an over-
equalized situation. Normally (no check in this box), the Design Assistant will
never select equalizers that over-equalize.

Replacement Cables
Backfeed: This allows you to specify a different physical cable as a backfeed
replacement cable type. For every span that is backfed, the Design Assistant will
replace the cable on the input to the amplifier with the cable type specified here.
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This feature is not normally used in a new-build situation, but it can be very helpful
in re-build projects requiring the use of existing cables.

Forwardfeed: The same as backfeed replacement cable, but used for forwardfeeds.

NIU Settings
NIU Penetration (%): Represents the expected Network Interface Unit penetration
percentage for power consumption analysis in Telephony designs. This power
consumption analysis is performed by the NIUtest command (.8 in the Powering
menu). The number entered here represents the percentage of house counts to
actually use the default NIU array. The default NIU array is entered and defined
on the first line on the NIU Arrays tab in the Couplers file. Note that this
penetration percentage is used only at house counts without additional MDU
window information. Explicit placement of NIU arrays within an MDU window
will override any power estimates based on this figure. If this penetration
percentage is set to 50%, then half of the house counts listed in the “hc” column in
the Design mode will be assumed to have the default NIU array for powering
calculations. The NIU Penetration % will determine how many default NIU arrays
are calculated into the Bill of Materials.

off-hook %: Represents the amount of time that any given phone line is expected
to be off-hook or active. This number includes only expected off-hook time, not
ring time.

ring %: Represents the percentage of time that any given phone line is expected to
actually be ringing.

addl. line %: Represents the percentage of available additional lines in a given
NIU array that are not initially active but can be expected to be assigned for hook-
up in the future. For example, assume an NIU array has a total of ten possible
phone lines available and originally has four active lines leaving six available
additional lines. The additional line % is the percent of probability that each of the
remaining six lines will be assigned for hook-up. An additional line percentage of
50% in this case would mean that half of the remaining lines (three) are actually
expected to be assigned (for a total of seven) at a later date.

off-hook limit: The maximum number of lines your telephony receiving/switching
equipment can activate at one time in your typical powering area. This setting is
used to check for call-blocking in the NIU Statistical analysis (.8 NIUtest from the
Powering menu). It will supercede any off-hook setting made in the NIU worst-
case test (.8 NIUtest from the Powering menu). Setting the off-hook limit to “0”
will disable the call-blocking test.

Maximum LE cascade: Specifies the maximum number of line extenders that may be
placed in series. Note that this has no bearing on the number of line extenders that
may be used in a network. There are only three valid values for this field: 1, 2, and
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3. Please note that the custom cascading feature found on Page 3 of the Actives file
will override any settings here, but if you choose, you may follow the Design
Assistant’s built-in LE cascade checking outlined below:

To use the Design Assistant’s built-in LE cascade feature, your line extenders
should be defined on the first few lines in the Actives file as Active ID’s 11, 21, 22,
31, 32, and 33. The placement of an 11 LE represents 1 LE in cascade, first LE. 21
represents 2 in cascade first LE. 22 represents 2 in cascade second LE. 31, 32, 33
represent 3 in cascade first, second, and third, respectively.

Therefore, a value of 1 in the Max LE Cascade field will allow only the placement
of an 11 LE without a resultant error message. A value of 2 would allow placement
of an 11 or a 21 and 22 (in cascade) without a resultant error message. A value of
3 would allow the placement of an 11, a 21 and 22 (in cascade), or a 31, 32, and 33
(in cascade). Note: if the cascade is violated, the Design Assistant will not hamper
your ability to place the line extender, it will simply produce an error message
during a network test.

Maximum Tap Cascade: Sets a maximum number of taps that can be placed in cascade.
If this cascade is exceeded, the Design Assistant will produce an error when the
network is tested. Note: the error only lists the first tap that is out of cascade in any
given line. For example, if the max tap cascade was set to 10 and there were 14
taps in cascade, only the 11th tap will have an associated error.

Miscellaneous part numbers:
HTH: Part number for housing-to-housing connectors. They are automatically
added to the Bill of Materials any time two or more pieces of equipment reside on
one line or multiple lines separated by a 0 footage within the Design Assistant. The
only exception is if a coupler has been specified as internal no housing-to-housing
will be BOMed.

Splice: Part number for a splice block. A splice block, as opposed to a straight
splice, requires two cable connectors also to be used. A splice is automatically
selected every time cable types change with no physical device in line.

Terminator: Part number for terminators (housing terminator only). They are
automatically selected any time there is a non self-terminating device on the last
node in a branch and anytime a coupler creates a branch but there is no equipment
on that branch.
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Create Parameters File: System Levels

Figure 10-2

The System Levels tab of the Parameters file covers system-wide output/input levels.
Typically, these are used primarily for tap output levels, but they may be used anytime a
minimum signal level is desired (for instance, at an MDU location or at a future split point).
The minimum system levels are numbered 0 through 15. These numbers are used in the
“lv” field of the ftg-hc-cab-lv columns of the Design screen. A “0” is the default entry for
the “lv” field, so the most commonly used set of levels should be placed there and it is
generally reserved for the default tap output spec.

These 16 levels may represent typical long drop levels, short drop levels, levels at the
converter (for use with the MDU window functions), levels needed for future splits, or any
other desired levels. Any network that uses this Parameters file will use these 16 sets of
levels.

You may also set up network specific levels. These levels would be numbered 16 through
31, and can only be viewed or modified while in the Entry menu, of the network containing
these specific levels. For more information see Chapter 5: Utilities, section Levels.

The Min Signals columns specify the minimum forward output levels. The columns are
labeled (by default) high, low, F3, F4, F5, and F6. The column headings can be customized
in the Frequencies page of the Parameters. The Max Signals represent the maximum return
input levels. These column headings are labeled (by default) Rh, Rl, R3, and R4 and also
may be customized on the Frequencies page.
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Note: Both forward and return levels are used to select taps. Therefore, setting the
Maximum Return levels on this page too low will force the automatic and semiautomatic
tap selection routines to select lower tap values, to stay below the maximum return level.
This may result in forward levels much higher than desired at some tap spigots. If the taps
you're using have no specific Maximum Level spec, and you are not limited by low-return-
output converters being used in your system, you should probably set the Maximum Return
levels to 99. Even if the design you are doing is completely unconcerned with return levels,
do not simply set the “rh” and “rl” figures to “0”! If you do, no taps will be selected,
since you are telling the program that “0 dB” is the highest level allowed back through the
tap.

Note: It is possible to specify which two forward and which two return frequencies are
used for tap selection on the tap selection page.

Tap margin: The number of dB that the output of a tap may drop below the minimum tap
output. Or the amount that the return input to a tap can rise above the maximum
before it is flagged as red in the Design screen. Taps that are out of spec by less
than the tap margin will be displayed in yellow. The Design Assistant will not auto-
select any taps that fall in the marginal area; they must be forced in at the designer’s
discretion. Typical values range from .5 to 1 dB, though it may be set to any desired
value, according to your design tolerance.

Tap window: Permits setting a maximum forward and minimum return level at all tap
spigots. Enter figures for the forward tap window here if a design calls for its tap
ports to carry no more than a certain maximum output. These values represent that
maximum output when added to the Minimum Signals figure for a given node. For
example, if you have a minimum tap output specification of 16 dB (Forward high),
and are not allowed to exceed 26 dB from that tap port, enter a “10.00” for the tap
window. Taps with an output higher than that limit is flagged as an error in the test
function and is displayed in yellow. Should a design call for a certain minimum
return level at the tap spigots, first determine a typical tap's maximum return
through-put (probably from line “0”). Next, enter Tap window Rh and Rl figures
for subtraction from that maximum which will bring you to your desired minimum
return level for TestWindow to check. If you are not concerned about a maximum
tap output, disable TestWindow, by placing “99” in each of these four lines.
Typical values for tap window are range from 99 to disable it all the way down to
4 or 5.
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Create Parameters File: Tap Selection

Figure 10-3

On the left side of the box are three separate edit boxes. The first two are labeled as
“Homes” and “Number of Ports”. These are used to specify how many tap ports are needed
to feed a certain house count. Typically, you need 1 port for 1 house count, 2 ports for a 2
house count, and so on, but this provides the flexibility to tap for more or less than 100%
of the homes.

The third edit box is labeled “Ports” and “Tap type”. This box tells the Design Assistant
what tap type (2 port, 4 port, or 8 port) to select based upon the number of ports required
to feed the house count.

Optimization is used to specify the default tap optimization setting within the Design mode.
OP- turns off tap optimization so all taps are selected using only the criteria set up on this
page and the system levels page. OP+ turns on tap optimization so that the Design Assistant
will select the tap or combination of taps with the lowest insertion loss. For instance, there
may be times when a 2 port tap and a 4 port tap would have a combined insertion loss lower
than that of an 8 port tap. With tap optimization off, the Design Assistant will select the 8
port tap, but in this case, with tap optimization on, the Design Assistant will select the two
taps. The third option, OPf, stands for tap optimization on failure. In the previous example,
with OPf turned on, the Design Assistant will select the 8 port tap if there is still enough
signal available to feed on downstream, but pick the 2 port and 4 port if there is not enough
signal available to feed downstream.
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Tap optimization is usually set either to OP- or OPf because the use of tap optimization
can sometimes call for the use of odd combinations of taps where they may not actually be
needed.

Enforce Tap Window: It forces all tap forward outputs and return inputs to fall within the
range established by the Tap window and System level settings. This option is used
primarily when using taps with plug-in pads and equalizers.

Create Parameters File: Powering

Figure 10-4

Here you may define up to 15 different types of power supplies. On the left portion of the
screen, enter the power supply part number, the voltage and current ratings, and the % of
the maximum current capacity for the power supply. When entering a power supply in the
Powering menu, use the ID# shown on the far left.

Power interpolation: If set to step, power interpolation is turned off and powering
calculations for the active devices will be based solely on the “stair steps” entered
on the Powering Data page of the Actives file. If set to “Linear”, power
interpolation is turned on to perform the calculations for the active devices on a
linear basis. The Design Assistant will interpolate the actual current draws for the
active devices at the true voltage thereby eliminating the jumps that occur in the
stair step method. If set to Constant Wattage, power interpolation is turned on to
perform modeling of constant-wattage devices. Here, the current draw changes
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across each voltage range will vary slightly from linear to maintain constant
wattage.

Overvoltage Check: If set, this checks for equipment that may be specified at a operating
voltage less than that of the power supply voltage. For example, a 60V (maximum)
device within a 90V power supply area.

Max Amperage through…: Indicates the maximum number of amperes that each piece
of equipment can pass for powering. If the Max A number is exceeded, the
offending device will be flagged in red, also, the [5] Test and [.6] TestArea
functions in powering will alert you if there are any problems. “Bridger” allows the
Test functions to check for excess current levels at a parent network's connection
to its offspring networks. Some common values include: 15 for Inserter, 10 for
Amp, 10 for Bridger port, 10 for Coupler, 10 for Line Extender, and 6 for Tap.
These numbers will vary for each manufacturer and each piece of equipment so is
sure to double check. If this value is left at “0”, all equipment will be flagged red
when a power supply is entered.

Transformers: Provides a voltage boost downstream of transformer placement.

Create Parameters File: Underground Housings

Figure 10-5
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This page is used to specify how the Design Assistant selects underground housings for the
Bill of Materials. At each underground location the Design Assistant will add up all the
equipment located there and consult this page to determine the correct size housing.

U/G Housing #1-#5: The Design Assistant supports five different sizes of enclosures.
Enter the part numbers of those housings here. Please note: housing #1 should
represent the smallest available pedestal progressing to #5, which should represent
the largest.

Min size: Min size sets the minimum point total for each particular type of pedestal to be
BOMed. At each underground location, the Design Assistant will select a pedestal
with the minimum size closest to the total points allocated without exceeding it. If
a pedestal is selected based upon the point total for Min size #1, U/G housing #1
will be BOMed; Min size #2 will BOM U/G housing #2, and so forth.

Equipment size – point values: Point values and Min size work together to BOM the
correct size pedestal according to the amount and type of equipment at each
pedestal location. In the point value column, enter a number to represent the size
of each physical device. The lowest point values should correspond to the smallest
physical devices and increase as the equipment gets larger. The Design Assistant
will total the points at each underground node, identified by an odd numbered cable
type, and match them to the minimum size requirements which then refer to the
U/G housing column to BOM the correct size pedestal.

For example:

Assume a Min size #1 of 5, Min size #2 of 10, and Min size #3 of 15.

A point total of 3 would not BOM any pedestal because it is under the minimum
size requirement of 5 points for Min size #1.

A point total of 9 would BOM an U/G housing #1 because 9 falls between Min size
#1 and #2.

A point total of 15 would BOM an U/G housing #3 because 15 is the Min size #3.

For a much more detailed example of point requirements and minimum size settings, please
see Appendix A: Miscellaneous, section Ped Counting.
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Create Parameters File: Frequencies

Figure 10-6

The frequencies page of the Parameters allows for customization of frequency headings
and it is here that extra forward and return frequencies are enabled.

To customize a frequency heading, simply enter the desired frequency – for instance, 750
or 750 MHz. The default headings are high and low for the forward and Rh and Rl for the
return. Note that once a heading has been entered here, the new name will be reflected in
all Design Assistant screens.

Two forward and two return frequencies are required for the Design Assistant to select
forward and return equalizer values correctly (it is not necessary, however, to design two-
way systems). To enable extra forward and return frequencies just check the boxes next to
the desired number of extra frequencies.

Forward High, Forward Low, Return High, and Return Low Select: These options are
used to specify which two forward and two return frequencies will be used to select
pads and equalizers. It is possible to choose from any frequencies that are enabled
on the Frequencies page.
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Actives

Select actives from the SpecEdit pull-down to display the current Actives file. The Actives
file stores all the information about amplifier types, inputs and outputs, pad and equalizer
information, power requirements, etc.

Create Active File: Actives

Figure 10-7

This page defines the signal levels required at the forward and return inputs, as well as the
forward and return outputs produced by each active. Each active can use a pad and
equalizer on both the forward and return path. The numbers under the columns marked
“PAD” (“Fwd”, “Ret”) and “EQ” (“Fwd”, “Ret”) represent which bank of pad and
equalizer values each active will reference (see Pads & EQ’s (Bank 1-Bank 4) later in this
chapter). You can set the frequencies to be a loss rather than an output. If the frequencies
are set to be a loss, they will not be considered for pads and equalizers. This feature was
introduced to handle the retro fit of amplifiers that only amplify certain frequencies and
allow other frequencies to pass through with some loss.

The part numbers for the forward components are named on this page; these part numbers
will show up in the Bill of Materials (BOM). You may have noticed the very first column,
“Active ID”. If you would prefer to use your own active ID’s, you may input your active
ID’s on the Configuration Table page and those changes will be reflected here.

If you are not using the Design Assistant’s default number system, it is sometimes easier
to select an active ID while designing if the unused active ID’s are removed on the
Configuration Table as was done it the spec file shown in the screen shot above. But, if this
has not been done, you are probably looking at the Design Assistant’s default active ID
numbering scheme. It works quite well for many projects and is described below:

11: Line extender, 1 in cascade, first one.
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21: Line extender, 2 in cascade, first one.
22: Line extender, 2 in cascade, second one.
31: Line extender, 3 in cascade, first one.
32: Line extender, 3 in cascade, second one.
33: Line extender, 3 in cascade, third one.
11H-31H: Alternate line extenders. The “H” is commonly used to denote “high gain”.

Note: It is not necessary to use the Line Extender cascading convention described above.

61-89 and 41-49: Trunk amps, system amps, distribution amps, fiber receivers, etc. Note
that all amplifier signal level calculations are performed the same whether they are
set up as line extenders (11-33H) or as trunk amps (61-89 and 41-49). Therefore,
it is not necessary to place line extenders in the line extender section, but it does
have distinct advantages. Line extenders have an automatic cascade checking
function that trunk amps do not; however, it is possible to set up custom cascade
checking for all amps. Also, by setting up actives in the appropriate sections, the
Design Assistant will keep track of the total number of line extenders and trunk
amps for BOM and cascade purposes.

Setting Up Active Inputs

As you will see in your operation of the Design Assistant, we handle specifications for
amplifier inputs on the forward frequencies in two different pieces. For convenience, we
speak of what we call a “housing input” and a “module input” see Figure 10-8. Housing
input refers to the minimum signal level you want to see at the amplifier housing, that is,
at the end of the cable going into the amp. Module input refers to the minimum signal level
desired after the equalizer and pad, at the amplifier module inside the amp housing. Return
amp output specifications are handled similarly.

Let’s have a look at a typical amplifier:
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As may be seen, between the Forward Housing Input and the Forward Module Input, we
have a test point, a diplex filter and then the input pad and EQ. To properly set up the
Design Assistant to choose the correct forward EQ and pad, we need to account for the
additional losses we have from the test point and diplex filter. Diplex filters and test point
can be set up as a plug-in in the Active spec file. Likewise, in the return direction, we see
that we have the return pad and EQ, a test point and the output diplex filter after the return
hybrid.

The forward inputs and return outputs on page 1 of the Actives spec file should be viewed
as “module” level figures.

Actual module input levels are best determined by the amplifier manufacturer, as they will
take into account all of the actual losses associated with the internal components. We can,
however, get pretty close by using some typical values.

For the forward:
Forward Input Test point 1 dB
Diplex Filter Loss 1 dB

Total forward loss 2 dB

For the return:
Return Output Test point 1 dB
Diplex Filter Loss 1 dB
Forward Input Test point 1 dB

Total return loss 3 dB

In addition to the above losses, however, we need to add the minimum high channel loss
incurred by the plug-in EQ, which is typically 1 dB.

For the forward:
Forward Input Test point 1 dB
Diplex Filter Loss 1 dB
EQ minimum high channel loss 1 dB

Total forward loss 3 dB

For the return:
Return Output Test point 1 dB
Diplex Filter Loss 1 dB
Forward Input Test point 1 dB
EQ minimum high channel loss 1 dB

Total return loss 4 dB

Figure 10-8
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Housing levels are determined for the forward-high and return-high channels by these
values to the module level for that device.

For example, assume you have a forward-high-channel module input of 16.50 dB. In this
case, your forward-high-channel housing input minimum is 19.50 dB and the Design
Assistant would show an error on an amplifier where the forward-high-channel level at the
end of the incoming piece of cable is less than 19.50 dB.

Low-channel forward input levels should be set with the output slope you desire in mind.
A standardized amount of mid-stage equalization may be accomplished by varying the
forward-low-channel input figures by the amount of the mid-stage equalization.
Equalization concepts will be dealt with in detail in the Equalization, section later in this
chapter.

Padding is done in the Design Assistant after any high and low channel equalizer losses
are subtracted from the actual incoming signal levels. Actives are never automatically
over-padded.

The columns in between the main frequencies and the extra frequencies labeled “Pad Fwd
Ret” and “EQ Fwd Ret”, are for pointing an active at a specific group of pads and equalizers
to use. Please see Pads & EQ’s (Bank 1-Bank 4) later in this section for more information.

Create Actives File: Reserve Gain

Figure 10-9
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In the first column, a return module part number may be entered to be BOMed with each
Active ID. The next two columns are used to set a reserve gain for the forward and return.

Reserve gain can be thought of as a warning to the designer that he or she is close to
maximizing the spacing between amps. If a 2.00 is entered here for an amp with a 17 dB
input, the Design Assistant will flag the amp yellow with an input of 17 to 19 dB and red
under 17 dB. Note that this level does not actually affect the true gain of the amplifier or
the pad and equalizer values chosen for that amp. It is intended as a warning that an amp
is down to a two or three value pad for those systems that do not always wish to maximize
spacing. The return reserve gain works the same.

Create Actives File: Powering Data

Figure 10-10

This page specifies powering information for each active. The data are entered in voltage-
current pairs in ascending order of voltage for each device. That is, for a given device,
from Vmin to V2, it uses A1 amperes; from V2 to V3, A2 amperes are used. “Vmin”
stands for “Voltage Minimum” and refers to the lowest voltage at which the active will
operate. Because actives run more efficiently (have lower current draws) at higher
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voltages, A1 will be the highest amperage. Not all power steps need be used, but they
should be input in ascending order from the left. Powering calculations will be more
accurate if more steps are used.

For more accurate powering simulations, see the section Create Parameters File:
Powering, the section Power Interpolation previously discussed in this chapter.

Equalization

Before we continue, let’s examine how some of the following equalizer values should be
calculated and entered. It is common practice to specify equalizer values in dB of cable
and specify that a given equalizer be used if the dB of cable from the previous active falls
within a particular range. This comes in quite handy when you are designing a system with
12 channels by hand or possibly with the help of a pocket calculator. Unfortunately, for
those of us who are designing cable systems at 550 or 750 megahertz and using real-world
equipment that contributes tilt as well, it's a little less appropriate. The next two sections
deal with pre-stage and mid-stage equalization. If you are familiar with these two concepts,
you may wish to skip to the section titled Create Actives File: Pads & EQ’s (Bank 1-Bank
4).

Pre-stage Equalization

Here we will talk a little about the way the Design Assistant handles signal equalization.
If you already understand the general concepts of pre-stage equalization, you might want
to skip to the section titled Mid-stage Equalization.

Assume you are using a line extender with a 7 dB output tilt -- its output levels might look
like this:

Figure 10-11
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If this LE performs no internal equalization, we would want the slope at the input of the
amplifier module (not housing) to be the same as the output slope. Here is how our ideal
module input would look:

Figure 10-12

If we had actual signal levels of 20 dB high-channel and 24 dB low-channel at the end of
the cable coming into our line extender, the slope of that signal might be visualized like
this:

Figure 10-13

This example shows a negative slope of 4 dB in actual signal going into our LE. To achieve
our output tilt, we need to correct that to a positive slope of 7 dB. This means we need to
reduce the level of the low channel by a total of 11 dB (knock it down 4 dB to get to a
“flat” slope, then 7 dB more to get to a positive slope of 7 dB). An equalizer that loses 0
dB on the high channel and 11 dB on the low channel would accomplish this.

However, in the real world, equalizers have a small amount of loss at the high channel, too,
usually about the same amount of loss regardless of the value of the equalizer. If the real
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version of our imaginary 0 dB/11 dB equalizer loses 1 dB on the high channel, then it must
lose 12 dB on the low channel, to accomplish the 11 dB of slope-change we need.

Note: the Design Assistant has two methods for equalizer selection; the default mode will
never over-equalize, so if you want your equalizers to be selected with a “best-fit”
scenario, be sure to check the “Allow Over Equalization” button on page 1 of the
Parameters.

Mid-stage Equalization

Let’s suppose that all our line extenders contained a standardized mid-stage equalizer that
accomplished 3 dB of equalization (that is 3 dB of actual slope-change, not 3 dB of cable
correction). If we permitted the same 11 dB of equalization to be picked, when the
incoming signal reached the mid-stage EQ it would be tilted by 11 dB. Then, the mid
stage EQ would add an additional 3 dB of tilt for a total slope change of 14 dB. We
would be over equalized by 3.00 dB, and our resulting output levels after amplification
would have a slope of 11 dB.

To take this mid-stage equalization into account and let the Design Assistant still pick the
proper plug-in equalizer, the amount of mid-stage equalization we expect to take place
inside the line extender must be considered in our module input figures. In other words,
we must “tell” the Design Assistant that 3 dB of equalization has already taken place.

The way you would do this in our example is simply by setting the module input figures to
16 dB/12 dB, instead of 16 dB/9 dB. This tells the Design Assistant that we want a module
input slope of 4 dB instead of 7 dB. When we run through our scenario of 20 dB/24 dB
coming into our LE, the amount of slope-change we need the plug-in equalizer to achieve
falls from 11 dB to 8 dB.

To generalize all this in terms of a formula, the plug-in equalizer that meets the following
mathematical criteria and results in the smallest non-negative value (assuming the Allow
Over Equalization box on page 1 of the Parameters file has not been checked), will be
picked:

(actual low input - actual high input) - (low module input spec - high
module input spec) - (low equalizer loss - high equalizer loss)

From our example with no mid-stage equalization, when the Design Assistant checks for
plug-in equalizers and gets to the 18, 15, 12, and 9-value EQs in our SAMPLECITY
Actives specs, the formula will read:

18-value: (24 - 20) - (9 - 16) - (13.66 - 1.2) = -1.46
15-value: (24 - 20) - (9 - 16) - (11.55 - 1) = 0.45
12-value: (24 - 20) - (9 - 16) - ( 9.44 - 1) = 2.56
9-value: (24 - 20) - (9 - 16) - ( 7.33 - 1) = 4.67



Design Assistant Building Specification Files >>> Chapter 10

109

The smallest non-negative value here is 0.45, so a 15-value equalizer will be picked.
For the example with 3 dB of mid-stage equalization, we get:

18-value: (24 - 20) - (12 - 16) - (13.66 - 1.2) = -4.46
15-value: (24 - 20) - (12 - 16) - (11.55 - 1) = -2.55
12-value: (24 - 20) - (12 - 16) - ( 9.44 - 1) = -0.44
9-value: (24 - 20) - (12 - 16) - ( 7.33 - 1) = 1.67

From this set of results, the Design Assistant will pick a 9-value EQ. Note: in this example,
the 12 value equalizer would be selected if the “Allow Over Equalization” box has been
checked on Page 1 of the Parameters.

Create Actives File: Pads & EQs (Bank 1-Bank 4)

Figure 10-15

These four pages, one page for each bank, specify the part number suffixes and operating
losses of forward pads, return pads, forward equalizers, and return equalizers. They are
divided into four groups, called banks.
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On the first page of the Actives file, we entered input and output signal requirements for
each active device. We also specified from which bank pads and equalizers would be
selected. A “1” in the “Forward Pad” column will allow selection of pads from bank 1,
while “2” will allow selection of pads from bank 2, etc. Banks may be mixed freely for
each device, giving you the greatest amount of flexibility. If interdiction taps are being
used, the program will automatically look to bank 4 to get their equalizer information. If
no interdiction taps will be used, bank 4 can be used for normal active pad and equalizer
information.

It is important to note that the Design Assistant will never automatically over-pad any piece
of equipment when automatically selecting pads. For example, if 1.0 dB of pad is required,
a pad of 1.0 dB is selected. However, if 1.6 dB of pad is required, a 1.0 dB pad will also
be selected, if that is the closest matching pad not exceeding the amount to be padded. In
this instance, a 2.0 dB pad would not be selected. Similarly, the Design Assistant will not
over-equalize in normal operating mode (See Parameters: Allow Over Equalization). That
is, for a given device it will compare the actual slope at the input of an active to the desired
input slope (specified on page 1) of that device and select the largest value equalizer that
will not knock the low channel below the minimum desired input.

Equalizers and pads should be entered in ascending order. For example, a zero pad should
be on the first line, while the highest value pad should be on the last line. Equalizers should
be entered with the highest value cable simulator (if used) entered on the first line working
down to a zero, then working up to the highest value equalizer. If no cable simulators are
being used, start with a 0 value EQ. Losses for equalizers should be the actual loss in dB
at both frequencies.

Pads and equalizers may also be entered with negative loss (gain), but when possible,
equalizers should be entered with their actual losses.

Part number prefixes are appended to the pad and equalizer value to create a whole part
number for Bill of Materials purposes.
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Create Actives File: EQs (Bank 5 – Bank 8)

Figure 10-16

These four pages, one page for each bank, specify the part number prefix and suffix and
the operating losses for full spectrum equalizers (equalizers that correct for the entire
spectrum – forward and return).

To make taps select these full spectrum equalizers, simply put the bank number (5-8) next
to the corresponding tap(s) on the Pad\EQ Banks tab in the taps file. The Equalizers in this
section should be entered in ascending order beginning with the highest value cable
simulator (if used) working down to a zero and back up to the highest value EQ.

The part number prefix is appended to the part number (equalizer value) for Bill of
Materials purposes.
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Create Actives File: Plug-Ins

Figure 10-17

This screen is where part numbers and attenuation values for plug-in modules are entered.
It is also where a device can be identified as an AGC device or a step-down transformer.

There is space for up to 31 different plug-in devices with corresponding identification
numbers of 1 through 31. The attenuation may be entered as positive or negative values.
If entered as a positive value, it will increase the minimum input for the active that it is
plugged into it by the amount specified here. For instance, assume an active input of 16
dB and an AGC plug-in module with an attenuation of 3 dB. Once this AGC module is
“plugged” into (see Configuration Table) that active, the minimum input required will be
19 dB. This effectively reduces the gain of that active by 3 dB. If an active’s inputs and
outputs are set to zero, on page one of the Actives file, it is considered a pass through
device. Therefore, adding a plug-in module with 3 dB of attenuation to a pass through
active will give you a device that loses 3 dB wherever it is placed.

If the attenuation is entered as a negative value, it will decrease the minimum input for the
active that it is plugged into by the amount specified here. For instance, assume an active
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input of 16 dB and a high gain plug-in module with a negative attenuation of 5 dB. Once
this high gain module is “plugged” into (see Configuration Table) that active, the minimum
input will be 11 dB. This effectively increases the gain of that device by 5 dB. It is also
possible to set up a gain block type of device that can be placed anywhere, regardless of
input, to generate the specified amount of gain wherever it is placed. For example, you
could set up a plug-in with a -10 dB attenuation value and plug it into an active that has
been defined as a pass through device. This will give you 10 dB of gain wherever it is
placed but will not pick any pads or equalizers.

By putting a check mark in the AGC column to the right of the attenuation, you can define
a plug-in as being an AGC device. When this AGC device is plugged into an active, the
output of that device will remain constant even if slush propagation is activated. With
slush propagation turned on, the output of non-AGC devices will vary depending on the
input and pad and equalizer selection. For example, assume the minimum input of an active
is set up for 16 dB and the actual signal into that amp is 18.8 dB. In this case, the Design
Assistant will pick a 2 pad, leaving 0.8 dB excess into the gain block inside the amp. A
non-AGC active will then have an actual output that is 0.8 dB higher than is specified in
the spec file. With slush propagation turned on, this 0.8 dB will be carried on through the
system for downstream pad, EQ, and tap selection. If an active is defined as AGC, the
slush propagation will be reset to 0.0 at that amplifier.

A check mark in the column labeled “step down” will identify this particular plug in as a
step down transformer. A step down transformer is a device that will knock the effective
voltage level into a device down to levels that the device can handle. This is used mainly
if you are powering your system at 90 volts, but some equipment is unable to operate above
60 volts. After marking the device as a step down transformer, enter the desired voltage
step down ratio in the first frequency level column (often .66). Then, in the second column
enter the current step up ratio (typically the inverse of the voltage step down ratio). When
a step down device is placed in the Design Assistant, the voltage will be knocked down to
the appropriate levels.
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Create Active File: Plug-In Powering Data

Figure 10-18

On this page, enter the individual current draws of each plug-in module. These current
draws will be added to the current demand of the active devices that these modules are
plugged into. The data should be entered in ascending order in voltage and current pairs.
Vmin is the lowest voltage at which the module can operate, A1 is the current that the
module draws at the minimum voltage. From Vmin to V2, the current from A1 is used.
From V2 to V3, the current from A2 is used, and so forth. Not all the voltage current pairs
need to be entered. Nor do they need to match the steps for the actives’ power draws. Keep
in mind however, that the powering will be more accurate as more power steps are filled
in.
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Create Actives File: Configuration Table

Figure 10-19

This screen is for the custom configuration of amplifiers. The first column (forward part
number), will automatically display the part number entered on the Actives tab and
therefore, is not editable here. These part numbers are the description of the base unit
amplifiers, to which you may add several plug-in modules.

The column labeled “Active ID” will automatically display the default identification
numbers of each base unit amplifier. If desired, the active ID for any of the base unit
actives may be changed or removed. If the active ID is changed, that change will be
reflected on all other pages in the Actives file. This new active ID number may be numeric
or alphabetic. Note that the alphabetic Active ID is case sensitive. Therefore, you must
specify the Active ID exactly as it appears (in upper or lower case) when you enter it into
the Design screen. If you do not, you will receive an error message that states “ID number
not found, Any key to continue”.

There are eight separate “Plugin” and “Quantity” pairs that allow you to plug-in up to eight
different modules into each base unit. The column “Plugin” refers to the part number
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defined on the Plug-Ins page. Using a “1” under “Plugin” will plug-in part #1, while a “2”
will plug-in part #2, and so forth. Entering a “1” for the part will cause the attenuation
figures for part number 1 (on page 10) to take effect, entering a “2” will calculate the figures
for part number 2, and so forth.

A quantity of 1 entered in the “Quantity” column will add the current draw (of the part
entered to its left) to the base unit amplifier’s total current draw. It will also add that plug-
in to the Bill of Materials. A quantity of 2 will add the powering information twice, the
BOM information twice, but only takes out the attenuation once. Therefore, if you wish
for the attenuation figures subtracted (or added) more than once, you will need to enter that
part number with a “1” quantity as often as desired.

Note: There are seven blank lines under each part number. This makes it possible to create
up to eight custom amplifiers using each base unit amplifier and adding to it virtually any
combination of plug-in modules. This makes a grand total of up to 400 different amplifier
configurations.

Create Actives File: Bridgers\Feedermakers\Inline Eqs

Figure 10-20

The information about the bridger is entered.

BR1 & BR2: Represent the bridger 1 and bridger 2 levels. These levels are used by the
Network Initialization Window anytime a new network is created to set the starting signal
levels. It is possible to override these levels while starting a new network, if desired.
Bridger module forward inputs and return outputs have no effect on the operation of the
design; thus they are not assigned any value here. Please see Chapter 5: Utilities, section
Network Initialization Window for more information.
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Create Actives File: Feedermakers

Figure 10-21

Feedermakers: The feedermaker section allows for definition of the losses for eight
feedermakers. Lines one through four are given losses for a feedermaker type 1 (1 port), a
feedermaker type 2 (2 ports), a feedermaker type 3 (3 ports), and a feedermaker type 4 (4
ports) respectively. The losses from the first four lines are subtracted from the “Br1” level
(on page 1 of actives) to supply the correct output levels through the “Network
Initialization” window. The program will then look to this table for the correct number of
ports and expect you to specify a name for the networks from each port (if using the
parent/child network architecture). The next four lines (5 through 8) are for feedermaker
losses that will be subtracted from the “Br2” levels. Often, these lines are left blank
because the specs only call for one (or no) bridger output. For more information on
feedermaker operation and the Network Initialization Window, please see Chapter 5:
Utilities, section Network Initialization Window for more information.
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Create Actives File: Equalizers

Figure 10-22

Equalizers: Losses and part numbers for in-line equalizers are entered at the bottom-left
part of the screen. The line called EQ should store data about the default in-line equalizer.
It is the equalizer that will be selected automatically. The rest are user-definable pieces of
equipment (usually equalizers). Signal losses are entered in the corresponding columns. It
is possible to give the “Q” numbers a negative loss that will then be calculated as a gain.
All these devices are placed in the “amp” column of the Design screen.

Create Actives File: Cascade Setup
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Figure 10-23

The Active ID and forward module part numbers are there for reference only, thus are not
editable from this screen. A check in the Custom Cascade column will turn on the custom
cascading feature. A check in each numbered column will make that particular position a
valid position in cascade. Place a check in the Exclude column if you wish to eliminate an
active from the cascade count.

For example, if Active ID 64 is an AGC amplifier that must be in positions 2, 4, and 6 in
cascade, enter a check in the “2”, “4”, and “6” columns next to Active ID 64. In this case,
anytime a 64 type amplifier is used at any other place in cascade it will be flagged with an
error message when the test function is used. Note that placing an amplifier at an incorrect
place in cascade will not turn the amplifier red or yellow. This custom cascade feature
allows for setup of valid cascade positions for up to 19 amplifiers in cascade.

Taps

Select Taps from the SpecEdit pull-down to display the current taps spec file. Here, 63
different types of taps may be entered. Each type is available in 2-way, 4-way, 6-way, and
8-way. It is not necessary to enter information for all four types. The Design Assistant will
only use those taps listed in the “Tap Sel” column on page 2 of the Parameters file.

Create Taps File: Tap ID and Part Numbers

Figure 10-24
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The Tap ID is the number the Design Assistant will use to identify all tap values and usually
corresponds to the actual tap value. If your tap values end in .5 (15.5, 10.5, etc.), this entire
value will be displayed for Bill of Materials purposes, but the Design screen will only
display the digits to the left of the decimal. If 3-digit Tap ID numbers are used, the left
identifying bracket on the tap will be replaced by the first digit in the Tap ID. The tap
values should be entered with your highest value tap on the first line and descend from
there. The part number columns allow for a fourteen-character part number.

The Design Assistant makes provisions for using multiple tap vendors in a design. The
easiest way to accomplish this is to enter the taps that you wish to be placed automatically
first, just as if you were going to use only that vendor’s taps. Then, skip a line and start
entering the taps that you wish to be able to place manually but do not want the Design
Assistant to place automatically. Give the second group of tap ID numbers that can be
easily distinguished from the first group (possibly call the 35 taps 135, the 7 taps 107, etc.).
To use this second group in the Design mode, simply press “0” to alter and 135, 107, or
whatever. Note that if a 3 digit Tap ID number is used, the left identifying tap bracket will
be replaced by the first digit of the Tap ID.

Create Taps File: Two Ports, Four Ports, Six Ports, and
Eight Ports

Figure 10-25

The spec pages for the two port, four port, six port, and eight port taps look exactly the
same. The two port page is pictured above.
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These pages are used to define the actual operating losses of the 2-port, 4-port, 6-port, and
8-port taps. The “Tap ID” and the “Part Number” columns are automatically filled in based
upon the information input on the Tap ID and Part Number page, and are not editable here.

In the losses columns “Tap Value” indicates losses directed toward the tap ports, “Tap
Losses” indicate losses from hard cable input to hard cable output, otherwise called
insertion losses. The labels in the loss columns reflect the frequency labels entered on the
Frequencies tab of the Parameters file.

Put a [1] in the Self Term column for any self-terminating taps. If using active (powered)
taps, place a [1] in the column next to all active taps. When a tap is defined as being active,
the Design Assistant reads it’s powering information from the Active Taps table. It is not
automatically assumed that the tap is an interdiction unit. If the taps being setup are
interdiction units then they may require plug-in equalizers and pads for proper operation.
See the Pads/EQs section later in this chapter.

Create Taps File: Active Taps

Figure 10-26

This page of the Taps specification file contains a powering information table similar to
the one found in the Actives file. Fill in this page only if the taps you are using are active
taps. If you are not using active taps, leave all values here set to “0”. “Min. Voltage” is
the lowest voltage at which the tap will operate. “Amperage 1” is the amperage drawn by
that tap when its voltage drops into the Minimum Voltage range, that is, between “Min.
Voltage” and “Voltage 2”. “Amperage 2” is the amperage drawn when the voltage is
between “Voltage 2” and “Voltage 3”. Voltages should be entered increasing to the right,
with V4 being the highest voltage. This means that, when an Autoappend or AppendArea
is done while powering, branches containing these taps will not be trimmed or compressed,
so that the active taps may be powered.
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Create Tap File: Tap Swap Options

Figure 10-27

The Tap Swap Options page determines how the Design Assistant performs tap swapping.
For instance, sometimes systems want to swap a four port tap for any two port tap above a
certain value, say 20. In this case, you would enter a 4 in the two port swap option column
for the 26, 23, and 20 values. Anytime the Design Assistant would normally select a 23
two port tap, a 23 four port tap will be selected instead. Any value two port tap may still
be placed manually.

Create Taps File: Pads\Eqs

Figure 10-28

The pads and equalizers page of the tap spec file instructs the Design Assistant whether or
not to select pads and equalizers for taps. If you want to select pads and/or equalizers for
certain taps, set the corresponding column; F-Pad, R-Pad, F-EQ, and R-EQ, to the Pad/EQ
bank 1-8 from the Actives spec file. If the Design Assistant is instructed here to select pads
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and equalizers, it will refer to banks 1-8 of the Actives file to make the actual selection. If
the Pad/EQ column is set to 0, no pads or EQ’s will be selected.

Couplers

Select couplers from the SpecEdit pull-down to display the current Couplers file. The
coupler file consists of five pages. Again, just as in taps, the Coupler ID is used for
reference by you and the program only, the Coupler ID is never used in actual mathematical
calculations. The Couplers file is used to define the characteristics of internal couplers,
external couplers, and Network Interface Units.

Create Couplers File: Couplers

Figure 10-29

On this page, all of the specifications regarding couplers are entered. In the leftmost
column, enter the part number for the coupler. The part number may be up to 14 alpha-
numeric characters. In the Coupler ID column enter the number you wish to use as the ID,
that is the number you would like to enter while placing the particular device. It is helpful
to use intuitive Couple ID’s, for instance 2 for a 2 way splitter or 8 for a DC 8. Though it
is possible to enter an ID number with a decimal value, for example 3.5, in the specification
file, the Design Assistant will not recognize a 3.5 as being a valid Couple ID number when
the coupler is placed during the design process. Therefore, it is recommended to enter all
Couple ID numbers as whole numbers.

In addition to defining the losses of each coupler and the number of tap legs, you also
define whether or not each coupler is an external, internal, or optical coupler on this page.
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To define the coupler as being an external coupler, do nothing more than enter the losses
and the number of tap legs. To define a coupler as an internal coupler, place a check in the
“int” column on the far right. A coupler defined as an internal coupler will be treated
differently by the Design Assistant in two ways: 1. The Design Assistant will not BOM
any fittings in conjunction with an internal coupler. 2. The Design Assistant will flag an
internal coupler red if it is used incorrectly, that is, not placed at the same location as an
amplifier or placed with a tap or cable footage in between the amp and the coupler.

To define a coupler as an optical coupler, place a “1” in the “Optical” column. Once
identified as an optical coupler its losses may be entered as a percentage rather than a
discreet dB loss.

The next columns labeled “Tap” are used to enter the tap leg losses at the forward high,
forward low, return high, and return low frequencies, respectively. The four columns to the
right of that labeled “Thru” are used to enter the thru leg losses at the forward high, forward
low, return high, and return low frequencies, respectively.

In the next column, labeled “Tap Legs”, enter the number of tap legs available for the
coupler. Note: the Design Assistant will create a branch for each tap leg and the Design
Assistant can only create two branches at any one location. Therefore, the maximum
number of tap legs should be 2 (as in the case of a 3 way splitter), except for the case of a
drop splitter. When entering drop splitters into the Couplers file, they should be placed
following a blank line so that they will not be selected automatically to feed a regular
branch. It is not necessary to enter the “Thru Leg” specification (because a drop splitter
has no through leg). The number of “Tap Legs” should be the number of output ports on
the drop splitter, that is, an eight-way drop splitter should have eight tap legs.

In the remaining columns enter the tap and thru leg losses at all the extra frequencies that
have been enabled in the Parameters file.

Defining Amplifier/Optical Receiver Couplers

Many of today’s amplifiers and optical nodes have multiple outputs but do not use
feedermakers as the older mainstation-type amplifiers did. Because of this, we need to be
able to tell the Design Assistant how to choose the individual legs of each device. To do
this, we will define a branch (at the amp’s location) by using special couplers.

Let’s take a look at some typical equipment configurations and determine what type pf
coupler to define:

Three-port mini-bridger with a trunk level output and two feeder level outputs:

Define the amplifier (low level) trunk output in the Actives spec file.
Define a 3-way, unequal splitter with zero loss on the through leg and negative
amounts on the tap legs. This will make the two feeder legs a higher level.
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Two-port, equal output mini-bridger or dual-driven output line extender amplifiers:

Define the amplifier output in the Actives spec file. Define a 2-way, no loss splitter.

Three-port, equal output (balanced triple) amplifier:

Define the amplifier output in the Actives spec file. Define a 3-way equal, no loss
splitter.

Trunk

Feeder

Feeder

Trunk

Feeder legs 10 dB higher than trunk

Amplifier Configuration:
Mini-bridger with trunk and

2 feeder outputs

Lode Configuration:
Mini-bridger with trunk and

2 feeder outputs

Feeder

Feeder

Feeder legs equal

Amplifier Configuration:
Mini-bridger with 2 feeder outputs

Lode Configuration:
Mini-bridger with 2 feeder outputs

Feeder

Feeder

0 dB loss

0 dB loss

Feeder

Feeder

Feeder

Feeder

Amplifier Configuration:
Mini-bridger with

3 equal feeder outputs

Lode Configuration:
Mini-bridger with

3 equal feeder outputs

0 dB loss

0 dB loss

0 dB loss

Feeder Feeder
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Three-port mini-bridger with a default of two equal driven ports, but the ability to
passively split one port:

Define the amplifier high level output in the Actives spec file.
Define a 2-way, no loss splitter.
Define an additional 2-way splitter (or couplers as appropriate) with a positive
amount of loss.

E.g. an additional splitter with +4 dB which will then be subtracted from the high
level (un-split) output to give the two lower level outputs.

For optical nodes, let’s create a one-port, internally passively splittable node:

Define the node high level output in the Actives spec file. Define a 2-way splitter
with a positive amount of loss.

For a four-driven-port node:

Define the node high level output in the Actives spec file. Define three 2-way loss
less splitters. You need three splitters as the first feeds the other two to give you
four equal outputs.

Feeder

Feeder

Amplifier Configuration:
Mini-bridger with 2 equal feeder outputs,

one of which may be passively split

Feeder

Feeder

0 dB loss

4 dB loss

Lode Configuration:
Mini-bridger with 2 equal feeder outputs,

one of which may be passively split

Feeder
Feeder

0 dB loss

4 dB loss

Node Configuration:
Optical Rx with 1 feeder output,

which may be passively split

Feeder

Feeder

Feeder

Feeder

0 dB loss

Lode Configuration:
Optical Rx with 1 feeder output,

which may be passively split
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Create Couplers File: Base NIUs

Figure 10-30

This page defines physical characteristics and signal level requirements for base NIU types.
An NIU (Network Interface Unit) is the on-premises device that both separates and
multiplexes the broadband video and telephony signals. The NIUs are defined in the
Couplers file because for design purposes all NIUs except the default (see NIU Arrays) are
placed in the coupler column in the MDU window.

Part number: Specifies a part number for the NIU. There is a maximum of 31 NIU part
numbers and they may be up to 14 alphanumeric characters.

NIU ID#: A three digit numeric code used to identify the base NIU types that can be
configured into NIU arrays on the NIU Arrays page. Please note that this ID
number is only used on the NIU Arrays page to configure NIU arrays -- it is not
input directly into the MDU window. This code can be one, two, or three digits,
but it should not duplicate the ID numbers entered for couplers on other pages.

Ports--Phone: The number of phone ports available to this NIU. The Design Assistant
will use this number when the NIUtest function is invoked from the Powering
menu. The NIUtest calculates power consumption based upon various scenarios to
help determine possible powering conditions.

--Video: This feature is for reference only, the number entered here will not affect
any powering calculations.

Node Configuration:
Optical Rx with 4 feeder outputs

Feeder 1

Feeder 2

Feeder 3

Feeder 4

Feeder 1

Feeder 2

Feeder 3

Feeder 4

Lode Configuration:
Optical Rx with 4 feeder outputs

All splitters 0 dB loss
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--Min.: This represents the minimum number of phone ports that are actually
expected to be hooked up at this type of NIU. For example, assume an NIU
has 8 phone ports available with a minimum of 3 hooked up at any one time.
For powering purposes, this NIU will be assumed to have no less than 3 and
no more than 8 phones hooked up. The additional line percentage specified
on the General Parameters page of the Parameters file determines the
probability of each additional line over the minimum of 3 to be hooked up
at any given time.

Homes: This is the number of dwelling units that can be covered by this type of NIU. If
the sum of the house counts defined for the NIUs used in an MDU window is less
than the house count specified at that particular node, it will be flagged as an error.
For example, if two NIUs are required to design an apartment building, and the
house counts that they can feed are 3 and 5, then together they can feed up to 8
units. Therefore, if the house count listed in the house count column of the Design
screen is greater than 8, the house count itself will be displayed in red. You will
also receive an error message from the test function that says, “not enough drops at
node x.x” where “x.x” represents the location of the MDU window.

Minimum and Maximum: These are the minimum forward input and maximum return
output signal levels for the NIU. For any node with an MDU window that contains
NIU array codes in the “cpl” column, taps will be selected to provide sufficient
signal (at the end of the drop cable) for the levels specified here. The requirements
for all individual NIUs comprising the arrays will be used to calculate the tap values
at such a node. In this case, the “lv” columns both in the MDU window and in the
Design mode will be ignored.

For any node without an MDU window, the value listed in the “lv” column in the
Design screen will override the signal level requirements listed for the individual
NIUs that comprise your default NIU array. Therefore, if the default NIU does
have signal level requirements, it may be desirable to set up the tap output spec so
that the level at the end of a “typical drop” is the input to the NIU, not the level at
the TV or converter.

These levels need not be used unless desired. If there are no minimum/maximum
levels input here, then the Design Assistant will pick taps based solely on the
number entered in the “lv” column either in the Design mode or the MDU window.
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Create Couplers File: NIU Power Requirements

Figure 10-31

This page is devoted to the power requirements of Network Interface Units. Note the power
here is expressed in watts as opposed to voltage as in other parts of the program. Part
numbers and ID numbers are copied from the previous page and are not editable here.

Idle Power: Number of watts required to power the NIU in its idle state (no lines active).

1 line active: The Additional power required when 1 line is active or off-hook. This is
added to the idle power when 1 phone is activated.

Addl line active (ea): The incremental increase in power required for each additional
active line when one phone is already off-hook.

Addl ring power (ea): The additional power needed for each phone that is ringing, over
and above the power needed when that line is active.

Minimum voltage: Minimum operating voltage of the NIU. When the voltage at the NIU
node drops below this value, it will be flagged by an error message in the test
function that says “insufficient voltage for NIU”.

Note that all power values on this page are incremental. For example, if a given NIU type
had ten lines, five of which were off-hook and two were ringing, for a total of seven active
lines at a particular point in time, the power required would be:

(Idle power) + (1 line active) +
[(7 active lines - 1) * (additional line active power)] +
[(2 ringing lines) * (additional ring power)] = total power required
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Create Couplers File: NIU Arrays

Figure 10-32

This page creates arrays of NIUs by grouping individual NIUs. These arrays help provide
the flexibility necessary to feed any type of home, apartment complex (MDU), or business.
The “array” defined here may consist of only one base NIU or virtually any combination
desired, but they must be defined on this page. Note: The NIUs defined on pages 2 and 3
are not functional until they are placed into an array on this page. The Design Assistant
will not recognize the NIU ID numbers defined on page 2; it will only recognize the Array
code defined on this page as an active NIU. The array that is defined on line 1 will be
considered the default NIU. The default NIU will be placed at the “typical” house count,
that is, any node that is not further defined by an MDU window.

Array code: Three-character alphanumeric code used to identify the NIU array being
defined. If the array code is entered as a “+”, the information on that line will be
considered a continuation of the line above. Each line entered to define one array
will use a separate drop, that is, an NIU array code followed by three “+” lines will
take four separate drops. Do not specify an array code that is identical to a coupler
ID #, as this will prevent the selection of that coupler in an MDU window and is
likely to cause confusion. To place a particular array code, other than the default on
line 1, open the MDU window at that node and place the desired array code in the
“cpl” column.

Drop coupler: Enter here the three-digit Coupler ID# (from the Couplers page) for any
drop coupler that will be used to feed the individual NIUs specified on this line. It
is possible that NIU devices may exist that can feed signal directly from one to the
next, so that no drop coupler is needed when feeding an array of multiple devices.
Therefore, this column may be left blank even if there are multiple individual NIUs
specified in the “NIU ID#/Quantity” columns. In most cases, however, a blank
drop coupler column will indicate only a single NIU in the “NIU ID#/Quantity”
column. In this case the drop will feed directly into the NIU specified on this line.
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NIU ID#: Enter here the ID number for the individual NIU(s) to be configured in this
array. This is the three-digit ID number that was entered on the Base NIUs page
while defining the individual NIU characteristics. It is possible to feed up to eight
individual NIUs in this array from one drop. If your array is made up of NIUs fed
with separate drops, you will need to place a “+” in the Array code column on the
next line, and continue your configuration there.

Quantity: Enter the quantity of NIU devices of the type specified in the preceding part
column that you wish to comprise this particular array. There is a maximum of 255
in the “Quantity” column, which we hope will be more than enough for anyone.

Create Couplers File: Meta NIUs

Figure 10-33

Meta-NIUs are used to describe telephony usage patterns. While the previous three pages
specify the physical characteristics of NIU devices and arrays of NIUs, this page describes
how customers use their telephone. Meta-NIU setup is similar to the NIU Array setup on
the previous page. In this case, however, multiple NIU arrays are grouped together further
describing the customer usage patterns. The use of Meta-NIUs can be toggled on or off
from the NIUTest function within the powering menu. See Chapter 9: Powering, section
NIU Powering Analysis for more information on how to use Meta-NIUs.

Cumulative Prob: A read-only column displaying the accumulated percentage
totals already entered in the unit column. If the cumulative percentage is
already at 100% and more unit percentages are added, then all usage
patterns entered hereafter are ignored by the powering analysis routines. A
cumulative percentage of less than 100% is acceptable. In this case, the
remaining percentage of customers will be treated as a portion of the total
Penetration percentage (entered on page one of the Parameters file). Please
note: Penetration % is still in effect with Meta-NIUs toggled on during
powering analysis.
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Percent: The percentage of the overall customer base expected to fit the usage
pattern described by the entries on the remainder of this line.

Array code: The NIU array code (defined on the NIU Arrays page of the Couplers
file) expected to be used by the percentage of the customer base defined on
this line.

Add’l lines: The percentage of customers defined by the particular NIU array code
that are expected to purchase an additional phone line. This entry is similar
to the additional line percentage set on page one of the Parameters file
except here it is used to describe the phone usage pattern for this group of
customers.

Base OffHook: This is very similar to the off-hook percentage entered on page one
of the Parameters files in that it describes the percentage of time a phone
line is expected to be active. In this case, however, it refers only to the base
phone line described by the “minimum” column on page 2 of the Couplers
file. In addition, it refers only to the customer type defined on this particular
line. Separating the base lines from the extra lines (additional lines) further
refines the customer usage description since different customer groups may
use the base lines quite differently than they use their additional lines.

Base Ringing: The percentage of time that this customer type’s base line phone is
expected to be in a ring state.

Extra OffHook: The percentage of time that this customer type’s additional line(s)
is expected to be in an active state.

Extra Ringing: The percentage of time that this customer type’s additional line(s)
is expected to be in a ring state.

Cables

Select Cables from the SpecEdit pull-down to display the current cables spec file. The cable
spec file stores all the information about the kinds of cables that will be used to design your
system. The physical type of cable, attenuation factors, loop resistance, connector
information, etc is all entered here.

One hundred different types of cable, numbered 0 through 99, may be entered. In the
Design Assistant, cable type is entered along with footage and house count information.
Zero is the default cable type used when no cable type has been explicitly entered with the
footage and house count (it will show as a blank entry in the Design screen). The Cable
ID numbers used to enter the cable types are displayed (0 – 99) down the left side of the
screen. It is not possible to change these Cable ID numbers.
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Even-numbered cable types should be entered as aerial cable. Odd-number cable types are
treated as underground cable. Thus, each pair of cables (0 and 1, 2 and 3, 4 and 5, etc.)
usually has identical loss characteristics. This enables the Design Assistant to determine
at each location if it is an aerial location or an underground location. This way the Design
Assistant is able to accurately determine the strand distance, the trench distance, the
number of poles used in system, and the pedestals used in the system. The Design Assistant
uses cable “categories” to determine the status of the cable, for instance whether or not to
count the cable as mileage, backfeed, parallel, etc. (See Series/Colors section).

Create Cables File: Cables

Figure 10-34

Part number: Enter here the cable part number. It may be up to 14 alphanumeric
characters. The part number entered here will be used for Bill of Materials purposes.

Loop Res./1000: Loop refers to electrical loop resistance in Ohms per 1000 feet, or per
1000 meters if meters had been specified in the Parameters. For fiber and any
cables not intended to carry power, Loop should be set to 99, to cause an error in
Powering if accidentally powered.

High, Low, Rh, Rl per 100ft (or other, customized frequency labels): These columns
are for the attenuation factors for each specific cable type. “High” refers to the
forward high frequency; “Low”, the forward low; “Rh”, the return high; and “Rl”
the return low frequency.

Note: all frequency labels can be customized on the Frequencies page of the Parameters
file. If meters had been specified in the Parameters file, the attenuation factors would be
per 100 meters instead of 100 feet. Optical fiber and drop cable attenuation may also be
entered here.
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Create Cables File: Connectors

Figure 10-35

The Connectors page of the Cable file editor automatically displays the part numbers of
the cables that were entered on the previous screen. The part numbers to be used for both
pin-type and feed-through connectors for each cable are entered here also.

On this page, enter a part number up to 14 characters for both feed-through and pin-type
connectors. The right five columns specify which type of connector will be BOMed with
various types of equipment. Under “Connector Type”, a “1” is a pin-type connector and
“0” is a feed-through connector. This allows the flexibility to use pin-type connectors for
amplifiers and couplers and feed-through connectors for taps. This is not a very common
practice today so some customers may choose to use the feed-through column to specify
extension type connectors when doing a system upgrade or use this column for some other
purpose.

Create Cables File: Series/Color

Figure 10-36
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The Design Assistant provides the ability to give the same physical cable type different
classifications based upon usage. We call these classifications cable categories or cable
series. This provides the ability to differentiate between cable that should be counted as
mileage and cable that is parallel. While the parallel cable should be counted for Bill of
Materials purposes, it should not be included in any strand/trench calculations (set which
categories are counted as mileage in the Parameters file).

For example, cable 0 is duplicated as cable categories 100, 200, 300, 400, 500, etc. Cable
type 8 is duplicated as 108, 208, 308, 408, 508, etc.. These categories can be used to keep
track of things such as parallel cable, risers, tracer cable, direct bury cable, cable in conduit,
etc. Parallel cable costs less to install than standard (category zero) cable and should not
be counted in the total plant mileage. However, parallel cable is physically identical to
standard cable, in actuality, it is standard cable, it is just used for a different purpose. Thus,
by numbering parallel cable as the 1xx (category 100) counterpart to standard cable, it will
be counted separately in the Bill of Materials. The Design Assistant will assign all
backfeeds created with the backfeed function in the Design menu as a 1xx category to keep
it separate from standard cable. This is true for any cable number 0 through 99. Each has
its 1xx, 2xx, 3xx, 4xx, 5xx, etc., counterpart that will all be counted separately in the Bill
of Materials.

This page allows for the creation of a series description (category name) and it sets the
color cables will be displayed in. The series description will be displayed on the Bill of
Materials so that it is easy to determine the classification of each physical cable type.

To enter a series description, click in the appropriate box and type a descriptive name. If
no descriptive name is given to each cable series, then it will be listed in the Bill of
Materials as Category 100, 200, 300 and so on.

It is also possible to visually differentiate the individual series from the regular cable by
specifying a display color. To assign the colors the cables will be displayed in, click on the
desired foreground and background colors (a sample of what it will look like in the Design
menu is displayed) and press Assign Color.

We have found that 10 separate categories are not always enough for every customer.
Therefore, to provide more flexibility, it is possible to define different category definitions
for the same cable series based upon physical cable type. For example, it is possible for
series 200 to represent forwardfeed cable for aerial cable types 0-8, cable in 1” conduit for
underground cable types 1-9, new mileage cable for aerial cable types 10-18, and
something completely different for the remaining physical cable types.

Enter descriptions for each cable series as follows:

Aerial cables 0, 2, 4, 6, 8
Underground cables 1, 3, 5, 7, 9
Aerial cables 10, 12, 14, 16, 18
Underground cables 11, 13, 15, 17, 19
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Aerial cables 20, 22, 24, 26, 28
Underground cables 21, 23, 25, 27, 29
Aerial cables 30, 32, 34, 36, 38
Underground cables 31, 33, 35, 37, 39

Pricing File

This file contains the materials and labor costs associated with the equipment used in the
network design. If material and labor costs are entered into this file, network cost
calculations may be tracked while designing by using the Autocost [8] function found in
the Toggle [9] menu in the Design screen. With Pricing specifications entered, you may
also add a cost estimate to a Bill of Materials.

Create Pricing File: General Pricing

Figure 10-37

The Pricing file includes the prices of each physical device. The Pricing file stores only
the prices; the part numbers are automatically acquired from the other specification files
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that are currently loaded into memory. Thus, it is important to make sure the Pricing file
“matches” the other loaded spec files. The part numbers are listed in the same order as on
the BOM. Any lines left blank in the other spec files will appear here as “(unused)” with
a “0.00” cost. On this page, enter per unit cost, installation cost (aerial and underground),
and an expected operating cost (if any) for each device.

Create Pricing File: Cable Costs

Figure 10-38

On this page, enter the prices of each physical cable type, connector costs, installation
costs, and expected maintenance costs. Line #s 1 through 100 represent the different
physical cable types and are not editable here. The column labeled “Cost per 100” is the
cost of that particular cable type per 100 feet, or per 100 meters if meters are specified in
the Parameters. The connectors “Feed-Thru” and “Pin-Type”, represent the cost of feed-
through and pin-type connectors for each respective cable type.

The five columns under “Series x/100” refer to the cost to either hang or bury 100 feet
(meters) of that particular cable type. The columns labeled “0nn”, “1nn”, “2nn”, “3nn”,
“4nn”, and “5nn” represent cable categories 0 and 100 - 900, respectively. This option is
there because it may not cost as much to hang or bury backfeed or parallel cable as it does
to hang or bury the first cable. The categories also sometimes represent direct bury verses
plowed or conduit type trenches. The last column, “Maintenance”, refers to the expected
maintenance cost of 100 feet (meters) of each physical cable type.

Performance File

Select Performance from the SpecEdit pull-down to display the current Performance spec
file.
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Figure 10-39

Create Performance File

When creating a new Performance file, you will be presented with a “clean slate”. That is,
the Performance file will be completely blank. There will be 12 blank tabs that will access
12 empty pages. When a distortion type is defined on a blank page, the tab used to access
that page will be titled the same as the description entered for that distortion type. In the
screen shot above you will notice there has been four distortion types defined: c\n, ctb, cso,
xmod.

Description: 14 character alphanumeric description.

Signal Band: The frequency at which that particular distortion type will be tracked - the
forward high, or forward low.

Log\Add factor: The logarithmic equation at which that particular distortion type is
calculated. The addition factor for carrier to noise is “10” because it is calculated
using a 10 log rule. The addition factor for composite triple beat is “20” because it
is calculated using a 20 log rule, and so forth. Note that this field is not limited to
just a “10” or “20”, but the number entered here must be a positive number.
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Derate factor: The amount of degradation that occurs with a 1 dB change in signal level.
A positive number entered here will cause the Design Assistant to key off the input
level for that particular distortion type, whereas, a negative number will cause the
Design Assistant to key off the output level. For example, carrier to noise gets 1
dB worse for every 1 dB decrease in input level. Therefore, you would enter a
positive 1 here for carrier to noise. Composite triple beat gets 2 dB worse for every
1 dB increase in output level. Therefore, you would enter a negative 2 for
composite triple beat.

Source Level: the level of the distortion before any equipment is placed. The source level
could refer to the level at the headend or hub, or at the fiber receiver. It is the most
common for the source level to refer to the level after the headend and fiber link
but before the fiber node. This level is typically not found in manufacturer
specification catalogs. You will probably have to get this from the cable system
itself. Note that this should always be a positive number for all distortion types.
Higher source level values will have less effect on the calculations. Therefore, if
you are not able to find a valid source level, you may set it to “99” and the source
level will have a negligible effect on the calculations. To turn off the performance
calculations for a particular distortion type, set the source level for that distortion
to zero.

Warning Level: the level at which the Design Assistant will flag (in yellow or red) a
certain value. The flag will be in yellow up to 3 dB below the warning level and
then turn red when it is more than 3 dB below the warning level. This number
should always be input as a positive value. To disable the error messages you may
set the warning level to zero.

The remainder of the page is used for entering the “single unit base distortion levels” for
the distortion type described on the same page. There are 12 separate pages, one for each
distortion type. The levels that need be entered in the Actives Variations here is the amount
of distortion contributed by one amplifier.

For example, the formula to calculate the “single unit base distortion level” of carrier-to-
noise for an amplifier that has an input of 11 and a noise figure of 9 (from the
manufacturer's specs) is:

C/N[1] = 59 + input - noise figure
= 59 + 11 - 9
= 61

Therefore, a 61 would be entered here for that particular amp.

The different columns, labeled “#1” through “#8”, refer to the configuration table page of
the Actives file. If you recall, the configuration table (of the Actives file) allows for the
custom configuration of amplifiers. You can configure amplifiers with plug-ins and also
specify new ID#s for the eight different custom configurations possible using each base
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unit amplifier. For example, assume you had specified that an “11” is a base unit line
extender. An “11a”, therefore, could be the “11” code line extender with one plug-in, an
“11b” has two plug-ins, and an “11c” has three plug-ins. Then, you would need to input
the base unit distortion for the “11” in column “#1”, the “11a” in column “#2”, the “11b”
in column “#3”, and the “11c” in column “#4”. If you have not added any custom
configured amplifiers then you will only need values in column “#1” on these pages.

To view the performance calculations, you will need to be in the Design menu, then press
[9] for toggle and [0] for Signal Display. Note that only the first five characters of this
description will be displayed while viewing the performance calculations in the Design
mode.

For your reference, the following is a list of basic distortion formulas. These formulas
express distortion as a positive ratio of desired signal to undesired signal. If a manufacturer
provides negative numbers for the different distortion types, drop the minus sign for use
here.

Carrier-to-noise (C/N)

C/N for a single amplifier:
C/N[1] = 59 + input level - noise figure

C/N for a cascade of k identical amplifiers:
C/N[k] = C/N[1] - 10 log(k)

Cross Modulation (X-Mod)

X-Mod for a single amplifier:
X-Mod[1] = (X-Mod spec*) + 2(rated output* - actual output)

X-Mod for a cascade of k amplifiers:
X-Mod[k] = X-Mod - 20 log(k)

Second Order Distortion (SOD)

SOD for a single amplifier:
SOD[1] = (SOD spec*) + (rated output* - actual output)

SOD for a cascade of k amplifiers:
SOD[k] = SOD[1] - 10 log(k)

Composite Triple Beat (CTB)

CTB for a single amplifier:
CTB[1] = CTB spec* + 2(rated output* - actual output)

CTB for a cascade of k amplifiers:
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CTB[k] = CTB[1] - 20 log(k)

* Represents the manufacturer's rated levels.

To help you insert a meaningful warning level, here are the Federal Communications
Commission (FCC) standards as of July 1, 1995:

Carrier-to-noise 43
Carrier-to-Cross Modulation 51
Carrier-to-Discrete Second Order 51
Carrier-to-Composite Second Order 51
Carrier-to-Discrete Third Order 51
Carrier-to-Composite Triple Beat

Standard 51
IRC 47
HRC 47

It is recommended that you acquire the most recent FCC guidelines for accuracy.

Xspec File

The Xspec file is a file that stores up to ten different sets of specification files for quick
and easy access. The Xspec file is accessible by pressing [.][.][1] in the Design menu.

To load any set of specs listed in the Xspec file press the corresponding line number 0
through 9. The spec files here may be mixed and matched as desired. For example,
SAMPLE Parameters may be paired with SAMPLECITY Actives and a Taps file of still
another name, and so forth. The only restriction is that all the files listed in the Xspec file
must reside in the same directory. Pressing [Enter] or any of the arrow keys will switch to
editing mode wherein any of the positions on any of the lines may be modified.
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Macros

What is a Macro?

A macro is a shortcut for executing several commands with fewer keystrokes. By now,
you may have realized that there are several commands that you repeat and use all the time.
You may be wishing that you had a menu option just for those sequences of commands.

A macro can do exactly that. Using a special key sequence, you can put the Design
Assistant in “learn” mode, where it will memorize each keystroke as you type. Then, when
you are all done teaching the Design Assistant your keystrokes, you can play them back at
any time. When the Design Assistant plays back your keystrokes, it behaves just as if you
had typed them in yourself at the keyboard (only much faster).

Note: Macros record keystrokes and many mouse clicks within the Design Assistant but
will stop recording when certain dialog boxes are encountered. As a general rule if the
Design Assistant screen disappears as a dialog box appears any key strokes or mouse
clicks within that dialog will not be included in the macro and it will stop recording.

Macros are also Menu and column sensitive. If you record a macro with the cursor starting
in the Amp column of the Design menu and then run it with the cursor in the Coupler
column you may get some odd results. This can be avoided by utilizing the Right Click
Pop-up menu in the design mode and selecting the Move to Column option. This command
can be used to start the macro in the same column all the time.
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Figure 11-1

You can also use the Mode dropdown menu to select the correct menu to start in.

Figure 11-2

How to Setup a Macro

A macro can be assigned from anywhere in the Design Assistant. Typing [*][*] calls up
the macro function window, which looks like the following:
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Figure 11-3

[1] Save macro file: Updates the macro file currently loaded in memory with any new
macros that have been created during this Design Assistant session.

[2] Import text macro: Reads a text file (*.0ab) into memory and assigns it to the selected
keystrokes. This makes it possible to write a macro outside of the Design Assistant and
import it or to edit existing macros and read them back in. See below for guidelines on
creating or editing text macros.

[3] Export text macro: Exports an existing macro created from within the Design
Assistant to a text file that can be edited and imported back into the Design Assistant for
later use.

[4] Restore macros: Restores any macros deleted since the last save of the macro file.

[6] Create macro: Used to create new macros. See below for detailed instructions on
creating macros.

[7] Edit description: Allows editing of the text description of the macro. Note this edits
the text description only; it is not used to edit the macro keystrokes themselves.

[8] Delete macro: Press [8] and the “hot key” for the macro you wish to delete.

[9] Execute file macro: Reads and executes a text macro without assigning it to a
keystroke or saving it to the macro file.

To design a macro, press [6] Create Macro, then the key that you wish to assign the macro
to (that is, the key you want to be able to press to run the macro). Then, enter a description
of the macro (under 60 characters), followed by the keystrokes that you wish to record.
When you are done teaching the Design Assistant your keystrokes, press the [*] key to end
the macro recording.
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Once the Macro has been recorded and tested, press [*][*] again and select [1] to save the
Macro file. If the Macro file is not saved, the Macro is assumed to be temporary and will
be deleted when the Design Assistant shuts down.

To play back a macro, press the [*] key, followed by the key that the macro was assigned
to. To delete an existing macro, select [8] from the macro function window then press the
key that corresponds to the macro that you wish to delete. For example, if you had assigned
a macro to the “1” key, press [8] from the macro function window followed by the [1] key.
To make this deletion permanent, you will then need to save the macro file to disk. To
obtain a printout of your macros, number of keystrokes, and text descriptions, go to Macro
summary in the Print menu.

If you have defined some macros and unfortunately assigned a macro to a key that you had
previously defined as having a different macro, you can restore the macro file from disk.
This will erase any macros you have created since the last time you performed the “save
macro file” function. From the Macro Function window, select [4] to restore the macro
file. Macro files may be handled in a way similar to Status files, and like status files, they
will have a “.0ab” extension. You can set up a macro file with any filename you wish by
using the “/m” command line option. If you save your macros without having set up a
specific filename with /m, your macros will be saved to a file called MACROS.0ab. See
Chapter 2: Software Installation section Command Line Options for more information.

Creating and Editing Text Macros

It is possible to export any existing macro to a text file (press [3] followed by a text name
and the “hot key”) or write a new macro in any text editor. While it is possible to write a
macro in a text editor, this is not a common practice because it is usually much easier to
simply record the desired keystroke from within the Design Assistant. Most commonly,
the text macro capability is used only to edit existing macros that are extremely long and
would take a while to recreate.

While creating or editing text macros, use the following guidelines:

Ordinary printable characters (for example, “1”, “2”, or “a”) are represented by the
appropriate character.

Other keystrokes are represented as the following:

Up Arrow [UP]

Down Arrow [DN]

Left Arrow [LS]

Right Arrow [RS]

Back Space [BS]
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Tab [TB]

Page Up [BP]

Page Down [NP]

Enter [CR]

Exit [EX]

Insert [INS]

Delete [DEL]

Home [HM]

End [ND]

Function keys [F1] through [F12]

Macro codes are not case sensitive.

A macro can be written on one line or spread out over multiple lines.

Leading spaces will be read and included in the macro.

If a macro is given a text description, it will appear in square brackets with a colon
following the opening bracket ([: description]).

A Few Macro Ideas

Let’s take a moment to define a macro that places a mini-Bridger with a fake splitter. With
the Lode sample specification files loaded, go to the Design menu. Place your cursor in
the amp column where you want to place a mini-Bridger and internal coupler. Press [*][*]
to invoke the Macro Definition window. Select [6] for Create New macro. At the
following window:

Figure 11-4

Press [1] on the ten-key keypad to assign the macro to the “1” key. The computer will
display one of two possible responses:
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If you already have a macro assigned to the “1” key you will get the following message
when you go to redefine the macro:

Figure 11-5

Press [1] to redefine the key or [0] or [Escape] to abort the macro definition.

Or, if the key has not been previously assigned,

Figure 11-6

At this window, type in a brief description of the macro being created. Type in “Placement
of mini-Bridger and dummy coupler” then press [Enter].

At this point, your very next keystroke will become the first action of the macro. The
“Macro Record On” window will disappear when you press the first key you want to
record. Press [0] [6] [2] [Enter]. Using the arrow keys on your keyboard, move your cursor
over to the first coupler column and press [0] [2] [0] [0] [Enter] for the macro keystrokes
then press [*] to end the macro definition. Press the [Space Bar] to acknowledge the
following window.

Figure 11-7
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Your first macro is complete. Press [*] [*] [1] to save the Macro.

To use it, just press [*][1]. This will place a mini-Bridger and internal coupler for you.

The macro function can also be used to provide shortcuts during data entry. When entering
underground areas, you may need to enter extra footages to represent ped risers. This can
add many repetitive keystrokes to the data entry process. If you change cable categories
for the sweeps to differentiate them from the linear footage, a macro can save you even
more keystrokes. For our example, assume we are using cable type 1 for the underground
area, and the 200 category represents sweep footages. To create our sweep macro, go to
the Design menu and place the cursor in the “ftg-hc-cab-lv” column. Press [*][*][6], and
choose a key to assign this macro to. Any key except the [*] key will work. A good habit
to develop is choosing a key that will be easy to remember; in this case maybe the [s] key
for sweeps. Enter a description like Cable type 1 sweeps. When the “Macro record ON”
window opens, type the following keystrokes (remember; do not hit an extra key to clear
the “Macro record ON” window):

[.][0] - Break, moves house count onto a “0” ftg node below cursor location.

[][0][5][.][.][2][0][1][Enter] - Moves down one node and alters “ftg-hc-cab-lv”.

[][Insert] - Moves down one more node and inserts another “0” ftg node.

[0][5][Enter] - Alter’s “ftg-hc-cab-lv” column

[][*] - Moves down another node and turns off the macro recorder.

Input your trench footages just like the aerial (except for the “1” cable type). After you’re
done with the input, place the cursor on the first node containing an underground house
count. Make sure you are in the “ftg-hc-cab-lv” column and press [*][s]. Your newly
created macro should instantly place the house count at the end of a five foot span of “201”
cable, and place another five foot span right after it. It should then position the cursor on
the next node down ready to go again.

To save these macros, type [*][*][1] followed by the [Space Bar] to remove the
confirmation message. If, however, you decide that you want to restore the old macro file
(you don’t like the new macros) press [*][*][4] instead, followed by the [Space Bar] to
remove the confirmation message. To delete a specific macro, press [8] while in the Macro
Function window and press the key associated with the macro you wish to delete.

A macro can be assigned to any key on the keyboard, and keys that can be used with the
control keys [Shift], [Ctrl], [Alt]. [Shift][Q], therefore, can have a macro that is different
from an (unshifted)[q], and [Control][q] and [Alt][q] can also have their own macros.
Note: if you press the [Caps Lock] key, this switches you from the unshifted macro keys to
the shifted macro keys for all letter keys.
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The macro possibilities are astounding. As you work with the Design Assistant, you will
note how many keystrokes are always repeated, and you will find easier ways of
performing repetitious tasks. The macro feature of the Design Assistant is there to ease
your operation of the program. Efficient use of this feature can accelerate your use of the
program and make it a little easier to understand and operate.

Batch Macros

Most macros are designed to run on the design network currently loaded in the program.
There is, however, some macros that you may wish to run on a large number of networks,
for example a Single network BOM. That’s what the Run Batch Macro command allows
you to do. Simply record the macro for one network and use the Batch Macro command
to run it on multiple networks. Select Run Batch Macro from the Tools pull-down menu.

Use the Browse button to browse for the folder containing the networks you want to run
the macro on. Select the networks from the Available Files and add them to the Selected
Files and click OK.

Figure 11-8
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Then select the Macro you want to run from the Available Macros list. Keep in mind that
some macros really aren't meant to be run in a batch mode and might do some odd things
to your networks. It is recommended that you backup your network files and test the
macros to verify that there are no problems caused by running a macro on them.
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Tutorial

Tutorial: Plant Extension

Topics covered:

Setting up the Project Settings
Loading Specification Files
Starting a New Network
Setting Network Initialization Levels
Entering Strand Data

Creating Branches
Reading the Design Screen
Designing the Plant Extension

Using Will Work
Placing an Amplifier
Placing a Coupler
Changing a Coupler Value

Moving an Amplifier
Creating a Backfeed

Testing the Network
Naming Amplifiers

This tutorial simulates a typical plant extension. In this case, we will assume that you do
not have the original network in Design Assistant format. Therefore, we will be starting
the network with signal levels coming out of a terminated DC 8 saved for this future
extension. In this particular project we will be displaying the signal levels at 54, 550, and
860 MHz for the forward path and 42 and 5 MHz for the return path. This tutorial refers to
the map found on the last page of this tutorial. It may be helpful to refer to this map as we
go along. If you have not yet done so, start the Design Assistant by double clicking the
Design Assistant icon.
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Step #1: Project Settings

Setting the Project Settings simply tells the Design Assistant where to look for files and
where to save files. The project settings dialog will appear automatically when the Design
Assistant is started. If the Design Assistant is already running, go to the File pull-down and
select Project Settings to display the project settings dialog box.

For the purposes of this tutorial, we want to open the LodeXX.DAP project file that was
installed with the other sample files (the “XX’ represents the Design Assistant version
currently installed). To open the project file click on the open folder icon and browse to
C:\Lode Data Projects\ and double click on the LodeXX.DAP file.

The Project Settings dialog should look like this:

Figure 12-1

Pressing OK sets the Project Settings paths and loads the specification files. Depending
on the previously loaded project, you may or may not see the following window. If you
do, press any key to continue.
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Figure 12-2

Note: If during setup you chose to skip installation of the sample files it is necessary to re-
run the setup program to install the sample files at this time.

Note: If during installation you chose to install the sample files to directories other than
the specified default directories, then you will need to enter the names of those directories
in the Project Settings dialog box. Remember to save the Project file with the new path.

Step #2: Starting a New Network

To start a new network, press the icon in the upper left corner of the toolbar or go to
the File pull-down, hold the cursor over New and select Network. This will display a dialog
box asking for a network name, type “tutor1” and click “Open”. The following dialog box
appears”

Figure 12-3

For this tutorial, press No. The Design Assistant should display the Network Initialization
Window. This is used to set starting signal and/or distortion levels for the network. Since
we are starting this network from an existing DC 8 with the levels noted on the map, we
will need to customize the levels here. To customize the levels in this window, you must
first tell the Design Assistant you are not creating a Feedermaker network (feedermaker
levels are defined in the spec files, and therefore, are not user modifiable). To do this, click
on the Feedermaker network checkbox to clear the check mark. Change both the Amp
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Cascade and the LE Cascade to 1, this tells the Design Assistant we already have one
amplifier and one line extender in the existing plant. Click on the signal level next to 860
to highlight it blue and then change it to 28.99, change 54 to 25.34, 550 to 28.80, 42 to
38.48, and 5 to 29.27 (be sure your NUM lock is on). The Network Initialization Window
should look like this:

Figure 12-4

Click OK and you are ready to enter footages and house counts.

Just in case we have problems later in the tutorial, we will save this network now. Press
[Numlock] on the 10-key pad and then [7] to save the network.

Note: If your Network Initialization Window did not match the above screen shot, start
over with Step #2.

Note: Keep Existing Levels in the new network window will also start a new network, but
it will retain any network specific tap output levels set in the previously designed network.
It is very unusual to create network specific tap output levels, so that topic is not covered
here.

Step #3: Entering Strand Data

Notice that once a new network is created, the Design Assistant will automatically display
the Entry menu. The Entry menu is where most people enter all the strand data for a new
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design. Before we actually enter the strand data, it might be helpful to do a quick overview
of the Entry screen.

The column headings, reading from left to right, are as follows:

B – Branch number. The branch number is determined by the program and is not user
modifiable.

N – Node number. Node number can also be thought of as a line number, it does not refer
to a fiber node in any way. The node number is determined by the program and is not user
modifiable. The branch and node numbers should be used for reference and navigational
purposes only. It is possible for branch and node numbers to change; therefore, it is helpful
not to place too high an importance on them.

ftg – Footage. This is the distance between the poles or pedestals. This column heading
will change to “M” if the parameters specify the unit of measure to be meters or to dM if
the parameters specify the unit of measure to be decimeters. It is sometimes helpful to
insert 0 footage nodes if additional equipment is required at any particular location.

hc -- House count. This is the number of homes fed from this pole or pedestal location.

cab -- Cable type. The Design Assistant ID code for the desired cable type at this location.

lv -- Tap level. The desired tap output level to feed the homes from this pole or pedestal
location.
map# -- Map number.

loc# -- Location number. Often used for pole numbers.

Branch 1 – This column will be used to create new branches at split locations.

Branch 2 -- This column will be used to create new branches at split locations.

Amp Name – Amplifier ID. This is the amplifier column for any amplifier, inline
equalizers, or Q#’s defined in the spec files.

Note: All columns except for the footage column will appear blank if a 0 is entered.

To move the cursor to the next column press the dot “.” or period key. To move the cursor
to the previous column press the forward slash “/” or backspace key. The Design Assistant
will remember what information was entered on the previous line. Therefore, there is no
reason to enter data that is repetitive. For instance, if there are two spans in a row that are
identical, simply press [Enter] for the second span. Further, if the cable type stays the same
on subsequent spans (as it usually does) there is no need to re-enter the cable ID# for every
span.
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Ok, enough overview of the Entry screen. Please refer to the map at the end of this tutorial
and let’s enter the footages.

Type 107 to enter 107 feet and then press the period or dot key to move the cursor into the
house count column, type 2 then dot to move to the cable column, then press 0 and the
enter key to enter the first span. Referencing the map, enter the following distances and
house counts:

Note: it is not necessary to enter the cable type again until it changes.

83.1
201.7
134.4

After the 134 feet there is a branch that splits off to the north. It is possible to create this
branch now or after the rest of this strand line is entered. It is completely personal
preference as to when the branches are entered, but in this case, we will enter this branch
now.

Press –7 to create a branch. The Design Assistant will respond with:

Figure 12-5

Press OK with the mouse or press Enter on the keyboard to continue.

Referencing the map, enter:

147.7
140.1

We must move back to the previous branch.

There are two methods of doing this:

Press UP Arrow to the top of the current branch and once at the top, up arrow one more
time to return to the previous branch. Then, down arrow to place the cursor on a blank line
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in position to enter the next footage. If you leave the cursor at 1.4 over the current distance,
it will be overwritten.

OR

Press –3 (return) to return to the bottom of the branch this branch started from.

Making sure the cursor is below node 4 on branch 1 (it will soon become branch 1, node
5) continue by entering the following footages and house counts:

190.4
100.1
97.3
193.4
120.2
189.1
101.4

We have made this Design Assistant network reflect the spans and house counts on the
map and your screen should look like this:

Figure 12-6

If your screen looks the same, press [Escape] (Num Lock) once and 7 to save the network
and let’s go and design it.

Note: If your Design Assistant screen does not match the screen above, please start over
with Step #3 or you may use the delete key to delete any extra spans or the insert key to
add additional spans.

Note: To restore the network to the last saved version, press [Escape] from the Entry menu
and press 3 for restore.
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Step #4: Reading the Design Screen

If you are not in the Design menu go to the mode pull-down menu and click on Design or
press [ESC][9] to switch modes.

Figure 12-7

Pictured above is the menu portion of the screen. The top line shows the current menu
name (Design), the name of the network (tutor1), and the current EQ and tap Optimization
settings. The Status line on the bottom displays the specification files currently loaded, the
branch number (Branch 1 of 2), and feedermaker type (No Feeder).

Figure 12-8

Node: Indicates the node #. The node number is just the line number in the current branch.
Please don’t confuse the term node here with a fiber node - it is completely unrelated.

860/54: Column headings for the first two forward frequencies. These column headings
may be customized in the Frequencies section of the Parameters file.

42/5: Column headings for the first two reverse frequencies. These column headings may
be customized in the Frequencies section of the Parameters file.

ftg: Column heading for the footage column. If the distance units chosen is Meters
instead of feet, this column heading will be M.

hc: House count column.

cab: Cable column.

lv: Signal level column.

amp: Column used to enter amplifiers, line extenders, or in-line equalizers.

taps: Tap columns.
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cplr[branch]: The cplr column is for the coupler ID the [branch] column indicates the
branch number.

The Design screen is read from left to right. So, if there is an amplifier, a tap, and a coupler
on the same node (line), then the equipment would be spliced with the cable on the input
of the amp, the tap on the output of the amp, and the coupler on the output of the tap. To
help clarify this point, let’s evaluate the following line:

Figure 12-9

N: Node (line) 1 in the current branch.

860: 19.65 is the 860 MHz signal level after the 134 feet but before any equipment,
therefore, this is the amplifier input at 860 MHz.

54: 22.93 is the 54 MHz signal level after the 134 feet but before any equipment, therefore,
this is the amplifier input at 54 MHz.

42: 40.63 is the 42 MHz signal level at the end of the 134 foot span of cable, but in this
case since it is a return signal, it is actually the reverse output before the 134 feet. In other
words, this amp has a 39.03 reverse output at 42 MHz.

5: 29.95 is the 5 MHz signal level at the end of the 134 foot span of cable, but in this case
since it is a return signal, it is actually the reverse output before the 134 feet. In other words,
this amp has a 29.44 reverse output at 5 MHz.

ftg: 134 is the footage, all equipment is placed after the 134 feet.

hc: 4 is the house count or number of homes fed from this pole.

cab: This is the cable column. In this case, the column is blank because this is cable type
zero.

lv: This is the signal level column. In this case, the column is blank because we are using
signal level zero to select this tap.

amp: Here we have an amplifier type 11, a line extender.

taps: Here we have a 26 value four port tap. We know it is a four port because of the
square brackets [ ] around the tap value. A two port tap is shown with slash brackets / / and
an eight port is shown with angle brackets < >.

cplr[branch]: Here we have a two type coupler (a 2 way splitter in these specs) feeding
branch 2.
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550: 20.93 is the 550 MHz signal level after the 134 feet but before any equipment,
therefore, this is the amplifier input at 550 MHz.

Ok, enough for the Design screen overview, let’s design this small extension.

Step #5: Designing the Plant Extension

Step #5 – 1 Design Menu

Assuming you followed through with step #4, you should be in the Design screen. If you
are not, you will need to get there. Go to Design mode in the Mode pull-down to get to the
Design screen (green menu). Your screen should display the following:

Figure 12-10

Let’s double check on of the Design Assistant’s settings before beginning the design.
Notice on the second line in the menu (just under the word Help) is the Design Assistant’s
setting for in-line EQ selection. There are three possible choices: Manual, Auto, and Auto
Ex. These settings control the way the program selects in-line equalizers and for our
purposes here we want it to select them automatically whenever the maximum crossover
is achieved. Therefore, select Auto before continuing with this tutorial.

Note: If your screen menu does not match, start over with Step #5 – 1.

Note: If the strand data does not match, be sure that you have the tutor1 network loaded.
If tutor1 is loaded and the strand data still does not match, start over with Step #3: Entering
Strand Data.

Note: If you have inadvertently placed some equipment, don’t worry we’ll fix it.
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Step #5 – 2 Using Will Work

Will Work is a very powerful command that will take the available signal, propagate it
down through the remainder of the network and place as many taps as the available signal
will allow. It may be the most commonly used command in the program. Make sure your
cursor is at the top of the screen and type [6] for Will Work or press with your
mouse.

Two things should have happened:

1. It should have placed a two port eleven value tap at 1.1 (branch one, node one).

2. It should have displayed a red message on the bottom status line stating
“Insufficient signal at 1.2”

In this case, there was only enough available signal to place one tap.

Note: If your results didn’t match, make sure that the signal levels at 1.1 match the above
screen shot and that your strand data matches, also make sure your Lode specs are still
loaded. If your levels don’t match, but your strand data does, go to the Tools pull-down
menu and press Network Init. Refer to Step #2 and reset the levels (then start over with
step #5 – 2).

Step #5 – 3 Placing an Amp

Well, since we are out of signal, the most logical step is to place an amplifier. Since we are
just doing a small extension, we will only use line extenders in this tutorial.

Move the cursor to 1.2 (branch one, node two) and put it in the amp column. There are
three ways to place a line extender:

Press [0] to alter the field and then press [11] [Enter] to enter an amp ID# 11 (which in
these specs is a line extender).

Press [0] to alter the field and then press [Home] to display a list of available amps. Using
the arrow keys, put the cursor over the 11 type amp and press [Enter].

Press the [+] key on your keyboard or mouse click the “+” toolbar button to enter the first
amplifier in the spec file. In this case, this is the quickest and easiest way to enter a line
extender, but sometimes it may take several presses of the [+] key to increment the amp
ID# to the desired amp.

Place your line extender using any of the above methods and press [6] for Will Work.

This time Will Work should have placed five taps and displayed a message on the status
line on the bottom of the screen stating “Missing coupler at 1.4”.
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Note: If this Will Work did not place five taps, please make sure your strand data matches
and that you have the Lode specs loaded.

Step #5 – 4 Placing a Coupler

Notice that the Design Assistant’s message this time stated that we were missing a coupler
instead of insufficient signal. This is because the design cannot continue without a coupler
at the branch location. So, let’s place one now. Just as in placing amps, there are the same
three ways to place a coupler. If you have forgotten the three methods, refer to Step #5 – 3
and place a coupler ID# 2 (two way splitter) and press Will Work (you will need to have
your cursor on node 1.4 in the first cplr column).
.
This time after pressing Will Work, you will notice that the taps downstream of the two
way split have changed (this is because we have less signal) and we received a message on
the bottom status line stating “Insufficient signal at 2.1”. Notice that the message looked
“off-screen” to branch 2 first. This is important because, often times, it may tell you
something like “Insufficient signal at 1.6”, this would immediately tell you that branch 2
worked.

Step #5 – 5 Changing a Coupler Value

Well, what should we do now? We know that if we use a two way split, we don’t have
enough signal to feed branch 2. So, let’s change that coupler value to supply branch 2 with
more signal. To do this, put your cursor on the two-way splitter and press the [-] minus or
dash key to toggle the coupler value down. Notice this changed the coupler value to an “8-
”. This signifies a DC 8 with the tap leg (the low leg) coming down the screen that gives
us more signal on branch 2 and less on branch 1. Press [6] for Will Work.

Notice that all taps downstream of the DC have disappeared, but that the message box says
“Insufficient signal at 1.5”. This is good, it indicates that branch 2 works. But just to double
check, let’s jump into branch 2 and see what taps were selected. To go into branch 2, place
your cursor on 1.4, press [dot, left arrow] or using the mouse double click the branch
number. The Design Assistant should be displaying branch two, which worked with a 14
value eight port tap and an 8 value two port tap. Press the [up arrow] or to return to
branch one and finish this extension.

Ok, now that you have changed the coupler value and have at least some working design,
let’s go ahead and save this network. To save, click on the save button or press [Escape]
and press 7 to save – it is a little faster because it keeps your hand on the 10-key pad).

Note: If your screen did not match the description above, start over with Step #5 – 5.
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Step #5 – 6 Moving an Amp

Ok, the Design Assistant told us that we have insufficient signal at 1.5, so let’s put an amp
there. Put your cursor in the amp column on node 1.5 and place a line extender with
whichever method you prefer. Now that the amp is placed, press [6] for Will Work.

The Design Assistant should have placed 6 taps, but it gave us a message on the bottom
status line stating that we have “Insufficient signal at 1.11. We almost made it, but we ran
out of signal without being able to feed the last tap. It is time to explore our options. It does
not look like we will have enough signal to place a four port 8 value tap and stay within
our .5 dB tap margin, so that option is out. Well, we could place a third line extender and
make it work, but that would not be very efficient design. So, let’s try to move the amp
down and backfeed a span to see if we can feed this extension with only two line extenders.

Put your cursor on node 1.5. Press [3] on the 10-key pad or press the toolbar button
. On the Toolbar, it states “Carry Amp”. This is an indicator that the Carry

function is active. Move the cursor down two lines. Notice that the amp moves with the
cursor and recalculates the tap values. With the amp at 1.7 it appears that we have enough
signal to feed to the end of the line. Press 3 to stop the Carry Amp command.

Your screen should look like this:

Figure 12-11

Note: If your screen does not look like this, restore your network (press [Esc] and 3 to
restore) and start over with step #5 – 6.

Ok, let’s save again before moving on. Click the save button or you may choose to press
[Escape] and then press 7 to save – it is a little faster because it keeps your hand on the 10-
key pad.

Step #5 – 7 Creating a Backfeed

So far so good on designing this plant extension. It looks like the only remaining problem
is that there is not enough signal to feed the taps at 1.5 and 1.6. Let’s create a backfeed
from the amp at 1.7 and see if we can feed those last two taps.
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Make sure your cursor is on line 1.7 and press [ . ] [2] or mouse click on the
button. Notice, this created branch 3 and notice that the house count that was on 1.6 is
gone. Leaving your cursor at 1.7, press [ . ] [2] again to extend the backfeed in branch 3.
Note that the 4 house count that was at 1.5 has disappeared, that is because both of the
house counts that were on branch one are now fed from the backfeed branch, branch 3.
Notice also that the brackets around branch 3 are curly braces { } instead of the square
brackets, this indicates that branch 3 is a backfeed.

Just to double check, with your cursor still on 1.7, press [dot, left arrow] to move into
branch 3. Notice that we are going back 97 feet to feed the 1 house count and 100 feet to
feed the 4 house count. Also, notice that the cable type changed from 0 to 100 and is
displayed in purple. This category 100 cable signifies cable that is parallel and, therefore,
not counted as mileage. It is still cable type 0 or .625 aerial cable, the Design Assistant has
simply coded it for bill of materials purposes. The purple color just helps it stand out as
parallel cable, making it less likely for a designer to use it inadvertently.

Press the [up arrow] to return to 1.7. Put your cursor in the coupler column (on branch 3)
and let’s define a coupler value. Again, there are three ways to enter a coupler value.
Considering that there are four taps downstream on branch one and only two taps on branch
3, it may be wise to place a DC instead of a two-way split. So, place a DC 8 with whichever
method you desire (refer to step #5 – 3, if needed). Press [6] for Will Work. Hey, what do
you know, a message box we hadn’t seen yet – “Network will work from 1.7”.

Note: If you did not end up with the same results, restore your network and start over with
Step #5-7.

Ok, go ahead and save again before moving on.

Step #5 – 8 Testing the Network

It is always a good idea to go to the beginning of your network, press one final Will Work,
and then test it to be sure there are no errors. So, press [dot, up arrow] to move the cursor
to the top of branch one and press [6] for Will Work. Good job! “Network will work from
1.1” this is a good sign press [5] to test the network. No errors in red so this extension is
finished, except for one last thing; let’s name the amplifiers.

Step #5 – 9 Naming Amplifiers

Some people like to name their amplifiers for identification purposes. Place your cursor on
the first LE and press [ . ] [+] or mouse click . This will display the Amplifier
Definition window where you can give it a name. Type [LE-01] and press [Enter]. Press
[Escape] (Num Lock) to clear the amp definition window and this amplifier is named.

Unfortunately, the amp name is not visible because it resides in the same space as the taps.
So, to see the amp name, with your cursor in the ftg-hc-cab-lv column, press [ . ][0] or
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mouse click to break the node information into two lines. Notice this will
move the LE and tap to a 0 footage line below the original node. Move the cursor down
one to the node the line extender is on. Press [3] to Carry. Move the cursor up one line and
press [3] again to toggle off the Carry command. The LE’s name should be displayed just
to the right of the LE.

Next, let’s name the second one. Move the cursor down to the second LE and press [ .] [+].
Type the name to LE-02, press [Enter] and [Escape]. Follow the steps above to break the
node information and make the name visible (be sure your cursor is in the ftg-hc-cab-lv
column), and we are finished!

One last note, it is probably a good idea to save this network so that all of your hard work
is not lost. Click on the save icon to save the network

Your screen should look like the following:

Figure 12-12

Congratulations on your first successful design! Believe it or not, this short tutorial has
provided you with most of the information needed to create, design, and optimize all types
of networks within the Design Assistant.

Note: If your screen does not match, restore your network and start over with Step #5-1.
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Miscellaneous

Ped Counting

Many of your systems or clients will require BOMs which include enclosure counts, that
is, counts of the pedestals, vaults, or lock boxes which contain equipment that might be
considered “underground”. The Design Assistant provides a facility for counting these
items on the UG Housings tab of the Parameters spec file. Basic information on the use of
this facility is provided in Chapter 10: Building Specification Files, in the Parameters
section, but we thought we might give you some more specific suggestions here.

One possible scheme for equipment combinations

TV40----One 2, 4, or 6 way tap only.

TV80----Two or three 2, 4, or 6-way taps;
One or two 8-way taps;
One EQ and only one 2, 4, 6, or 8-way tap;
One coupler and only one 2, 4, 6, or 8-way tap;

TV104---Any combination of four of the above items; one LE only.

TV106---Any combination of six taps, EQ’s, couplers; or power inserters;
One LE and up to three of any of the other items;
One trunk amp only;
One optical receiver only.

TV1024--One LE and up to five large-tap size items
One trunk amp or one optical receiver and up to four of any large-tap size items
One Power Supply
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Guidelines For Point Assignment

First, obtain or create a list similar to the above “Possible Scheme” list covering as
completely as possible the various equipment combinations you will be dealing with.
Assign tentative point values to each item of equipment, smallest item with lowest points,
etc. If your enclosures are flexible as to what they can hold or your equipment’s housings
come in only a few sizes, you can start with 1 or 2 points for the smallest item of equipment.
If, as in our “Possible Scheme”, you have small 2- and 4-way and large 8-way taps, you
may find it better to start with 10 as a minimum to make it easier to juggle the totals.

The point total for the minimum combination the enclosure (ped/box/vault) can hold must
be greater-than-or-equal to the “Min size” assigned to that enclosure.

For instance, in our example Parameters file above, setting 31 points for the
#3 enclosure (TV104) ensures that three 2-way taps (10 points each, 30
total) will fall into a #2 ped (TV80). Whereas two 2-ways and one 8-way
(31 points total) or one LE alone (35 points) will fall into a #3, as is specified
in our “Possible Scheme” list.

In the same sense, the point total for the maximum combination to fit a given ped must be
less-than (and NOT equal-to) the next larger “Min size”.

Once again from our example, the largest point-total to go into a #4 (TV106)
would be 68 points (six large taps would be 66 points, but an LE and three
large taps would be 68). If we assigned the #5 ped 68 points, the LE-and-
three combo would get a TV1024. With the #5 enclosure set at 70, setting
the trunk amp to 65 ensures that a trunk amp alone will go into a TV106,
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but adding anything at all to the trunk amp gets a TV1024.

When Peds Are Counted

Before placing a pedestal, the program checks two things at each node. First, the cable code
to see whether it is aerial or underground. If the cable code is an odd number, it then
calculates the point total for the equipment at that node. If the cable code is odd and the
point total exceeds the lowest “Min size” from the Parameters file then the appropriate ped
is picked. Make sure the equipment intended to be underground has the right cable code
associated with it.

If you feel the need to test your point settings, simply create a network of one or two nodes
and place the questionable combinations of equipment on them. Then, with the cursor on
the node in question, and after making sure the cable code is odd, expand the display with
the “/ “ key. The housing type should appear in white lettering just to the left of the first
tap output levels on the far left side of the screen.
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Troubleshooting

Troubleshooting

Security key problems

Lode Data provides an assortment of security key diagnostic tools, to help determine the
causes of security key problems – see Utilities section following the list of questions and
answers

Q: When I try to start the Program I get this message:
“Key not found”

A: The security key has become disconnected from the port.

A: Wrong key type installed.

A: If you are using a USB key, the drivers may not be installed. Run C:\Program
Files\Lode Data Corporation\Utilities\Install Key Drivers. Attach the USB key
after the key drivers are installed.

Q: When I try to start the Program I get this message:
“Key expired or not legal for product”

A: Key date of security key button is older than the date required to operate the version
of the program you are attempting to run.

A: The security key on the computer is mastered to run a different program. For
example: trying to run the Design Assistant with a Drafting Assistant key.

A: The button in the security key is loose.

Q: When I try to start the Program I get this message:
Security key driver not loaded
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A: If you are operating Windows XP or Windows Vista, install the software, reboot
the computer, then attach the USB key.

General Design Assistant Questions

Q: Manually placed actives are displayed in red in the Design screen, even though they
seem to have enough signal.

A: Check input and output specs.

A: Check to see if the equalizers in the Active specification files are entered with a
high channel insertion loss greater than zero. Even though the input displayed at
the node where the line extender is placed may be higher than the minimum input,
it may not be higher than the minimum input plus the insertion loss of the equalizer
needed.

Q: When I open a network I get a message telling me that a branch doesn’t begin
anywhere.

A: A line containing the starting point of a branch (coupler) was deleted using the
delete key. You can either reattach or delete the branch using either the “Change
branch start” or “Delete branch” command in the Editor Entry mode. See the Editor
chapter for description of how to use these commands.

Q: Taps selected seem too low or manually placed taps are flagged as errors even
though they seem to have enough signal.

A: Check the return specifications; tap selection may be limited by the return path.

Q: Taps are not selected in Design screen.

A: Check the return specifications and make sure that the maximum return
specification has not been set to 0. If no return path is desired, set the return path
signal level to 99.

Q: When I start the program, I get the message “Menu not loaded”.

A: This indicates that the menu file (ENGLISH.0mu) is missing from the Design
Assistant directory. This file is compressed with the program files on the
installation CD. After obtaining a copy of this file, copy it into the Design Assistant
directory and restart the Design Assistant.
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Utilities

The following programs are installed in a Utilities folder within the chosen installation
folder. Typically: “C:\Program Files\Lode Data Corporation\Utilities”.

Readkey.exe

Readkey is a utility that reads the security key information for all keys attached to the
computer and displays it in a dialog box. The information includes the key serial number,
the products it is mastered for, and the key date. It also reads key expiration dates for timer
keys. Readkey also provides the means for updating keys after the purchase of a
subscription. When a subscription is purchased Lode Data will provide the user with an
update file called subupdt.enc which should be placed on the computer desktop. The
update is completed by pressing the Update Keys button on the Readkey dialog.

Install_1_wire_drivers_x86_v403beta.msi

Installation file for the USB drivers.



GLOSSARY

Glossary of Terms

Branch - A contiguous run of cable ending with a termination. Branch 1 starts with the
headend or a trunk amp. All branches after branch 1 start from a coupler. A branch
may have any number of other branches leading off from it.

Control File - A file that allows the grouping of multiple network files. This Control file
can then be used to generate various reports involving the grouped networks.

Distortion - Changes imparted upon the original signal by transmission and amplification.

Dongle - See security key.

Network - A relatively independent piece of design that is being worked on at one time.
A network file can be a plant extension, a feeder leg, or a trunk run for the entire
system. A Design Assistant network can consist of one or many branches.

NIU - Network Interface Units -Also known as Network Interface Devices or On-Premises
Devices. System devices that provide Broadband/Telephony switching, dial tone,
and ring services at the customer location.

Node - A logical (as opposed to physical) unit that corresponds to one line of the Entry,
Power or Design screens. In the real world outside of the computer, it can represent
a pole for aerial plant, or a pedestal for underground plant. Several nodes can be
located at the same pole or pedestal. One node in the computer can contain one
active, up to four taps, two couplers, all ancillary equipment, and all of the resultant
signal levels.

Security Key - A piece of computer equipment that is plugged into the computer (usually
a USB key) that is required for the Design Assistant to operate properly.

Specification File - A data file used by the Design Assistant to list part numbers and
operating specifications for Actives, Taps, Couplers, Parameters, Pricing, and
other user-definable values.
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